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Welcome to Merging Technologies Ovation!

Introduction

Thank you !

このたびは、Ovation Media Server & Sequencerをお買い上げいただき、誠にありがとうございます。

Ovationは、さまざまな活動領域で Show を制作・運営するために必要なツールを備えた、画期的なメディア
サーバー＆シーケンサーです。例えば

シアター

テーマパーク

ミュージアム

テレビ ゲーム

Show

トレード Show

AVプレゼンテーション

ラジオ局

小売店

などは、Ovationが使用される可能なアプリケーションのほんの一例です。

Note: IMPORTANT!  - 最初に行うべきことは、セキュリティキーを取得するためにソフトウェアを登録し、ユー
ザーサポートリストに登録することです。

また、以下のユーザーフォーラムにもご参加ください。

http://www.merging.com/forum/

※　このドキュメントは SDGs に鑑み、必要なとき以外は印刷しないでご使用ください。
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Overview
Ovationでは、様々なメディアやコマンドタイプの Cue を、スポットプレーヤーやカートリッジマシンのように手動
で、あるいはランタイムやタイムデイ、外部のLTCやMIDI TimeCodeに対して自動的に実行することができま
す。ランタイム、タイムオブデイ、外部のLTCやMIDIタイムコードに対して自動的に実行することができます。
Ovation シーケンサは、ハードウェアコントローラ、タッチスクリーン、GPI、Sony 9-pin (P2)プロトコルコマン
ド、MIDIから制御できます。やMIDIから制御することができます。

また、オーディオ録音も可能です。

Scope
Ovationは、オーディオ、GPO、MIDIコマンド、RS422またはイーサネットを介したSony 9ピン（P2プロトコルコ
マンド (IP）、IPコマンド、MMC、MTC TimeCode、HTTPコマンド、シェルコマンド/スクリプト/バッチファイル、
オープン サウンドコントロール（OSC）コマンド Ovationミキサーは、Ovationコントロール下で自動化することが
できます。

Ovationミキサーは、VS3、VST、VST3プラグインをサポートしています。詳しくはPyramixのユーザーマニュア
ルをご覧ください。

Ovationは、専用のハードウェアコントローラー、タッチスクリーン、MIDI、GPIで制御できます。Ovationミキサー
は、EMCまたはEuconを介してリモートコントロールできます。Merging Technologies社のISISリモートコント
ローラーには対応していません。

Evaluation Mode
有効なキーを入力していない場合、Ovationは評価モードで動作します。

すべての機能はフルバージョンと同じように動作しますが、1つの Show で保存またはロードできる  Cue List
は1つだけです。

Latency
最小限のレイテンシーは、Native モードまたは MassCore™ モードで動作するシステムでのみ達成されま
す。MassCore™モードでは、45msから66msのレイテンシーに加えて、トリガーデバイス（USB、GPI/Oなど）
が必要とする時間が発生します。専用のOvationハードウェアコントローラでは、通常、さらに10msのレイテン
シーが発生します。

注意：自動的にトリガーされるイベントはすべてサンプル精度です。例えば、ルールが Cue を Fire した場合、
以下のようになります。

Audio Formats Supported
対応するオーディオフォーマットの一覧は、Pyramixのユーザーマニュアルをご覧ください。

Ambisonics
Ambisonic Audio Cueに対応しました。Ovationにはチャンネルベースとアンビソニックのハイブリッドワークフ
ローが搭載されており、Ambisonic信号のエンコード、ミキシング、ローテーション、デコードをPyramixのミキシ
ングコンソールで直接行うことができます。

最大7次までのAmbisonicに対応しています。7次までのAmbisonic Decodersに対応し、b<>com Decoders
はOvationミキサーに統合されました。詳細はPyramixのユーザーマニュアルに記載されています。
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Aneman
Horusや Hapi などのMerging Technologies社製ネットワークオーディオインターフェースをお持ちの場合、こ
れらのデバイスは RAVENNA audio over IPを使用して Ovation ワークステーションに接続します。

ANEMANはMerging Technologies社が開発したアプリケーションで、ネットワーク上のオーディオ機器の接
続、監視、管理を行うことができます。デスクトップの Show トカットから起動することができます。
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Ovation Documentation and Help

ToolTips
Ovation Softwareには「ToolTips」が搭載されています。ツールのアイコンにマウスカーソルを合わせると、機
能の名前が表示されたボックスがポップアップします。

Documentation
すべてのドキュメントは、Adobe Acrobatのpdf形式です。(.pdfファイル拡張子)

ドキュメントを読むためには、Adobe Acrobat Reader V6以降がコンピュータにインストールされている必要が
あります。

注意：すべての目次、索引、相互参照は、迅速なナビゲーションのためのハイパーリンクです。

この Ovation ユーザーガイドと Pyramix ユーザーマニュアルは、ヘルプメニューから開くことができます。その
他のドキュメントは、Windowsのスタートメニューの「すべてのプログラム」→「Pyramix」→「Docs」で見ることが
できます。最新のバージョンは下記サイトでご確認ください。

http://www.merging.com/downloads

Support
ドキュメントに答えが見つからない場合は、下記のオンラインサポートをご利用ください。

http://www.merging.com/contact/tech-support

ここでは、F.A.Q.（よくある質問）への回答や、さらなるサポートを受けることができます。

Assumptions
この Ovation ユーザーガイドやその他の文書は、ユーザーが PC や Windows の用語や概念に精通している
ことを前提としています。新しいPCに自分でインストールする場合は、Ovationをインストールする前に、マシン
が正しく動作していることを確認してください。

Conventions
Merging Technologies 社のドキュメントの規約です。

画面やメニューに表示されている名称は太字で表示しています。例：Information & Settings

メニューやサブメニューの選択は次のように表示されます。

Show > Recent Shows : Quickstart

これで、Show プルダウンメニューで Recent Showsサブメニューにマウスダウンし、Quickstart を選択しま
す。

Settings ダイアログには、左側のペインにそのページにつながるフォルダのある階層的なツリー構造がありま
す。
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QUICKSTART
Overview
このセクションでは、シンプルな新しい Showの作成とミキサーの設定について、ステップバイステップで説明し
ます。ここでは、Cue を Cue Listに追加する方法、Cue Listの種類、Showの実行、 Cueや Cue Listの
Fire について説明します。

注意：このセクションは、本ガイドの他の部分にあるより詳細な情報の代わりになるものではありません。

A First Simple Show
以下の事前準備を前提としています。

● Ovationのハードウェアとソフトウェアのインストールが完了している。

● 物理的なI/Oに監視手段が接続されている。

● ソフトウェアの登録、登録キーの入力、VS3 コントロールパネルでの初期設定が完了している。

Launch Ovation
Ovationのアイコンをダブルクリックする

または、スタート > すべてのプログラム > Merging Technologies > Ovation:Ovationの順にクリックしま
す。

Ovation は空のメインウィンドウが開き、New Show ダイアログが開きます。
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New Show

Start with a template show 選択すると、右側のペインのリストから既存のテンプレートを選ぶこと
ができます。

Start with a single Cue List 選択すると、 Show は1つの  Cue List が作成された状態で開きま
す。コンボ
コンボボックスには、作成される  Cue List の種類が表示されます。矢
印をクリックすると
利用可能なタイプのリストが表示されます。
Standard Cue List
Timed Cue List
Hot Keys
Custom Keys
Cue Browser
Hot Browser

Set up a new Show
Workspace :

チェックを入れると、新しい Show のために新しい Show
Workspaceが作成されます。

Show Name このフィールドには、新しい Show の適切な名前を入力します。

Show & Media Location このフィールドには、Showと関連するファイルが格納されるパスが表
示されます。

... ...ボタンをクリックすると、Browse For Folder ダイアログが表示され
ます。
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Browse For Folder dialog

Browse For Folder ダイアログは、他の Windows ブラウザと同じように機能します。新しいプロジェクトを保
存する場所に移動して、必要なフォルダを選択するか、Make New Folderボタンを使って新しいフォルダを作
成して名前を付けます。OKボタンをクリックすると、新しいフォルダーが作成され、ダイアログが閉じられます。
Cancelボタンは、新しい場所を選択せずにダイアログを閉じます。

最初のシンプルな Show を作成するために、次の様に操作してください。

Start with a single Cue List: Standard Cue List

Show Workspace にチェックを入れます。

Showの適切な名前を入力します。

Show を保存する適切な場所に移動します（必要に応じて新しいフォルダを作成します）。

OK をクリックして、Show を作成します。

Show は Compose Mode で開きます。これは、Cue を追加して Show をデザインするモードで、新しい
Standard Cue List が空のメインウィンドウに表示されます。
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Configure the Mixer
デフォルトのミキサーが表示されます。表示されない場合は、View > View Mixerがハイライトされている（有
効になっている）ことを確認してください。

初回起動時には、デフォルトの 8ch入力 2ch出力 のミキサーがロードされ、出力ルーティングは選択されてい
ません。

Default Mixer with Output Routing Circled

Note: Pyramix Mixer は大幅にアップデートされ、非常にパワフルな新アーキテクチャーに改訂されました。上
記の Legacy Mixer はまだ使用可能です。新しいミキサーの詳細についてはPyramixユーザーマニュアルをご
参照ください。

Legacy と新しい General Mixing Busesのどちらを使用するかを決める際には、2種類のバスを使用するシ
ステムに内在させる場合の制限を理解することが重要です。

新しい Bus とパンを使用する場合は、必ずすべての Busを新しいタイプに変換してください。または、新しいプ
ロジェクトを構築する場合は、新しい Bus のみを選択してください。
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● Legacy Subgroup は、新しい Bus に送れません。
● Legacy Bus と General Mixing Bus が混在すると、コントロールサーフェスが混乱する場合があり
ます。

Output Routing
ST1出力バスのミキサーストリップの下部にある L:の XLR アイコンをクリックして Connect Output メニュー
を表示させます。

Default Mixer Output Routing

ハードウェアの出力をクリックします（この例ではADATドーターボードが装着されているので、物理的なコネクタ
ごとに2つのエントリーがあります）。目的の出力をクリックして、ステレオ出力の左サイドにルーティングします。

R:の XLR "アイコンについても同様に、ステレオ出力の右側に2つ目の出力チャンネルを選択します。

Set Panning
この演習では、ステレオ素材を想定しているので、それに合わせてパンを設定する必要があります。

Strip 1のパンスライダーをクリックして、フェーダーの上の英数字パネルに Left と表示されるまで左にドラッグ
します。

Default Mixer Stereo Panning
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次に Strip 2 のパンスライダをクリックして右にドラッグし、ディスプレイに Right と表示されるようにします。(マ
ウスポインタが離れると、表示は1〜2秒後にピークレベルは戻ります)。Left Rightペアの残りの6つのストリップ
にも同じ作業を行います。

注意：ミキサーの詳細については、Pyramixユーザーマニュアルをご覧ください。

Saving Mixer Configurations
ミキサーの構成は Show と一緒に保存されます。ミキサー構成は、ミキサーの Organize タブで独立して保存
と読み込みができます。(詳細はPyramixのユーザーマニュアルをご覧ください）。)

Building the Show

Cue List Pane - Compose Mode

Add Cues
右クリックのコンテキストメニューから Add > Load Audio File を選択するか、 Cue メニューから Add >
Load Audio File を選択すると、Open Audio Files Browser が表示されます。

例えば、5つのオーディオメディアファイルを選択し、Open をクリックすると、Showに作成した Cue Listに
Cue としてロードされます。

ブラウザの Cue 名には、UID (Unique IDentifiers)が含まれていることに注意してください。

Open Audio Files Browser
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これで、以下のような Cue Listができあがるはずです。

Cue List Pane - Compose Mode

Ovation は Media ファイルの名前を賢く省略して Cue Name を生成しています。Cue Nameは Cue
Propertiesペインで変更できます。また、Replave Audio Media（オーディオメディアの置き換え）機能を使え
ば、Cue Name を変更せずに Media File を変更することができます。

右クリックして表示されるコンテキストメニューの Move Up と Move Downボタンを使ってみてください。

First Run

Initialize Show
メインウィンドウで Init Showボタンをクリックします。

Main Window

(または、Show > Init を選択して、Show を初期化します。メインウィンドウには、作成した Cue List が表示さ
れています。また、最初の Cue を選択すると、Cue Listペインが通常の Show モードに変わることにも注意し
てください。
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Cue List Pane - Show Mode

1 - Cue List 1が緑色のバーで強調表示されているのは、このCue Listが選択されていて、Show Control
ボタンの影響を受けることを示しています。Cue のステータスラベルには、すべて Asleep と表示されていま
す。

Play

Show を開始するには Start Showボタンをクリックします。

選択されたCueは紫でハイライトされ選択されていることを示し、Cue名の下に Readyが表示されます。すなわ
ち、「発射準備完了」です(バッファにロードされた状態)。

Cue List Pane with Cue Ready - Show Mode

また、 Cue の周囲に赤い枠が表示されていることにも注意してください。これは、ゆっくりと点滅し、次に Fire,
Pause, Stop ボタン、Keyboard Shortcuts, Remote Control のいずれかを起動したときに、影響を受ける
Cue であることを示します。

Fire Selected Cueボタンをクリックします。選択された Cue が再生され、色が緑に変わ
り、 Cue 全体に経過時間のバーが表示され、経過時間と残り時間を示す2つのカウンターが
表示されます。
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Cue List Pane with Cue Playing - Show Mode

同じ Cue が Cue List で選択されたままになっていることに注意してください。また Cue の再生が終了すると
Cue は停止し、選択されていることを示すグレーのハイライトが表示されます。

Show を停止して再初期化します。(Show > Stop して Are you sure you really want to Stop the
Show? ダイアログで OK をクリックします。

Show を Start します。先ほどと同じように、選択されたCueがプレイアウトに向けて準備されます。

Fire Sequenceボタンをクリックします。選択された CUE が再生されます。今回は、リスト内
の次のCueがハイライト表示され、Fire Sequenceの準備ができていることに注意してくださ
い。

Cue List Pane with Cue Playing & Next Cue Ready - Show Mode

また、赤い枠線が Cue 2 に移動していることにも注目してください。これは、Fire, Pause, Stop ボタン、キー
ボードショートカット、リモートコントロール のいずれかに影響を受ける Cue になったからです。
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Fire Sequenceボタンを再度クリックします。次の Cue が再生されます。元の Cue (終了し
ていない場合) はまだ再生されていますが、次の Cue はハイライトされていて、Fire の準備
ができています。

Cue List Pane with Two Cues Playing & Next Cue Ready - Show Mode

また、赤い枠が Cue 3に移動していることにも注目してください。

Show Controlの "Transport" ボタンの操作に慣れるまで遊んでみてください。

Show > Stop と OK をクリックすると、Stop Show ダイアログが表示され、Compose Modeに戻ります。

Hot Keys Mode
今度は CueList > New > Hot Keys を選択して、いくつかの Cue を追加します。

Hot Keys Cue List Pane - Compose Mode - normal

注意：通常の Compose mode では、オレンジ色のヘッダーとタイトルバーの（Hot Keys）ラベル以外は、
Show が初期化されるまで、Standard Cue List と Hot Keysの  Cue List に違いはありません。

Init Showボタンをクリックして、 Show を初期化します。

オリジナルの Cue List は以前のように表示され、Hot Keyの Cue List は次のように表示されます。
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Hot Keys Cue List Pane - Show Mode

新しい  Cue List が選択されていない(オレンジバーがない)場合は、タイトルバーをクリックして選択するか、
Cue List が選択されるまで Show Controls の Toggle Cue Listsボタンをクリックしてください。

Show を開始して、2-Cue List 2 ペイン上の Hot Keys と Show Control の Fireおよび Fire Sequenceボ
タンを試してみてください。

(テンキーではなく、PCキーボードの数字キー）を使って Hot Keys を試してみてください。FireとStopが切り替
わることを確認してください。

1-Cue List 1 をもう一度選択するには、そのタイトルバーをクリックするか、リストが選択され
る (緑のタイトルバー) まで Show Control の Toggle Cue Listsボタンをクリックします。

最初の  Cue List で Cue を選択し、Show Control の Fire Selected Cue または Fire Sequenceボタンを
使用して Cue を Fire します。

次に、キーボードの HotKeys を使って、2つ目のリストの Cue の再生と停止を行います。

Stop Show をクリックして OK をクリックすると、Compose Modeに戻ります。
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Timed Cue List
3つ目の  Cue List を作成します。今回は Cue List > New > Timed Cue List を使用し、3つの Cue を追加
します。

Timed Cue List Pane - Compose Mode

リストの最初の Cue を選択し、右クリックして Cue Propertiesボタンを選択すると、選択した Cue の Cue
Propertiesペインが表示されます。ペインをフロートさせて、使いやすい大きさに変更します。

Cue Properties Pane

Go Time フィールドをクリックしてください。
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Time Entry Box - Cue Properties Pane

Timeの入力ボックスが表示されます。これは「時」「分」「秒」「ミリ秒」の形式で入力します。

クリックして入力カーソルを秒の部分に置き、10と入力します。 Cue Propertiesペインの他の場所をクリックし
て値を入力します。Go Time フィールドの値が 00:00:10:000に変更されていることに注意してください。

3つ目の Cue List ペインで次の Cue を選択し、Go Time を 00:00:20:000と入力します。

3つ目の Cue についても同様に、Go Time を 00:00:30:000 と入力します。

Cue List 3 ペインの Go:に時間が表示されるようになったことに注目してください。

Timed Cue List Pane with Cue Start Times - Compose Mode

Show > View Show Properties を選択し、Show Time Mode フィールドをクリックして Durationを選択し
ます（まだ表示されていない場合）。

Initialize Show で Show の初期化してください。

Cue List 3に Time ツールバーが表示されています。

Timed Cue List Pane -Show Mode
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Chase Timed List

Chase Timed Listボタンをクリックすると、リストに Show Time を追いかけるように指示
することができます。

注意：Chase Timed Listボタンはラッチングです。つまり、その状態は Show を Stop して再び Start したとき
にも記憶されます。

Show モードでは Chase Timed Listボタンを押すと緑色に点灯します。

注意：一度この機能を選択すると、Show を Stop して再び Starts しても、手動で再度ボタンを押してキャンセ
ルするまで持続します。

Start Show をクリックします。Cue List 3の タイムカウンター は、Show のタイムカウンターに追従します。リス
ト 3 の Timed Cues は、Show Time が Go Time に達すると Fire します( Cue がそれぞれ10秒以上の場合
は、前の Cue が再生されている間に次の Cue が Fire されます)。

Hot Keys は List 2の Cue に対しても有効であり、List 1を選択しても Show Controlsで List 1のCueをコント
ロールできることに注意してください。では Show を Stop してください。

Start Timed List
Init Show をして、Cue List 3の Chase Timed Listボタンをクリックして機能をキャンセルしてください。
Show を Start し、10秒を超えて走らせてください。

Start Timed Listボタンをクリックしてください。Timed ListのカウンターがGo Time（10
秒）に達すると、最初の Timed Cueが実行されます。

Start Timed Listは、Show Time と Timed List Time の間の Offset を導入します。最初の Cue の前の時
間も含めて、リスト全体が最初から再生されます。では Show を Stop してください。

Fire/Start Timed List
Show を Initialize して Start してください。

Fire/Start Timed Listボタンをクリックしてください。最初の Timed Cueはすぐに Fire さ
れ、他の Cue は適切な時間指定の順序で続きます。

Fire/Start Timed Listは、Show Time と Timed List Time の間に Offset を導入します。リスト全体は、最
初の Cue の先頭から再生され、最初の Cue 以前のリストの時間は無視されます。

注意：Show タイムが最初の Cue の開始時間を過ぎている場合は、ボタンが押された直後に Cueが Fire され
ます。

Pause Timed List
Fire/Start Timed List でリストが開始されている場合のみ利用可能です。
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クリックすると Timed リストが Pause します。もう一度クリックすると再開します。

Stop Timed List
Fire/Start Timed List でリストが開始されている場合のみ利用可能です。

クリックすると Timed リストが Stop します。リストをスタートにリセットします。

Conclusion
おめでとうございます。あなたは、3つの主なタイプの  Cue List のそれぞれの例を使って、最初の Show をデ
ザインし、実行したところです。

Ovation には、フェードやインタラクション ルールなど、さらに多くの可能性があります。これらの使用に関する
詳細な情報は、このガイドの他の部分に記載されています。
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Ovation Concepts

Launching Ovation

Launch Ovation
Ovationの ショートカットアイコンをダブルクリックします。

またはスタート > すべてのプログラム > Merging Technologies > Ovation:Ovationの順にクリックしま
す。

Application Delay Launch アプリケーション遅延起動
この機能は、マシンの起動時にOvationを自動的に起動し、必要なドライバやサービスなどが利用できるように
遅延させるものです。

自動起動を有効にするには、Ovation アイコンを Startup フォルダにドラッグし、Show Propertiesペインの
Show セクションにある Application Delay Launch フィールドに、必要な遅延値（秒）を設定してください。

Ovation Media and Commands

Audio
Ovationは、Mixer を経由して、Horus / Hapi または Native を使用しているる場合は サウンドカード を介して
Audio Cue を再生します。

MIDI
Ovationは、MIDI（MMC、MIDIコマンド）を同一マシン上の他のアプリケーションや外部機器に出力します。

IP Commands
Ovationは Cue ごとにIP Commandsを出力します。

Sony P2 / RS422
OvationはSony P2プロトコル、RS422コマンドを出力します。

GPO
Ovation は GPO コマンドを COM ポートに出力します。

Commands/Scripts/Batch files
シェルコマンド/スクリプト/バッチファイルを出力します。

Automation
Ovation Mixer の Snapshot がトリガーされ、オートメーションを記録 再生することができます。

DMX 512 / CMX ライティングコントロール
DMX Commands ページを参照してください。
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Media Management
Ovationでは、ローカルストレージ, リムーバブルストレージ, ネットワークストレージ上のメディアファイルを使用
します。

新しい Show が作成されると、同じ場所に Audio Filesフォルダが作成されます。

Show が Consolidate されると（Consolidate Processの章を参照してください）、ネットワーク上のファイル,
リムーバブルストレージ上のファイル, または Show で使用されるすべてのファイルが収集され、 Show ファイ
ルの場所にある Audio Files フォルダにコピーされます。

リムーバブルストレージやネットワーク上に存在するオーディオファイルやファイルを  Cue List に追加すると(ド
ラッグ＆ドロップ、Load Audio File、Replace Audioなどを使用して)、そのファイルを Show に関連するAudio
Filesフォルダにコピーするかどうかを確認するダイアログが表示されます。

Show パッケージング プロセスでは、Show に関連するすべての オーディオメディア やその他のファイル（
Show ファイルを含む）を収集し、バックアップのために新しい場所にコピーしたり、Show を別の Ovation ワー
クステーションに移動できるようにします。Packing Processの章を御覧ください。

Remote Control

Remote Control OF Ovation
Ovation Sequencer & Media Serversは、以下の方法でコントロールできます。

● Merging Technologies Hardware Controller
OVController module を介して

● General MIDI
● 9-pin Sony P2 (RS422 プロトコルl) commands
● IP コマンド
● GPIs.

Remote Control BY Ovation
Ovation SequencerとMedia Serverは、以下の方法で他の機器をコントロールします。

● MMC
● MIDI コマンド
● Sony P2（RS422プロトコル）コマンド
● COM コマンド
● IP コマンド
● GPO
● シェルコマンド／スクリプト／バッチファイル

● OSC（Open Sound Control）コマンド

Remote Control of Ovation Mixer
Ovation Mixerは、EMCまたはOasisを介してハードウェアコントロールサーフェスで制御することができます。
Merging Technologies社ISISコントローラには対応していません。

Multi-Sequencer Synchronization
複数のオベーションをさまざまな方法で同期させることができます。Cue で別の Ovation をコントロールするこ
とができます。1台の Ovation を別の Ovation に完全にミラーリングして、ほぼ瞬時に完全な冗長性を確保す
ることができます。
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クリエイティブな可能性
複数の Ovation シーケンサを設置する場合、通常は様々なゾーンごとに1台ずつ設置し、観客がゾーン間を自
由に移動するような場合には、すべてのシーケンサで特定の Cue を完全に同期して再生することが望ましいで
しょう。例えば、BGMなどです。そのためには、1台の Ovation の Cue をマスターに設定し、他のすべての
Ovation の同じ Cue をスレーブに設定します。各 Ovation には、GPSタイムコード ジェネレーターなど、共通
のタイムベース ソースを提供する必要があります。すべてのマシンで同期する必要のある Cue は、マスターシ
ステムではマスターとして設定され、スレーブでは同じトークンでスレーブとして設定されます。その他の Cue
は、各システムで独立してトリガーすることができ、各ゾーンで異なるイベントを提供しますが、ベースラインの

オーディオはすべてのシステムで同期します。

ミッションクリティカルな状況下で、バックアップの Ovation が同じ Show を行うことで冗長性を確保するため
に、Controller > Mirror all Commands to Remote Ovation Sequencers機能を使用することができま
す。しかし、これはサンプルアキュレートな同期を保証するものではありません。正確なサンプル精度のバック

アップが必要な場合は、両方のシステムのいくつかのキー Cue をマスター/スレーブとして設定することができ
ます。通常メインマシンとバックアップマシンで同一の Show を実行し、 Show 中に手動でトリガーされる Cue
は、メイン Ovation でマスター、バックアップでスレーブとして設定されます。ルールやタイムドイベントでトリガー
される他の Cue は、マスター/スレーブを設定する必要はなく、シーケンサーエンジンによって両方のシステムで
同時に自動的にトリガーされます。Multi-Sequencer Synchronization 機能を使えば、手動でトリガーされた
Cue がバックアップマシンで確実に同期されるようになります。メインマシンに問題が発生し、バックアップマシン
に切り替える必要がある場合は、オーディオ出力をバックアップマシンに手動で切り替えるだけです。その後の

Cue の手動制御はこのマシンで行います。

注意：矛盾したコマンドを避けるために、バックアップに切り替えた後は、マスター Show を停止する必要があり
ます。

Using Multi-Sequencer Synchronization
マルチ シーケンサー同期を使用する前に、マスターとスレーブの両方のシーケンサーにIP通信が設定されてい
る必要があります。

IP Connection を参照してください。

Multi-Sequencer Synchronizationをオンにし、Show Properties でグローバルパラメータを設定します。
Multi-Sequencer Synchronization を参照してください。

個々の Cue のパラメータは、同期させたい各 Cue のCue Propertiesで設定します。
REMOTE CONTROL: Multi-Sequencer Synchronizationをご覧ください。

Ovation Modes

Compose Mode
Show のデザインと組み立ては、Ovation の Compose Mode で行います。

Show Mode
Show は Ovation の Show Mode で実行されます。Initialize Showボタンをクリックすると、Ovationが
Show Modeになります。

Show の開始
Start Show をクリックするか、Ovation キーボードの Start Showボタンを押すと、様々なことができます。

● Hot Cue と Custom Cue を Fire できるようになりました
● Show Timeに設定された Timed List は、指定された時間にCueを Fire します。
● Standard Cue List が Fire 可能になりました。
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Show
Showは、最上位のレベルです。 Show はファイル拡張子が .ovs で保存されます。 Showはさまざまな要素
を制御します。実行可能な Show には、必ず1つ以上の Cue Listが含まれています。この Cue List には、メ
ディアファイルを指す Cueや、MIDI, GPO, DMX, IP などを含む Cueが1つ以上含まれています。

Cue Lists
Cue List の表示はモーダルです。つまり Show が初期化されていないときは Compose Modeになっていま
す。 Show が初期化されると Cue List の表示は Show Modeに切り替わります。

Ovationが Compose Modeの時、Cue List のメインエリアには、リストに追加されたすべての Cue と子 Cue
のツリー構造が表示されます。 Show Modeの表示は、Cue List の種類や Compose Mode での選択に応じ
て異なります。

注意: Cue List を個別に保存せずに閉じた場合、その内容は失われます。  Cue List を閉じようとすると、次の
ようなダイアログが表示されます。

Close Cue List Dialog

Multiple Cue Lists
Ovationでは、 Show で複数の Cue List を扱うことができます。メインウィンドウの Show Control は、現在選
択されている Cue List を操作します。メインウィンドウ のShow Control が選択した Cue List を制御している
とき、キーボードショートカットまたは外部ハードウェアコントローラを使って Hot Key Cue List を同時に制御す
ることができます。

Timed Cue Listは、特定のTimed Listが選択されているときにメインウィンドウの Show Control によって影響
を受けない限り、Compose Mode で設定した Interaction Rulesに従います。

Audition
オーディオオーディションは、Settings > Application > General > Audition で選択した Output Slot で再生さ
れます。
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Selected Cue
現在選択している Cue は、Cue List の Auditionボタンをクリックするか、Cue > Audition/PFL をクリックす
ると試聴できます。Auditionボタンの隣にある小さな下矢印をクリックすると、Auditionのトランスポートコント
ロールの全機能にアクセスできます。Audition Toolbarを参照してください。

Cue をダブルクリックしても Audition を行うことができます。2 度目のダブルクリックで Auditionが停止しま
す。

Audition Jump
Audition には 6つの ジャンプコマンド があります。これらのコマンドは、Cue を Audition しているとき、
Audition Toolbar や Ovation キーボードの Rewind ボタン, Fast Forwardボタンをクリックするとキーボード
ショートカットや修飾キーを使ってのみ利用できます。

● Audition Jump Forward 1：1秒後の時間にジャンプ（Ctrl + ->キーまたは早送りボタン）
● Audition Jump Forward 2：5秒後の時間にジャンプ（Ctrl + Shift + ->キーまたは早送りボタン）
● Audition Jump Forward 3：15秒後にジャンプ（Ctrl + Shift + Alt + ->キーまたは早送りボタン）
● Audition Jump Back 1：1秒前の時間にジャンプ（Ctrl + <-キーまたは巻き戻しボタン）
● Audition Jump Back 2：5秒前に飛び戻る（Ctrl + Shift + <-キーまたは巻き戻しボタン）
● Audition Jump Back 3: 15秒前にジャンプする（Ctrl + Shift + Alt + <-キーまたは巻き戻しボタン）

Cue List Pane
新しい空の Cue Listペインを開くには、Ovation のメインウィンドウのメニューから Cue List > New >
(required type) を選択します。

Empty Cue List Pane - Compose Mode

タイトルバーは、  Cue List が選択されていると、淡いグリーンでハイライトされます。トップハットピンアイコン
は、ペインがドッキングされているときに Auto Hide（自動非表示）モードを切り替えます。

Edit Toolbar
ツールバーでの作業を好む人のために、編集ツールバーが用意されています。デフォルトでは、Compose
Mode でのみ表示され Cue List > View Edit Toolbar でツールバーを表示するように設定されている場合の
み表示されます。

29



注意: ツールバーの右にある >>ボタンは、他のツールバーボタンにアクセスします。ペインを十分な幅にリサイ
ズすると、すべてのツールバーボタンが表示されるようになります。

Empty Cue List Pane. Full width Toolbar - Compose Mode

Cue Properties 現在選択されている Cue の詳細を表示する Cue
Propertiesペインを開く。

Cue Gain Cueのゲインを変更する Cue Gainのダイアログを開きま
す。

Add 新しい Empty Cue をリストに追加します。矢印をクリックする
と選択肢があります。

Add Short Empty Cue 1S長の空のCueを追加します。トリガーとして使用します。

Add Long Empty Cue 24Hの長い空のCueを追加する。条件付きルールに使用しま
す。

Load MTInterChange XML

Load Audio File

Import CD Tracks

Remove 選択しているCueを消します。

Edit in Pyramix 選択しているCueをPyramixで編集します。

Replace Audio Media ブラウザウィンドウを開きます。現在のオーディオメディアファ
イルの代わりに使用したいオーディオメディアファイルを選
び、「開く」をクリックします。

Snapshot Automation 選択したCueで  Filter Mixer Controls to Snapshot ダイア
ログを開きます。

Paste Automation 選択されたCueに その前にコピーされたCueのAutomation
Snapshotをペーストします。

Audition Settings > Application Settings > Audition で選択した出
力スロットで、選択した Cue を再生します。ドロップダウンに
は、標準的なオーディションのオプションが表示されます。

Move Down 選択された Cue を  Cue List の1つ下の位置に移動します。

Move Up 選択された Cue を  Cue List の 1 つ上の位置に移動します

Nest 選択された Cue を、リスト内で上に位置する Cue の子 Cue
にします。 Cue は、必要に応じて任意の深さでネストできま
す。例えば、子-子 Cue など。

Un-Nest 選択された Cue をネストレベル上に移動します。単純な子
Cue の場合は、一番上の Cue レベルに戻します。
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Cues in Cue Lists

Cue Colours - Show Mode

Cue Status
Show モードでは、Standard Cue List の Cue は4つの状態のうちの1つになります。

Asleep

Ready

Playing

Paused

Cue Statusは、ラベルとハイライトの色で示されます。

Asleep Asleep ハイライト無し

Ready Ready 紫のハイライト

Playing Playing 緑のハイライト

Paused Paused 黄色のハイライト

赤枠
フォーカスされている Cue には、点滅する赤いボーダーが表示されます。つまり、この Cue は、次に「Fire」、「
Pause」、「Stop」ボタン、「Keyboard Shortcuts」、「Remote Control」のいずれかを起動したときに影響を受け
る Cue です。

Cue Progress
Cue が実行されると、そのリストエントリまたは（ホットキーボタン）には、 Cue の進行状況が3つの方法で表示
されます。

左側のカウンターには、 Cue の開始からの経過時間が表示されます。

右側のカウンターは、 Cue の終了までの残り時間を示します。

黒いプログレスバーは、 Cue の再生に合わせて左から右に移動します。
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Cue を一時停止した後に再開した場合、プログレスバーには前回の一時停止からの経過が表示されます。(上
記のように)

Cue Fire Buttons
Show Mode では Cue に Fire / Pause と Stopボタンが表示されます。

Cue List with Fire Buttons - Show Mode

Show Propertiesの Show Time Options セクションで Cue Fire Buttons フィールドが Yesに設定され
ている場合、 Show Mode で Cue Fire Buttonsが表示されます。

Fire Toolbar
Standard Cue List で Fire Toolbarが選択されている場合（View > View Fire Toolbar）、Show Mode で
Show の準備が完了すると Cue List ペインは次のように表示されます。

Cue List with Fire Toolbar - Show Mode

Cue List の１つ前の子Cueを選択
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Cue List の次の子Cueを選択

選択しているCueをFireし、次のCueを選択

Cue List の一つ前のCueを選択

Cue List の次のCueを選択

選択しているCueをFireし、そのCueはそのまま再度FireされるためにReady

選択したCueをPause

選択したCueをStop

Cue List Types
Standard Cue Lists:
シーケンシャルなイベントが手動でトリガーされるリスト

Timed Cue Lists:
指定された時間に自動的に、または手動でトリガーすることができる Cue 付きリスト

Hot Keys Cue Lists:
ホットキーモードでいつでもトリガー可能な Cue のリスト。

Custom Keys Cue List
Hot Key リストのように動作しますが、 Cue ボタンをカスタマイズできるリスト。

Cue Browser List
ファイルシステムやネットワーク上のフォルダのコンテンツを Cue として表示するリスト。

Hot Browser Cue Lists
Cue Browser List と同様の機能を持つリストですが、シングルクリックで Cue が起動します。Cue を他の
Cue List にドラッグアウトすることはできません。通常、オーディオファイルプレーヤーとして使用されます。
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Cue List Detail

Cue List の選択
Cue List は次のように選択できます：

● クリックする

● Tabキーで利用可能なすべての Cue List を循環して選択する（またはOvationキーボードのSelect
Cue Listボタン）。

● Show Mode で、Ctrlキーを押しながら Hot Key のトリガーボタンを押す。(Ovationキーボードでは
1-48、PCキーボードでは標準マッピングで 1 - 0のキー )

Standard Cue List

Cue List Pane with Show Control - Show Mode

これは基本的なモードです。Cue は Cue List が選択されているときにメインパネルの Show Control ボタン、
Active Cueパネルのボタン、および Cue List ペインの Toolvar ボタンから Fire, 一時停止, 停止することが
できます。
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Timed Cue List

Timed Cue List - Show Mode

Go Timeが設定されているCueは、スタートするとあらかじめ設定されたタイムシーケンスに従います。Show
Controlから Cue を手動で Fire することもできます。

Hot Keys Cue List

Hot Keys Cue List Pane - Show Mode

この Cue List では Show Mode のときに各 Cue が Fire ボタンとして表示されています。スポットエフェクトに
使用されるこのモードは、キーボードのショートカットや外部ハードウェアコントローラでよく使用されます。Hot
Key Cue List の Cue は、Show Control からも FIre できます。

Hot Cue の停止
再生中に Hot Cue を停止するには、Alt + クリックします。ダブルクリックは危険なので行わないでください。
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Hot Keys Cue List のデザインモード
Hot Keys Cue List には Hot/Custom Keys Design Mode があり、Hot Keys View に Cue を配置することが
できます(詳細は以下を参照)。このモードに入るには Cue List を右クリックしてコンテキストメニューを開き、
Hot/Custom Keys > [Hot/Custom Keys Design Mode を選択するか Cue List メニューで選択します。

Hot Keys のスロットは、Cue が含まれていてもいなくても常にグリッド上に表示されます。

Hot Keys Cue List Pane - Design Mode

注意：スロットは可能な限り自動的に正方形に保たれます。

● Hot Key の番号は、Hot/Custom Keys Design Mode の設定に従います。

● Cue List が Automatic Cue Numbering Mode になっている場合、すべてのCueは Cue List の標準
的な順序を反映して、Hot Key View に次々と表示されます。このモードでは Cue の配置は自動的に
行われ、Hot/Custom Keys Design Mode で手動で変更することはできません。

● Cue List が Automatic Cue Numbering Mode でない場合、Cue はその Cue Number に対応する
Hot Key スロットに表示されます。Cue 番号は、Hot/Custom Keys Design Mode.の場合、Cue
Properties パネルで変更するか、Hot Keys に Cue を直接ドラッグ アンド ドロップしてください。

Hot Keys Columns
Hot Key ビューに表示される列数を手動で設定することができます。

この設定は Hot Keyの Cue List Propertiesペインで行います。

Number of Columns が Autoに設定されている場合、システムは Cue Listペインのサイズに応じて列数を自
動的に調整しますが、Automatic Cues Numbering の設定には従い、必要に応じて空のスロットを残します。

Hot Keys Column to Audio Slot Mapping
Cue List Properties で Hot Keys の列を Audio Slots Mapping でオーディオスロットにマッピングできます。

● Noに設定した場合、すべての Cue はその Cue Properties で定義した Audio Output Slot から再生
されます。
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● 数字（1, 2, 6）を設定した場合、Cue は Hot Key の列に対応するオーディオスロットで再生されます。
Cue は、配置された列によってオーディオ出力に割り当てられます。

注意：このモードでは、実際のオーディオ出力スロットは Cue コラム番号に Hot Keys Column to Audio
Slot Mapping フィールドで設定した数を掛けたものになります。これにより、モノラル(1)、ステレオ(2)、サラウ
ンド(6)の Cue を扱うことができます。

Triggering Hot Keys
Hot Keys は、Ovation専用キーボード, インストールされているコントローラ, キーボード ショートカット（Hot Key
01～48）のいずれかでトリガーできます。

注意：Ctrlキーを押しながらトリガーボタンを押すと、Cueは Fire されるのではなく選択されます。Ctrl + Shift
を押しながらトリガーボタンを押すと、Cue List が選択されます。

Ctrlが押された場合、指定した Cue を選択（Fire なし）

Ctrl + SHIFTキーが押されていれば、Cue Listを選択します。

Custom Keys Cue List

Custom Keys Cue List Pane - Design Mode

機能的には Hot Keys Cue List と同じですが、ボタンの形状, 色, テキストの色, フォント, フォントサイズ, 位置
などをカスタムデザインできます。Show Edit Mode では、Hot Keys Cue List と同様にStandard Cue List と
して表示され、簡単にCueを管理することができます。また Custom Key Design Mode というオプションもあり
ます。

Custom Keys Design Mode
このモードに入るには Cue List を右クリックしてコンテキストメニューを開き、Hot/Custom Keys >
Hot/Custom Keys Design Mode を選択するか、Cue Listのメニューから選択します。

ボタンをクリックして変更します。黒いボックスをクリックしてドラッグすると、ボタンのサイズが変更され、ボタンの

任意の場所をクリックしてドラッグすると、新しい場所に移動します。背景のドットはグリッドを表しており、サイズ

変更や移動はすべてグリッドにスナップします。Custom Keysサブメニューには、Snap all Keys on Grid,
Reset all Keys Position, Reset all Keys Size and Positionのコマンドがあります（Snap all Keys on
Gridは、グリッドのサイズが変更されたときに素早く調整するために用意されています）。

注意：Standard Cue List の Cue は、フォントやラベルの背景をカスタマイズできます。
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Grid Size
グリッドサイズを調整するには Cue List Propertiesペインを開き、Custom Keys セクションの Custom
Keys Grid Size フィールドの値を変更してください。

Color and Font
選択したボタンの色やフォントを変更するには Cue List Propertiesペインを開き、Custom Keys セクション
を探します。

Custom Color フィールドでは、RGBカラーの値を数値で入力することで色を直接変更できます。また、フィー
ルドの右側にある ...ボタンをクリックすると、カラーピッカーが表示されます。標準色とカスタムカラーが用意さ
れています。同様にフォントの色を変更するには、Custom Font Color フィールドを使用します。フォントの属
性を変更するには、カスタムフォントフィールド内をクリックします。…ボタンをクリックすると、システムにインス
トールされている任意のフォントを選択できる標準フォントダイアログが開き、font style, Regular, Italic, Bold,
Bold Italic を設定し、フォントサイズを選択することができます。

Justification
Custom Fontが定義されていない場合、ボタンのテキストは他の Cue と同様に左揃えになります。Custom
Fontが設定されている場合は、ボタンが「グラフィック的な意味」を持つ可能性が高くなります。そのため、テキ
ストは自動的に中央に配置され、複数行が許可され、大きなボタンにできるだけ多くのテキストを収めるようにな

ります。

通常、これは以下のような Cue に使用されます。

Custom Keys Cue List - Show Mode Custom text

注意：Cue List が Automatic Cue Numbering モードに設定されていない場合 （Cue List Properties :
Automatic Cue Numbering フィールドが Noに設定されている場合）、上の例のように無関係であれば、
Custom Keys Cue List のすべての Cue の番号を何も設定しないことができます。これは、カスタム  Cue List
のデフォルトの状態です。
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Cue Browser Cue List

Cue Browser Cue List

この特殊な Cue List では、Ovationのメインインターフェイス上で、メディアファイルをブラウズしたり、試聴した
り、他の Cue List に Cue としてコピー＆ペーストしたりすることができます。太いスクロールバーは、タッチスク
リーンでの操作を容易にするためです。

Parentはフォルダを１つ上に上げます。

Refreshはリストをリフレッシュします。

リスト内のメディアファイルをダブルクリックすると、そのファイルが再生されます。

Auditionモードでは、 Show の実行中に関わらず常に Cue が再生されます。このタイプの Cue List では、他
の Toolbar はすべて無効になります。

Cue Browser は、 Cue を検索して他の Cue List にコピー/ペーストするのに非常に便利です。右クリックして
表示されるコンテキストメニューでコピー＆ペーストができます。

Cue の検索機能
Browser と Hot Browser Cue Listsには、パス名の右側に <Search> テキストボックスがあり、ファイルの検
索/フィルタリングができます。これは Vista Explorer の検索と同じように動作します。

● 何も入力されていない場合は、現在のフォルダの内容がサブフォルダ名も含めて表示されます。

● 何かを入力すると、そのテキストを名前に含むすべてのファイルが表示され、サブフォルダ内のファイ

ルも再帰的に含まれますが、サブフォルダ名は表示されません。

● ファイルを検索する際、コメント欄にはファイルが見つかったパス名が自動的に入力されます。
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Hot Browser Cue List

Hot Browser Cue List

Hot Browser Cue List は Browser Cue List と非常によく似ていますが、以下の重要な違いがあります。

● シングルクリックすると、 Cue が起動します。

● 再生中の Cue をシングルクリックすると、 Cue が Pause します。

● Pause した Cue をシングルクリックすると、Pause した時点から Cue が再開されます。

● 再生中の Cue をダブルクリックすると、 Cue が停止します。

● Cue を他のリストにドラッグしたり、コピー＆ペーストすることはできません。

● Parent ボタンと Refresh ボタンは、タッチスクリーンでの操作を容易にするために大きくなっていま
す。

Parentはフォルダを１つ上に上げます。

Refreshはリストをリフレッシュします。

注意：Hot Browserの Cue List タイプは、通常オーディオファイルプレーヤーとして使用されます。

Cues
Cue とは、アクションを実行するための一連の命令のことです。これらのアクションは、メディアファイル（マルチ
チャンネル/マルチメディア、Pyramixコンポジションなどの場合はファイル）に対して行うことができ、外部または
内部のデバイスに指示を送ることもできます。例えば マイクの入力をオン／オフしたり、ミキサーのスナップ
ショットを変更したりすることができます。Cueはメディアファイル全体を再生する必要はありません。Cue
Propertiesペインを使って、長さを Cue 全体に設定したり、開始点をメディア ファイル内の任意の位置にオフ
セットすることができます。
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Active Cueウィンドウの Cue Trimmerオプションでは、In point, Out point, In / Out fades.をすばやく簡
単に調整することができます。Cue Trimmer をご覧ください。

Cue Icons

Cue Type Icons

Cue に オーディオ、マイク入力, タイムコードジェネレータ, MMC, MIDIコマンド, Sony P2/RS422, GPO, シェ
ルコマンド, ミキサースナップショットの各オプションが有効な場合、専用のアイコンが表示されます。

Selecting Cues
Cue の選択は Cue をクリックすることで行います。複数のCueの選択は通常のWindowsの方法で行います。
Ctrl + Click を行うと 選択を維持したまま、個々の Cue の選択を切り替えます。連続した範囲を選択するに
は、最初の Cue をクリックした後に最後の Cue を Shift + Clickすると、連続したブロックが選択されます。

また、Ctrlキーを押しながらOvationキーボードまたはPCキーボードの Hot Key を押すと、Cue を選択するこ
とができます。

Cue の移動とコピー
選択した Cue は、Windowsの標準的なショートカットを使って移動やコピーができます（Ctrl + Cによるコピー,
Ctrl + Vによるペーストなど）。また Cue List 間の Cue の移動は、ドラッグ＆ドロップ で行えます。Ctrlキーを
押しながらドラッグ＆ドロップするとコピーされます。

Altキーを押しながらドラッグ＆ドロップすると、移動先の Cue のオーディオが移動元の Cueのオーディオに置
き換えられます。Windowsエクスプローラからオーディオファイルをドラッグ＆ドロップすることで、簡単に Cue
を挿入することができます。

Cue / Cue List Context Menu
Cue List 内の Cue または空白の領域を右クリックすると、以下のオプションを含むコンテキストメニューが表示
されます。

Undo

Cut

Copy

Paste

Add Cue>

Add Short Empty Cue

Add Long Empty Cue

Add Cue Shortcut 現在選択している Cue と同じ名前、コメント、色を持
つ新しい Cue を追加し、ショートカットの起動時に親
Cue を起動するルールを設定します。

Load MTInterChange XML
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Load Audio File オーディオファイルを選択するブラウザを開きます

Import CD Tracks CDインポートを行います

Record Audio as New Cue Record Audio ダイアログを開きます

Remove 選択したCueを消去します

Edit in Pyramix Pyramixで編集します

Consolidate 選択したCueがShow Audio Files Folderに存在しない場合、またはSamping Rateが
Show Rateと異なる場合、Consolidate Cuesダイアログが開きます。それ以外の場合
はメッセージを表示します。すべてのファイルがすでに適切に統合されているので何もす
る必要はありません。

Record Audio Record Audio ダイアログを開きます

Replace Audio Media (オーディオを含む Cue にのみ表示されます。) ブラウ
ザウィンドウを開き、選択した Cue の現在のファイル
を置き換える代替オーディオメディアファイルを選択し
ます。

Snapshot Automation ミキサーの状態のスナップショットを取得します。これ
はCueによって呼び出されます。

Paste Automation クリップボードにあるオートメーションのスナップショット
を、選択したCueに適用します。

Change Audio Gain Cue Gain フェーダーを開きます。

Edit Rules Interaction Rules ダイアログを開きます

Add Rule > Cue に適用されるルールのリストを表示します。

Fire Next Cue when Ending

Fire Next Cue when Stopping

Fire All Child Cues when Starting

Stop Previous Cue when Starting

Loop (Fire Itself when Ending

Loop between Markers (Fire Itself between Markers

Dim All Cues when Starting

Select Next Cue when Starting

Copy Rules 選択したCue Rulesをクリップボードにコピーする

Paste And Replace Rules 選択したすべての Cue の現在のルールを、以前にコ
ピーしたルールで置き換えます

Paste and Add Rules 選択されたすべての CUE の現在のルールに、先にコ
ピーされたルールを追加します

Audition/PFL 選択されたAudition出力で Cue を再生します メディ
ア Cue 以外のCueは動作が異なります
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Audition >

Start

Rewind

Stop

Play/Pause

Fast-Forward

End

Jump Forward 1

Jump Forward 2

Jump Forward 3

Jump Back 1

Jump Back 2

Jump Back 3

Pin/Unpin to Active Cue Window Cue の Pined / Unpinned を設定します。Pinが
Active Cue Windowでアクティブになっている場合、
Pinされた Cue は選択されるとActive Cue Window
に表示されます。ピン留めされていない場合は表示さ
れません

Lock in Active Cue Window Active Cue Window で Lockが有効になっている場
合、これを選択すると Active Cue Window で選択さ
れた Cue が Lock された Cue の代わりになります(
Cue を Alt + Click しても同様の効果が得られます)

Move Down

Move Up

Nest

Unmest

Move Down

Hot/Custom Keys

Hot/Custom Keys Design Mode

Snap all Keys on Grid

Reset all Keys Position

Reset all Keys Size and Position

Fire

Pause

Stop
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Cue
Properties

Cue Propertiesを表示/非表示します

Consolidate Cue
安全性、正確性、安定性を最大限に高めるためには、すべてのオーディオ Cue のサンプリングレートが Show
と同じであることが望ましいです。オーディオファイルを読み込んで Cue を追加した際に、サンプリングレートが
Show と一致しない場合、Consolidate Cues ダイアログが開きます。この機能は、Cue メニューまたは右ク
リックのコンテキスト Cue メニューで Consolidate を選択することで、選択された既存の Cue に対しても呼び
出すことができます。

Consolidate Cues dialog

No を選択した場合、Cue は現在の場所に残り、Ovation Sampling Rate Conversion Engine で再生されま
す。Yesを選択した場合、オーディオファイルのコピーとサンプリングレートの変換（必要な場合）のプロセスが開
始されます。

Consolidating Cues... dialog

Consolidate Cue機能が選択されていて、Audio Filesが Show Audio Filesフォルダに入っていて、かつ
Showと同じサンプリングレートである場合、このメッセージが表示されます。

Consolidate Cues message

44



CD Tracks Import
OvationにはCDインポート機能があります。

Cue メニューまたは Cue / Cue List コンテキストメニューから、Cue > Add Cue > Import CD Tracks を選
択すると、Import CD ダイアログが表示されます。

CD Import dialog

Device Settings
コンボ ボックスのドロップダウン リストには、マシン上のドライブがすべて表示されます。
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Settings
Settingsボタンをクリックすると、特定のドライブ設定のダイアログボックスが開きます。これらの設定は、必要
に応じて項目をクリックし、ボックスに値を入力することで変更できます。

CD Import Settings dialog

Status
設定ボタンの右側には、CDの読み込みに関する情報が表示されます。

Disc Content
Read TOC… クリックすると CDに収録されている Table Of Contents が表示されま

す。下のペインにトラックが表示されます。

Read ISRC, UPCEAN &
CDtext

チェックを入れると情報がある場合はそれも読み込まれます。

Query Database クリックすると、オンラインデータベースを利用して、市販CDのトラック
名などのデータを取得できます。結果は、ダイアログに表示されます。
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CD Import Query Database results dialog

複数のディスクタイトルが表示されている場合は、該当するディスクをクリックして選択し、OKをクリックすると
データが取り込まれます。Clip Prefix:の欄にディスク名が自動的に入力されます。

Database Settings クリックすると、データベースのアドレスやその他の設定を変更するためのダイアロ

グが表示されます。

CD Import Database Settings dialog

デフォルトの設定は上記の通りです。設定を変更するには、その項目をクリックして入力します。OK "をクリック
すると、変更した設定が保存されます。

Defaults はデフォルトの設定に戻し、"Cancel "は変更を加えずにダイアログを閉じます。

Import All Tracks アクティブにすると、トラックリストのチェックボックスの選択にかかわらず、CDの
すべてのトラックが取り込まれます。

Import Selected
Track(s)

アクティブにすると、選択された（トラックリストでチェックされた）トラックのみがイ
ンポートされます。

Select All クリックすると、リスト内のすべてのトラックが選択されます。

Deselect All クリックすると、リスト内のすべてのトラックの選択が解除されます。
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Target File
Destination Drive: 結果のファイルが置かれるフォルダーを示します。

Format: ファイルフォーマットの選択です。以下のファイルフォーマットが選べます。

PMF, SD2, AIFF, FLAC, Ogg Vorbis, MP3/MPEG-1/2 Audio, MP4/AAC, DSDIFF, DSDIFF Edited
Master, Virtual Tape, Wave, BWF, CD Image, MTFF, Digital Release, OMF

Waveform: 波形ファイルを 録音中に生成する / 録音後に生成する / なし のいずれかが
選択できます。

Sampling Rate 読み込み時のサンプリングレートを選択できます。44.1kHz以外を選択する
と、読み込み時に自動的にサンプリングレートが変換されます。

Prefix チェックすると、インポートされた各トラックにプレフィックスが追加されます。デ
フォルトではCDのタイトルが付けられますが、ボックスをチェックすると任意の
プレフィックスをフィールドに入力することができます。

Track バーにインポートされる各トラックのプログレスバーが表示されます。

Disc バーに選択したすべてのトラックまたはディスク全体のインポートの進行状況
が表示されます。

Import Tracks クリックするとインポートを開始します。

Cancel インポートをキャンセルし、ウィンドウを閉じます。

Keep window open
after Import

インポートが完了した後も、CDインポートウィンドウが開いたままになります
（例：次のインポートのため）。このオプションを選択すると、Prefix labelフィー
ルドがグレーアウトします。

Cue Capabilities
Cue は メディアファイルの再生やバッチファイルの実行などのアクションを開始または応答するコマンドの コン
テナオブジェクト です。Cueは 単一または複数の機能を持つことができます。Cue タイプ１つで様々な機能をカ
バーします。

Audio
Cue は、モノラル, ステレオ, マルチチャンネルのオーディオメディアファイルの再生をトリガーすることができま
す。多くのエレメントを含む Pyramixコンポジション の再生をトリガーすることもできます。

TimeCode Generator
Cue は外部機器に LTCを出力することができます。
Propertiesペインの TimeCode generator セクションで 適切なシリアルポートを選択してください。

MTC
Cueは ハードウェアまたはソフトウェアデバイスにMTC（MIDI TimeCode）を送信できます。
Properties ペインの TimeCode generator セクションで 適切なMIDIポートを選択してください(Cueの設定は
Cuelistの設定よりも優先され、CuelistはShowの設定よりも優先されることに注意してください)。

MMC
Cue は MMC（MIDI Machine Control）コマンドをハードウェアまたはソフトウェアデバイスに送信することがで
きます。

Cue Properties ペインの MMC セクションで適切なMIDIポートを選択し、スタートタイムを入力します。
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Fireは MMC Play コマンドを、Pauseは MMC Pause コマンドを、Stopは MMC Stop コマンドを送信しま
す。

MIDI Command
Cue は一般的なMIDIコマンドをハードウェアまたはソフトウェアデバイスに送信することができます。

Sony P2 / RS422
Cueで Sony P2 / RS422コマンドを、適切に装備されたハードウェアデバイスに送信できます。これには、
VCube も含まれます。詳細は Sony P2 over IP をご覧ください。

Fireは Sony P2 Playコマンドを、PauseはSony P2 Jog(0) コマンドを、StopはSony P2 Stop コマンドを
送信します。

IP Command
出力するデータは Cue Propertiesペインの入力欄に追加することができます（各 Cueに固有）。IPコマンドの
フォーマットは ASCII, HEXA(16進数), OSCのいずれかです。出力ポートの選択も可能です。

GPO
Cueはシリアルポートとアダプタを介して、適切な装備を持つハードウェアデバイスにGPOコマンドを送信するこ
とができます。GPO, GPO Section をご覧ください。

Shell Commands/Scripts/Batch files
詳細は Shell Command / Script / Natch Section をご覧ください。

Microphone Switch
Cue で ミキサーの入力をマイクに切り替えることができます。Microphone Switch Section を御覧ください。

Mixer Automation
Cue で Ovation ミキサーのスナップショットをトリガーすることができます。Cue で Ovation ミキサーのダイナ
ミック オートメーションをトリガーすることもできます。詳細は、Snapshot Automation と Dynamic
Automation をご参照ください。

REMOTE CONTROL: General MIDI Command
CUE は General MIDI コマンドでリモートコントロールできます。詳細は、REMOTE CONTROL: General
MIDI Command をご参照ください。

REMOTE CONTROL: IP Command
IPコマンドで Cue をリモートコントロールできます。

REMOTE CONTROL：マルチシンセサイザーの同期
個々の Cue は、セカンダリースレーブまたはマスターマシンに同期させることができます。詳しくは
Multi-Sequencer Synchronization ををご覧ください。

REMOTE CONTROL: Dataton との同期
Cue は、Dataton ビデオプレーヤーのタイムラインと同期させることができます。

Empty Cues
空の Cue は、Addボタンをクリックするか、メニューの Cue > Add > Add 、または右クリックからのコンテキ
ストメニューから作成できます。空の Cue には、メディアやコマンドを後から追加することができるので、メディア
が利用可能になる前に  Cue List を作成することができます。また、Empty Cueを Cue Rules と組み合わせ
て、複雑なインタラクションを構築することもできます。
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Compound Cues
1つの Cue には、一度に多くのことを実行する命令を含めることができます。例えば、オーディオメディアファイ
ルを再生し、照明を暗くするなどです。Cue に機能を追加するには、Cue Properties ペインの各セクションで必
要なオプションを設定します。

Scenes
Cue は必要に応じて何層にもネストすることができます。操作上の便宜を図るため、最上位のレベルをScene
と呼びます。例えば、劇場での作業において、シーンに関連するすべての Cue と Child-Cue が単一のトップレ
ベル Cue の下に入れ子になっている場合、Sceneボタンはこれらのシーン間で素早く変更することができ、
Cueナビゲーションボタンは各 Child-Cue を順に表示します。

Mixer
Ovation の Show にはオーディオミキサーが関連付けられています。このミキサーは要件に合わせて設定する
ことができます。

Cue ベースの Snapshot オートメーションや Dynamic オートメーションも行うことが可能です。詳しくは
Snapshot Automation と Dynamic Automation の章をご覧ください。

ミキサーの構成の詳細については、Pyramixユーザーマニュアルの Mixerの章を参照してください。

注意：現在のところ、ストリップやエフェクトなどを追加するには、現在の Show を初期化し、開始し、停止してミ
キサーを再構築する必要があります。

Automation

Snapshot Automation
すべての Cue はミキサーのスナップショットを保存し、Cue が起動したときにそれを呼び出すことができます。ミ
キサーへのスナップショットの変更は、Cue が Fire されたときに即座に Cue の全長にわたってリニアに、また
はユーザーが定義した期間にわたってリニアに実行させることができます。

Snapshot の保存
● Snapshot を入れたい Cue を選択します。
● ミキサーコントロールを必要な値に設定する。

● Cue Propertiesペインを開きます (表示されていない場合)。
○ Mixer Automation > Type フィールドでコンボボックスをクリックし、Snapshot または
○ Cue > Snapshot Automation または
○ マウスの右ボタンで Cue のコンテキストメニューから Snapshot Automation を選択しま
す。

この操作を行うと Filter Mixer Controls to Snapshot ダイアログが開きます。
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Filter Mixer Controls to Snapshot dialog

このダイアログは Pyramix のダイアログと似ており、By Stripsボタンと By Typesボタンで2つの表示を切り
替えることができます。

注意：表示を切り替えると、選択範囲がデフォルトに戻り、全てが選択された状態になります。

By Strips
この表示では、現在のミキサーでオートメーションできるコントロールがツリー構造で表示されます。チェックボッ

クスには Snapshot に含まれるコントロールまたはコントロールグループが表示されます。

Allボタンはすべてのボックスをチェックします。

Nothingボタンは、すべてのボックスをオフにします。
● Snapshot に含めたいミキサーコントロールを選択します。
● OKをクリックしてスナップショットを記録し、ダイアログを閉じます。

Current Snapshot では、Cue ですでに オートメーションに含まれているアイテムを表示します。
● 必要に応じて、ミキサーコントロールを変更します。
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● OK をクリックすると、変更した Snapshot が保存され、ダイアログが閉じます。

Snapshot の消去
● Snapshot を削除したい Cue を選択します。
● Cue Properties を開きます (表示されていない場合)。
● Snapshot フィールドの Type コンボボックスをクリックして None を選択します。

Glide
Snapshot を含む Cue が実行されると、デフォルトでは変更が瞬時に適用されます。この動作は変更可能で
す。オプションは、ユーザーが定義した期間をリニアに変更するか、 Cue の長さ全体をリニアに変更するかで
す。

デフォルトの動作を変更するには、次のように操作します。

● Cue Properties を開きます。

● Mixer Automation セクションで

● Glide フィールドをクリックします。

● グライドタイムを設定したい場合は、_:_:_:_ の時間入力エリアに適切な値を入力してください。

● Cue の全長にわたってグライドさせたい場合は、ドロップダウンリストで Cue Length を選択します。

注意： Cue の長さよりも長い値を入力した場合は、 Cue の長さ以上のグライドが発生します。

Apply Snapshot
ミキサーオートメーションの Snapshot を適用するには、 Cue を Fire するだけです。

注意：同じミキシングコンソールのコントロールを同時に制御する2つの Snapshot は「衝突」します。このような
状況は避けてください。

Snapshot はオーディションすることができますが、FF/REWやスクラブはできません。

Copy and Paste Snapshot
Snapshot をコピーするには、Snapshot を含む Cue をコピーします。

スナップショットを貼り付けるには、対象となる Cue を選択し、 Cue の右クリックメニューから Paste
Automation を選択します。

または、Cue > Paste Automation を選択します。オートメーションの Snapshotは、メディアファイルやその
他のパラメータに影響を与えることなく、ターゲットのCueに追加されます。
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Dynamic Automation

Direct in Ovation
● ミキシングコンソールのオートメーションをOvationに直接記録することができます。

● Cue を右クリックし、Start Recording Automation を選択します。

● Cue を Fire または Audition します。ミキシングコンソールの動きや変更は、Cueの再生中にCueに
記録されます。

● 複数のオートメーションレコードパスを、同じキューに次々と実行できます。Cue を Stop して、再度
Fire または Audition を行うだけです。最後に記録されたオートメーションパスは、Cue > Undoコマ
ンドを使っていつでも取り消すことができます。

● 終わったら、Cue を右クリックして Stop Recording Automation を選択します。

In Pyramix
ミキシングコンソールのオートメーションは、Pyramixで記録, 編集して、File > Publish to Ovation コマンドを
使ってOvationに送ることもできます。

Dynamic Automation は Pyramix で作成できます。Pyramixでオートメーションを記録（編集）して、オーディオ
クリップの上に置くか、あるいはタイムライン上にオーディオを置かずに、Mark In と Mark Out で Ovation に
送るオートメーション領域の開始と終了を設定し、Project > Publish to Ovation as New Cueを行ってくださ
い。

Ovationでは Cue が作成され、起動するとPyramixで行ったのと同じようにOvationのミキサーコンソールが
オートメーションします。

Pyramix と Ovation のミキシングコンソールが同じである必要はありませんが、オートメーションしたエレメント
が両方に存在している必要があります。プラグインの場合は、順番と位置が同じでなければなりません。

オートメーションは Pyramix では 最初のトラック／最初のストリップ に記録しなければなりませんが、マルチト
ラックにすることもできます。Ovationで再生するときには、オーディオ Cue と同じように、Cue Properties >
Audio > Audio Output Slot パラメータを使って、オートメーションを最初のストリップ（とそれ以降）以外のスト
リップにシフトすることができます。

Pyramix のタイムラインにオーディオクリップとオートメーションが準備／録音中に含まれていた場合、Ovation
の Cue にもオーディオとそのオートメーションが含まれます。

Ovation の Dynamic Automation がサポートするミキシング コンソールのコンポーネントは以下の通りです。

● Faders
● Panning Control
● VS3 plug-ins
● VST plug-ins

以下のミキシング コンソールのコンポーネントは、Ovation  Dynamic Automation ではサポートされていませ
ん。

● General Mixing Busses controls
● Legacy busses controls and panners
● Masters

ミキシング コンソールのオートメーションを含む Cue は、Cue Properties > Mixer Automation > Type
フィールドに Console Automation と表示されます。
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この場合、Glideパラメータのデフォルトは Cue Length で、 Cue の長さを短くするとオートメーションが早く停
止することを意味します。

Glide が Automation Lengthに設定されている場合、オートメーショントラックの終了前に Cue が終了して
も、オートメーションは再生を続けます。オートメーションはその終わりまで止めることができません。

既知の制限事項
● パニングコントロールは1つしかサポートされていません。ミキシングコンソールには1つのパニングコン
トロールしかない必要があります。

● Edit In Pyramix で編集しても、オートメーションを Pyramix に戻して編集することはできません。

● Cue を一時停止しても、オートメーションは一時停止しません。

● Bus sendsのオートメーションは現在サポートされていません。
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Show Logging
Show ロギングは、再生されたオーディオファイルの一覧を示すログファイルを作成します。これは放送局にとっ
て便利な機能です。

ログの有効化と設定は Show Properties で行います。以下を参照してください。新しいログファイルは、
Every Show, Every Week, Every Month で作成され、Ovationがアクセスできる任意のフォルダに保存で
きます。ログファイルは削除されず、ファイル名に日付と時間が入った新しいファイルが作成されます。

ファイル名には以下が含まれます。

● Station Name
● Station Name + Date
● Station Name + Show Name
● Station Name + Show Name + Date

ログファイルは、以下のいずれかの形式で作成されます。

● ASCIIテキスト (.log)
● XML (.xml)
● Enco DADログファイル (.exp)

例：

ASCII Text (.log)

2013-04-03 16:07:40 00:00:02 I Love Rock N Roll.wav

XML (.xml)

<Cue>

<Name>I Love Rock N Roll</Name>

<Date>2013-04-03</Date>

<PlayedAt>16:32:21</PlayedAt>

<Duration>00:00:07</Duration>

<FileName>I Love Rock N Roll.wav</FileName>

<PathName>E:\Media\Music\I Love Rock N Roll.wav</PathName>

</Cue>

Enco DAD log file (.exp)

16:09:0100:00:0104/03/1300000I Love Rock N Roll Love Rock N Roll.wav

Other Modules
Ovationの中からオーディオ エディターなどの他のアプリケーションを呼び出し、データを交換することができま
す。例えば、Merging Technologies社のPyramixオーディオ エディターなどです。サードパーティのアプリケー
ションもサポートされる予定です。

55



Editing with Pyramix
注意：Secondary Audio Device は Native システムでは推奨されておらず、MassCore システムでのみ使
用できます。

MassCore™ システムでは、オーディオ Cue 、モノラル、ステレオ、マルチチャンネル、またはマルチトラックの
コンポジションを開いて編集を行うことができます。Cueにカーソルを合わせて右クリックしたコンテキストメ
ニューから Edit を呼び出すか、選択したCueに対して Cue > Edit を呼び出します。ただし、Pyramixでの編集
を行うには、Pyramixが起動していて、両方のアプリケーションが特定の方法で設定されている必要がありま
す。

例えば、ステレオ Cue を編集するための設定は次のとおりです。

1. Ovationが開いていれば閉じてください。

2. VS3のコントロールパネルを開きます。

VS3 Control Panel

3. Applicationのドロップダウンリストで Ovation を表示されていることを確認し、表示されていない場
合はリストから選択します。
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4. Platform ドロップダウンリストに MassCore™ が表示されていることを確認し、表示されていない場
合は、リストから選択します。

5. Audio Bridge セクションで ASIO device Mode を選択します。

6. Number of channels (I/O) ドロップダウンリストを 8に設定します。

7. Applicationのドロップダウンリストで Pyramix Virtual Studio を選択します。

8. Platform ドロップダウンリストで Native - ASIO を選択します。

9. I/O Selection Driver name:のドロップダウン リストで MT ASIO Bridge を選択します。

10. Ovationを起動し、Settings > Show Settings > Mixing Console > Slots Allocation に行きま
す。

11. Slots Allocationドロップダウンリストで、値を 6に設定します。

12. Ovation のミキシングコンソール（View > View Mixer）を開き、Strip 7 と 8 の Live INPUTS をそれ
ぞれ MT ASIO Bridge 1 と 2 に設定します。

13. Pyramixを起動します。

14. 新しい Pyramix プロジェクトを作成し、”Ovation Edit” などの名前をつけます。8:2のシンプルなミキ
サーがあれば十分です。

15. ミキサーのモニタリング セクションを開き、Configure タブを選択して、新しい Speaker Set を作成し
ます。”Ovation Edit” のような覚えやすい名前を付け、LとRのスピーカー出力を MT ASIO Bridge 1
と2にパッチします。スピーカーセットを起動します（別の方法として、Pyramix Mixerのステレオ出力ス
トリップの出力をMT ASIO Bridge 1と2にパッチしても結構です）。

16. Pyramixプロジェクトを “Ovation Editor” のような覚えやすい名前で保存します。

これでOvationのステレオ Cue を右クリックして Edit を選ぶことができます。

17. 選択した Cue が Pyramix で開きます。

18. 結果に満足するまで Pyramix で編集します。

19. Pyramix で Project > Ovation > Publish to Ovation を選択すると、編集したCueがOvationの同
じ場所に表示されます。

(または、Project > Ovation > Publish to Ovation as a New Cue を選択します。編集されたCueは
Ovation の Cue リストの 元の Cue の直下に、同じ名前と 接尾辞 (New)が付けられて表示されます。例え
ば、元のCueの名前が steampass2 であれば、新しいCueは steampass2 (New) となります。

注意：Pyramix は Ovation の起動後に起動して、空のプロジェクトをロードした状態で Edit を実行してくださ
い。

注意：マルチチャンネル Cue を編集する場合は、上記のセットアップ手順に従って、スロット数を増やし、必要に
応じてスピーカー出力のマッピングを変更してください。

注意：Ovation Cueから Edit を実行すると、既存のPyramixプロジェクトは新しいCueで上書きされます。つま
り、既存のトラックはすべて削除され、新しい Cue を編集するために新しいトラックが作成されます。

注意：Clip Gain と Envelopeはサポートされており、Ovation に送られます。

● Pyramixで編集した Cue に Envelope 情報が含まれている場合、Ovation に送られます。
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● Pyramixで編集した Cue に設定された Clip Gain は Ovation に送られます（適用されたゲイン値は
Ovation では表示されません）。
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Recording
概要
Ovationでは、Ovation の出力ミキサーとは独立したミキサーを使用して、同時に最大8チャンネルのオーディオ
を録音することができます。

操作上、録音は Cue List の Cue に行われます。新しい録音は、Cue で参照されているオーディオ メディア
ファイルを置き換えるか、または新しい空の Cue に録音することができます。録音は Compose モードまたは
Show モードのどちらでも行うことができます。(ただし、Show Properties > Show Time Properties で
Forbid Editingが Noに設定されている場合に限ります)。Show モードで録音する場合、Ovation のユー
ザー インターフェースのすべての機能は、録音が行われていないときと同様に動作します。

録音は Show のサンプリングレートで24ビットの Broadcast Wav 形式（.bwf）で行われます。

Record

録画の開始
録画を開始するには 2 つの方法があります。

● 既存の Cue のオーディオメディアを新しい録音に置き換える場合。
○ Cue List で Cue を選択します。
○ 右クリックして表示されるコンテキストメニューから Record Audio を選択するか、Cue >

Record Audio を選択します。

● 新規の空の Cue にオーディオを録音するには、次のようにします。
○ 右クリックして表示されるコンテキストメニューから Add Cue > Record Audio as New

Cue を選択するか、または Cue > Add Cue > Record Audio as New Cue を選択します
（または、新しい空の Cue を作成してから、既存の Cue のオーディオ メディアを置き換える
方法で進めることもできます）。

いずれの方法で録音を開始しても Record Audio ダイアログが表示されます。

Record Audio Dialog

Record Audio dialog

Name 既存の Cue のオーディオメディアを置き換えるためにダイアログを開くと、
フィールドには既存の Cue の名前が表示されます。
新しい Cue を録音するためにダイアログを開くと、フィールドのデフォルトは
Recording Audio Cue… となります。いずれの場合も、フィールドに録音
の新しい名前を入力することができます。
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Input Slot コンボボックスは、レコードソースとして使用される最初のミキサー入力を選
択することができます。

Nb Channels コンボボックスで録音するチャンネル数を設定します。(最大8ch)

Reset Mixer to Factory ミキサーをデフォルトの 8モノラル入力、1ステレオ出力に戻します。

Show/Hide Mixer レコードミキサーの表示/非表示を切り替えます（デフォルトは非表示）。

Progress カウンターに録音開始からの経過時間が表示されます。

Record ボタンをクリックすると 録音が始まります。

Cancel ボタンをクリックすると 録音を中止してダイアログを閉じます。

注意：Recordボタンと Cancelボタンはモーダルです。録音時には以下のオプションがあります。

Record Audio dialog - recording

Stop & Accept クリックすると、録音を停止してダイアログを閉じ、録音を選択した Cue に
リンクさせます。

Abort & Try Again ボタンをクリックすると、録画がキャンセルされ、ファイルが削除され、次の

録音のためにダイアログが開かれます。

注意：録音中の Cue が削除されたり、Cue を含むリストが閉じられた場合、録音は正しく終了し、ファイルも正し
く作成されますが、Cueは作成されず、録音を指すように変更されません。

オーディオ録音の操作が Undo された場合、 Cue は元の状態に戻るか削除されますが、オーディオメディア
ファイルは保持されます。

録音したファイルの場所
録音によって作成されたファイルは、Show ファイルのあるフォルダの Audio Filesサブフォルダに置かれま
す。
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Record Mixer
Record Audio ダイアログを開くと、専用の録音ミキサーが作成されます。

Default Record Mixer

ミキサーは、Record Audio ダイアログの Show/Hideボタンで表示できます。

デフォルトで レコード ミキサーは 8つのモノラル入力ストリップと1つのステレオ出力バスで構成されています。

入力はチャンネル 1〜 8 に接続されています。

ミキサーは必要に応じて設定することができ、後でオーディオ録音ダイアログを開いたときにも同じ状態で呼び

戻されます。

注意：非常に重要なこと

レコードミキサーの出力をモニターなどに使用する場合は、選択した物理的な出力がすでに Ovation の出力ミ
キサーに割り当てられていないことを確認してください。すでにOV出力ミキサーで使用されている出力がレコー
ドミキサーに割り当てられている場合は、再割り当てされ、OV出力ミキサーの出力は切断されてしまいます。

注意：ミキサー構成の詳細については、Pyramixユーザーマニュアルをご覧ください。

注意：Pyramixミキサーは大幅に更新され、非常に強力な新アーキテクチャで改訂されました。上図のレガシー
ミキサーはまだ使用可能です。新しいミキサーの詳細については、Pyramixユーザーマニュアルをご参照くださ
い。
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Ovation User Interface
概要
Ovation のユーザーインターフェースは、Show の構成と実行のためにゼロから設計されています。 Show に
は様々なタイプのメディアやトリガー Cue が含まれており、これらは用途に応じて手動または自動で起動するこ
とができます。

コマンドや機能は、ボタン, プルダウンメニュー, コンテクストのポップアップメニュー, キーボード ショートカットか
らアクセスできます。

Ovation の機能にアクセスするには、通常いくつかの方法があります。インターフェイスのサブセクションは、独
立したドッキング可能なペインで、表示/非表示、自動またはユーザーによる配置が可能です。これは、ユーザー
が自分のタスクに最も適した方法で作業できることを目的としています。

また、「パワーユーザー」は非常に効率的な操作手順を開発することができます。

Ovation を気軽に使ったり、オペレーターとして使ったりしても、その可能性のすべてを知ることはできません。
しかし、Show デザイナーにとっては、それ以上に素晴らしい体験が待っているのです。

User Interface Options
従来のメニュー以外にも、Ovationには様々なUIオプションがあります。

Fire Command
Fire Command は、Show Compose モードではダブルクリックのように動作し、デフォルトでは Space キーに
マッピングされています。つまり

● Edit モードでは、Spaceキーで Audition/Stopを切り替えることができます。
● Show モードでは、Spaceキーは常に Cue を Fire します。

Show モードでは、Enterキーで Fire Sequenced Cue （Fire and Select Next Cue）を開始します。

Context Menus
右クリックすると、現在のカーソル位置に関連するコマンドやオプションを含むポップアップメニューが表示されま

す。

Keyboard Shortcuts
特に、キーボード ショートカットや、Ovation の標準マッピングを使用することをお勧めします。キーボード ショー
トカットは完全にカスタマイズすることができます。

Hardware Control Surfaces
多くのアプリケーションでは必須ではないにしても、ハードウェア コントロールサーフェスやタッチスクリーンが必
要とされるかもしれません。Merging Technologies 社は Ovation 専用のコントローラを提供しており、販売
パートナーはカスタムメイドのソリューションを提供しています。

互換性のあるコントローラーの一覧とその機能については、こちらをご覧ください。

https://confluence.merging.com/pages/viewpage.action?pageId=17203276

Mouse Modifier Keys
Keyboard Modifiers を使用することで、マウスのクリックから可能なアクションの範囲が広がります。これらは
生産性を向上させ、学ぶ価値があります。詳しくは Appendix VI をご覧ください。
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Main Window
Cue Listがない状態で Ovation を起動すると、ペインのない真っ白なキャンバスが開きます。上部にメニュー
を備えた Ovation のメインウィンドウが表示され、下部には時間表示を備えた Show コントロールが表示されま
す。

Main Ovation Window

固定ボタン
右上の標準のボタンは、Windows の標準的なアイテムです。

Minimize Ovationのメインウィンドウをタスクバーに最小化します。

Maxmize / Restore Main Ovation Window の最大化と、最小化 /最大化する前のサイズと位置に戻すこと
を切り替えます。

Close Ovation の終了ダイアログを開きます。

Exit Ovation dialog

Ovation を閉じるには OK を、Ovation を閉じずにダイアログを終了するには Cancel をクリックします。
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Main Window, Panes and Toolbars
Ovation のユーザーインターフェースは、メインウィンドウとサブウィンドウ（ペイン）で構成されています。これら
のペイン（およびツールバー）は、Windowsデスクトップ上の任意の場所に配置することができ、Ovation のメイ
ンウィンドウ内に留まる必要はありません。ペインとツールバーは、近接しているとお互いに「磁化」され、メイン

ウィンドウの端にも磁化されます。また、メインウィンドウの端に近づくと、ペインやツールバーのサイズが自動的

に変更されます。新しいサイズは、半透明のグレーのボックスで表示されます。サイズ変更は、マウスボタンを

離したときにのみ行われます。青色の「ランディングライト」は、ペインがドッキングする場所を示します。

ペインのタイトルバーをダブルクリックすると、ペインのサイズと位置が現在と最後の間で切り替わり、メインウィ

ンドウにドッキングします。

ペインの入れ子と結合

入れ子のペイン
Cue List や Prpperties などのペインは、Cue List 1 の上に Cue List 2 などをドラッグするだけで入れ子にす
ることができます。 青い ゴースト ペインが既存のペインのほとんどを覆い、中央の青いランディング ライトが点
灯します。

Cue List Pane with Cue List ready to dock - Compose Mode

その結果、次の図の様になります。
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Cue List Pane with Nested Cue Lists - Compose Mode

上部の大きなボタンで、入れ子になっているペインを切り替えることができます。ここでは；

1 - Cue List 1, 2 - Cue List 2

ペインのネストを解除するには、Cue List の大きなラベルボタンをクリック＆ドラッグします。
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Combined Panes
あるペインを他のペインの端の近くまでドラッグすると、ウィンドウが結合されます。結合されたウィンドウは、単

一のペインとして閉じたり、自動的に隠したりすることができます。ペインをドラッグする場所によって、縦方向ま

たは横方向に結合することができます。

次の図では、2つの Properties ペインと、入れ子になった2つの Cue List ペインが組み合わされています。

Combined and Nested Panes - Compose Mode

ここでは、Cue List 1が表示されています。選択された Cueのプロパティは濃いグレーで表示され、選択され
た Cue Listのプロパティは淡いグリーンで表示されます。

Cue List Properties は淡い緑色、Show Properties は青色、Cue Properties は灰色で表示されます。
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Toolbars
Ovation には複数の ツールバー が装備されています。これらは必要に応じてユーザーインターフェースに表示
したり、隠したりすることができます。また、Show Propertiesの Hide Toolbars フィールドを Yesに設定す
ることで、Compose モードではツールバーを表示し、Show モードになるとツールバーを隠すことができます。

メニュー ツールバーを含むメインウィンドウのすべてのツールバーは、カーソルが移動 に変わるまでエント

リの左側をクリックし、新しい場所にドラッグすることでフローティングにすることができます。フローティング状態

のツールバーをメインウィンドウの端にドラッグすると、スナップしてドッキングした状態になります。

Toolbar Context Menu
メインウィンドウのヘッダーまたはフッターの空白部分を右クリックすると、Toolbars メニューが表示されます。

Toolbars context menu

リストでチェックされた Toolbar が メイン Ovation ウィンドウに表示されます。
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Audition Toolbar
Show > View Audition Toolbarを選択すると、メインの Show ウィンドウの下部にAudition Toolbarが追
加されます。

Audition Toolbar

ボタンの内容は一目瞭然ですが、念のために左から右に向かって説明します。

カーソルが Cue の開始点にある場合、 Cue の開始点または前の Cue  - 巻き戻し - 停止 - 開始/一時停止 -
早送り - 次の Cue です。これらのコントロールは、現在選択されている Cue に対して作用します。

Audition Jump
Audition Jumpには6つのコマンドがあります。これらのコマンドは、 Cue をオーディションしているとき、
Auditionツールバーや Ovation キーボードの Rewind ボタンや Fast Forward ボタンをクリックしたときに、
キーボード ショートカットや修飾キーを使って利用できます。

● Audition Jump Forward 1：1秒後の時間にジャンプ（Ctrl + -> キーまたは早送りボタン）。

● Audition Jump Forward 2：5秒後の時間にジャンプ（Ctrl + Shift + -> キーまたは早送りボタン

● Audition Jump Forward 3：15秒後にジャンプ（Ctrl + Shift + Alt + -> キーまたは早送りボタン

● Audition Jump Back 1：1秒前の時間にジャンプ（Ctrl + <- キーまたは巻き戻しボタン

● Audition Jump Back 2：5秒前にジャンプ（Ctrl + Shift + <- キーまたは巻き戻しボタン

● Audition Jump Back 3: 15秒前にジャンプ（Ctrl + Shift + Alt + <- キーまたは巻き戻しボタン
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Audition Drop-down
Cue List ペインでは、Audition ボタンのすぐ右にある下矢印をクリックすると Audition トランスポート コント
ロールが表示されます。これらの機能は、Audition ツールバーと同じです。

Standard Cue List Pane with Audition Drop-down - Compose Mode

Modifiers Toolbar
Show > View Modifiers Toolbar を選択すると、メインの Show Windowの下部に Modifiers Toolbarが
追加されます。

Modifiers Toolbar

Modifiers Toolbarは、タッチスクリーンで Ovation をコントロールするユーザー向けのツールです。機能は、
フィジカル コントローラにあるものと同じです。The Ovation Keyboard Controller Commands Map を参
照してください。
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Show Controls

Ovation Main Window Show Control Bar

メイン画面の下部にある Show Controlバーは、Menus と同じ方法でフローティングにすることができます。
例えば、カーソルが十字に変わったら、左側の端をクリックしてドラッグします。

Show Controlバーをメイン画面の端にドラッグすると、水平または垂直に再固定されます。それ以外の場合
は、デスクトップ上の任意の場所に置くことができます。

現在選択されている Cue List の 前の子Cue（Previous Child-Cue）を選択する

現在選択されている  Cue List の 次の子Cue（Next Child-Cue）を選択する

現在選択している Cue List の選択した Cue を Fire し、次の Cue を選択して Ready to
Fire にする。

現在選択している  Cue List で前の Cue（Previous Cue）を選択する

現在選択されている  Cue List で次の Cue（Next Cue）を選択する

Cue Listの昇順（Shiftキーを押しながらだと降順）で切り替える

現在選択している  Cue List の 選択した Cue を Fire します。Cue は再び Fire 可能な
状態になります。

現在選択している  Cue List の選択した Cue を一時停止

現在選択している  Cue List の選択した Cue を停止

Show タイムカウンター Show 開始時に選択した時間フォーマットで表示
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Show を初期化し実行する準備をします。Cue Listの表示を Show Modeに変更

Start Show Timed Cuesは適切なタイミングで Fire されます。Hot Key Cue は、自由
に Fire できます。

Pause Show 　Pause Show ダイアログを開きます。

Pause Show Dialog

OK で Show を一時停止します。Cancelは ダイアログを閉じます。

Pause Show  Showを一時停止します

Show が Pause している状態で Pause Show をクリックすると、一時停止した時点から Show が再開され
ます。

Stop Show 　Stop Show ダイアログが開きます。

Stop Show Dialog
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OK で Show が停止します。Cue List の表示は Compose Mode に戻り、Time Mode が Durationの場
合はタイムがリセットされます。Cancel でダイアログが閉じます。

注意：Show Properties で Pause Show や Stop Show のダイアログを表示しないようにすることができま
す。リハーサル時や Showを構成する際に便利です。

Other Toolbars
その他のツールバーは、Ovation ウィンドウのヘッダーまたはフッターの空白部分を右クリックして、コンテキスト
メニューから選択することでアクセスできます。その他のツールバーはすべてユーザーが設定できます。右端の

アイコンの隣にある下向き矢印は、現在のツールバーのボタンと Customize…にアクセスできます。既にツー
ルバーに表示されているボタンは青くハイライトされています。リスト内の各項目をクリックすると、表示/非表示
が切り替わります。リストの最後の項目は Reset Toolbar で、その言葉通り、ツールバーをデフォルトの状態
にリセットします。つまり、すべてのボタンが存在する状態になります。

Show

New Show

Open Show

Save Show

Initialize Show

Start the Show

Pause the Show

Stop the Show

Consolidate the Show
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Package the Show

Toggle Show Properties pane show/hide

Toggle Show Validator pane show/hide

Toggle Show Log pane show/hide

Toggle Show Control Toolbar show/hide

Toggle Audition Toolbar show/hide

Toggle Active Cue Window show/hide

Toggle Audio Gain Matrix show/hide

Toggle Audio Control Fader show/hide

Open User Manual

About Ovation

Cue List

New - 使用可能な Cue List タイプのリストをドロップダウンで表示します。選択すると新し
いリストが開きます。
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Open Cue List

Save Cue List

Cue List Properties ペインの表示/非表示

Fire /Start Timed List

Start Timed List

Pause Timed List

Stop Timed List

Chase Timed List

Fire Toolbar - Show Mode時、選択したウィンドウの Fire Toolbar の表示/非表示を切り
替えます。

Edit Toolbar - Compose Mode時、選択した Cue List の Edit Toolbar の表示/非表示を
切り替えます。

Toggle/Select Cue List - 開いている Cue List を順番に選択します。

Hot Key List を順番に選択する。
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Create Cue List

新しい Standard Cue List

新しい Timed Cue List

新しい Hot Keys Cue List

新しい Custom Keys Cue List

新しい Cue Browser

新しい Hot Browser

Cue

Undo

Cut

Copy

Paste

Cue Properties ペインの表示/非表示
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Cue Rules windowを開く

Cue gain フェーダーを開く

Add -  Cue の追加オプションのリストをドロップダウンします。

Remove - 選択している Cue

Edit Cue in Pyramix（すでに開いている場合

Replace Audio Media - ブラウザを開き、代替のオーディオメディアファイル/コンポジショ
ンを選択します。

Snapshot Automation

Paste Automation

Audition - ボタンをクリックすると選択した Cue をオーディションすることができ、下矢印を
クリックするとオーディション用のトランスポートコントロールをドロップダウンで表示させるこ
とができます。

Active Cue Window へ Cue を固定/固定解除

選択した Cue をActive Cue Windowに配置してロックする（Active Cue WindowでLock
が有効な場合のみ使用可能）。

Move Down

Move Up

Nest

Un-nest
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Link Offsets / Start Times

Fire

選択した Cue を Fire

前の Scene を選択

次の Scene を選択

前の Cue を選択

次の Cue を選択

選択した Cue を FIre

選択した Cue を Pause

選択した Cue を Stop

全ての Cue を Stop All Cues

Settings
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Settingsを開く

キーボード  Show トカット の設定を開く

Show Menus and Toolbars in Emergency
Show Mode で Ctrl + Alt + Home を同時に押すと、メニューと選択したツールバーをすべて元に戻し、緊急
時にすべてのコマンドにアクセスできるようになります。

78



Active Cue Window

Features & Functions
Active Cue Windowは、Compose Mode と Show Mode の両方で、現在選択している Cueの情報を表示
し、様々な操作を行うことができます。

カーソルの位置、オーディオファイル内の位置、ズームレベルは、Cue を切り替える際に記憶されます。

さらに、Active Cue Window Edit Toolbar を使って編集操作を行うことができます。これは、Show または
View メニューで切り替えることができます。

Compose Mode

Active Cue Window - Compose Mode

Cue List and Cue

Active Cue Window - Cue List and Cue

上部ツールバーにあるバーには、Active Cue の Cue が置かれている Cue List名が表示されます。2つ目の
バーには、Active Cue が表示され、右側の2つのボタンは Pinned モードまたは Locked モードを起動しま
す。

Lock and Pin

Pinned Mode
Pinned Modeは、Cue を固定して Active Cue Window に表示します。
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Pinned ボタンが非アクティブの場合、すべての Cue は、Fire されると Active Cue
Window に表示されます。

Pinnedボタンが有効な場合、Cue Propertiesの Pinned to the Active Cue
Windowパラメータが Yesに設定されている Cue のみが、選択された状態で表示され
ます。オーディオ Cue はデフォルトでピン留めされます。その他のタイプのコントロール
Cue は、デフォルトではピン留めされません。

Cue List with Pinned Cues in Show Mode

Override
ピン留めされていない Cue を Alt + クリックすると、ピン留め機能が一時的に上書きされ、この Cue が現在の
Cue の代わりになります。

注意: Pinnedアイコンは、Active Cue WindowでPinnedが有効になっている場合、Cue ListのCueにのみ表
示されます。

Locked Mode
Locked Modeが有効な場合、現在表示されているCueをActive Cue Windowにロックします。ロックが解除さ
れるまで、他のCueは表示されません。

Override
他の Cue を Alt + クリックすると、一時的にロックが上書きされ、この Cue が現在の Cue の代わりになりま
す。

ロックが解除されています。Cue は選択または Fire されると表示されます。

ロックされています。現在表示されている Cue は Active Cue Window にロックされてい
ます。
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Cue List with Locked Cue

Cue List では、Active Cue Window にロックされている Cue は、名前の左にロックマークが表示されます。
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Cue Trimmer

Active Cue Window - Trimmer

Navigation

Marker Button

Marker ボタンを押すと、Marker の管理機能にアクセスできます。詳しくは Markers の章
をご覧ください。

Scroll Bar

Scroll Bar と Nudge ボタン、ズームイン/ズームアウト/ズームトゥフィットボタンは、トリマー内のCueの表示
をコントロールします。

スクロールバーのハンドルの大きさは、タイムラインに表示されている Cue の時間に応じて変化します。

Nudge ボタンは、 Cue の表示を1秒単位で左右にスクロールします。

Zoom In

Zoom Out

Zoom-to-fit

Timescale Ruler
選択している Cue は、00:00:00:000から始まる Active Cue Timeline に表示されます。

ルーラー内をダブルクリックすると、アクティブエリア内のマウスカーソルの位置から Cue を試聴することができ
ます。

ルーラーをクリックしてドラッグすると、タイムラインが移動します。

Audition Cursor/Trimmer Scale Ruler
● Stop時に Altキーを押しながら、Trimmer Scale Ruler の Audition Cursor にマウスカーソルを置
き、マウスの左ボタンをクリックして押したままにすると、Cueがオーディションされます(マウスカーソル
が I ビームに変わります)。 ボタンを離すとオーディションカーソルがマウスカーソルの位置に戻りま
す。
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● Stop時、I-beamマウスカーソルは再生をせずに Audition カーソルを移動させます。

● Stop 時または Pause 時に、Active Cue Window から Audition または Fire を行った場合、再生は
現在の Audition カーソルの位置、つまり前回の再生が停止した位置から開始されます。これにより、
例えば Show のリハーサルの際に、Cue の途中から行うことができます。

● Audition Stop ボタンを2回押すと、次の Audition または Fire は Cue の最初から始まります。

● Trimmer Scale でクリックすると、

○ 再生中の Cue の場合、クリックポイントにジャンプして再生を継続します。

○ オーディション中の Cue の場合は、クリックポイントにジャンプしてオーディションを続行しま
す。

● Marker をクリックすると、その Marker が選択されます。

● ALT を押しながらマーカーをクリックすると、

○ Cue が再生中の場合は、カーソルが Marker にジャンプして再生を継続します。

○ Cue が オーディション中の場合、カーソルは Marker にジャンプし、Audition を続行します。

注意：Marker を正確に行うためには、Cue のサンプリングレートが Ovation Show と同じである必要がありま
す。そうでない場合、カーソルが誤った位置からスタートしてしまうことがあります。

● Trimmer Scale をダブルクリックすると、クリックした位置から Cue のオーディションを開始します。

● Marker をダブルクリックすると、Marker のルールを編集できるようになります。

● Altキーを押しながら Marker をダブルクリックすると、その Marker からオーディションを開始します。
Cue が終了するとカーソルは Marker に戻ります。

Active Cue Window の外から Fire や Audition を呼び出した場合 (メニュー, キーボード, Show Control
Toolbar など)、Active Cue は現在の IN点から Fired されます。

Trimmer Waveform Display
選択された Cue の音が表示され、その中の音の出る部分が薄いグレーでハイライトされます。シェーディングさ
れた部分の四隅にある4つのボックスはハンドルです。これらのハンドルをドラッグして、開始、終了、フェードイ
ン、フェードアウトのポイントをグラフィカルに調整することができます。下のハンドルは 開始点（IN）と 終了点（
Out）を設定し、上のハンドルは Fade In と Fade Out を調整します。ハンドルをダブルクリックすると、デフォ
ルト値に戻ります。つまり、In と Out のハンドルは Cue の境界線、Fade のハンドルには No Fade が設定さ
れます。

注意：開始点と終了点は、メディアの境界を越えてドラッグすることで、開始オフセット/プリロールや終了オフセッ
ト/ポストロールを設定することができます。

Zoom and Move
カーソルが十字の状態でタイムラインとルーラーの任意の場所をクリックして水平方向にド
ラッグすると、タイムライン全体を移動することができます。
カーソルが十字の状態でタイムラインとルーラーの任意の場所をクリックして垂直方向にド
ラッグすると、タイムラインを拡大／縮小することができます。

マウスで Trim を行う
Cue はマウスでも変更可能です。
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● SHIFT+クリックすると、現在のマウスの位置が Cue IN となります。

● Ctrl+クリックすると、現在のマウスの位置が Cue OUT となります。

トリミング中にレビューする
● トリミング中に Cue を確認するには、Audition Play/Pause または Review Start を使って Cue を
試聴できます。上記の方法で Cue IN を変更するたびに、Cue は新しい INポイントから再開されま
す。

● OUTポイントをトリミングしながら Cue を聴くには、Ctrl + Review End を押してください。オーディ
ションで CUE の OUTポイントに到達すると、CUE の最後の 1秒がループします。

注意：Pleroll と Cue Out Loop の時間は、Settings > Application Settings > General > Audition で設
定します。Cue をループさせている間に、インタラクティブに Cue を正確にトリムすることができます。Review
End アイコンボタンを Ctrl + クリック して Loop Out Mode を有効にすると、それ以降キーボード ショートカット
で Audition Review End (Ctrl + Alt + Space)を行うと、Ctr lキーを押さずに Review end アイコンボタンをマ
ウスでクリックするまで、Loop Out Mode で再生されます。マウスで操作する場合、Cue のエンドをレビューす
る毎に Ctrlキーを押すかどうかを選択できます。

Toolbar Audition Mode

Active Cue Window - Audition

ボタンは左から右へ向かって

Fire Auditionモードではグレーアウトしています。

Pause Active Cue の再生を一時停止する。

Stop Active Cue の再生を停止し、カーソルをスタートポイントに戻す。

PFL Active Cue の PFL 再生を開始する。

Time Counter Cue In Point からの経過時間。Cue の開始点ではありません。
カウンター内をクリックして時間を入力すると、再生カーソルがその位置に移動しま
す。

1,2,3,4 Rehearsal Presetボタン

CLEAR PRESETS 現在の Cue に設定されている Rehearsal Preset をすべて消去します。

ENABLE PRESETS 点灯時 Rehearsal Preset をクリックすると、現在の Cue に設定されているプリ
セットが無効になります。

Rehearsal Preset Points の章も参照して下さい。

Show Mode
注意: Active Cue ウィンドウには 選択している Cue List の現在選択している Cueが表示されます。つまり、
再生中の Cue でも選択されていなければ、その Cue は表示されません。
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Active Cue Window - Show Mode

Show Mode では、Show Propertiesの Forbit Editing [編集を禁止]フィールドが Yesに設定されている
場合、Active Cue Window には上部の Edit Toolbar が削除されてシンプルに表示されます。

Cue の Audition または Fire
Show の進行中に Cue を選択し、Active Cue Window のボタンを使用して、Cue のオーディションまたは
Fire を行うことができます。

Cue Fired
選択した CUE が Show Mode で再生されている場合、PFLボタンは使用できません(グレーアウトしていま
す。)

Active Cue Window Edit Toolbar
デフォルトでは非表示になっていますが、View > View Active Cue Window Edit Toolbar を選択すると、
Edit Toolbar が表示されます。

Cue Properties　Cue Properties を表示します。

Cue Rules　Cue Rules を表示します。

Cue Gain　Cue Gain を表示します。

Edit Active Cue を Pyramix で編集できる状態にします（この機能は Pyramixの起動と編
集の設定が必要です）。
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Replace Audio Media

Snapshot Automation

Snapshot Automation Paste

Audition Audition をクリックすると Cue を試聴することができます。小さな矢印をクリック
すると Audition のトランスポートコントロールにアクセスできます（ウィンドウ下部にあるもの
と同じで、Jumpオプションもあります。詳しくは Audition ツールバー を御覧ください）。

Link Offsets/Start Times Cue のすべてのオーディオ, TCGen, MMC, 9ピン(Sony
P2)のオフセットとスタートタイムをこれらのプロパティでリンクします。このボタンはオン/オフ
を切り替え、別の Cue がアクティブになってもその状態は保存されません。有効にすると
Cue Propertiesペインの関連するフィールド名がすべて赤色に変わり、分かりやすくなり
ます。

Nudge
Nudgeボタンの機能は、ドロップダウンリストで設定された増分でCueに影響を与えます。刻み幅は 1 sample
から 100 sec までです。

Cue In を前へ

Cue In を後ろへ

Cue Out を前へ

Cue Out を後ろへ

Fade In を前へ

Fade In を後ろへ

Fade Out を後ろへ
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Fade Out を前へ

カーソル を前へ

カーソル を後ろへ

Cue をカーソルに揃える

Cue の Out をカーソルにあわせる

Nudge の値

Start を聴く

End を聴く
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Rehearsal Preset Points

概要
Show の各 Cue には、最大4つのリハーサル ポイント プリセットの保存と呼び出しができます。これらのプリ
セットは、リハーサルでオーディオが必要な場合に Cue を Fire するポイントとして使用することを目的としてい
ます。

機能について
● 1つまたは複数のリハーサル ポイントが有効になっている場合、Cue 自体に 小さな緑のボックスに黒
い三角が入ったアイコンが表示されます。これは リハーサル プリセット ポイントが有効であることを示
しています。

Rehearsal Preset Set icon

● Show が実行され、通常通り Cue が Fire されると、リハーサルポイントが再生の開始点として使用さ
れます。

● When Starting を割り当てられたルールはすべてリハーサルポイントに適用されます。

● Fire Itself when Ending (loop) は、Rehearsal Point を Loop In ポイントとして使用します。

● リハーサルポイントが設定されている Cue が実行されたときに実行されるように設定されているすべ
ての Net された または リンクされた Cue は、リハーサルされている Cue との同期を維持できるよう
に、相対的にオフセットされて実行されます。

Setting and Using Rehearsal Presets
● 再生カーソルが Cue の開始位置にあるときに、SHIFTを押しながら、Active Cue Windowの4つのリ
ハーサル・プリセット・ボタンのうちの1つをクリックします。

○ 再生中に操作できます。

○ 再生カーソルは、手動でルーラーバーをクリックして任意の位置に配置することができます。

○ この位置は、アクティブ Cue ウィンドウの時間カウンターボックスに希望の時間を入力して設
定することもできます。

○ この位置は、Cue Properties ウィンドウの Rehearsal Presets フィールドに希望の時間を入
力して Set をクリックすることでも設定できます。

● この位置は、Cue Properties ウィンドウの Rehearsal Presets フィールドに希望の時間を入力し、ド
ロップダウンリストから Set Preset 1、2、3、または 4 をクリックして設定することもできます。

● - 複数のプリセットを設定するには、他の場所でも上記の操作を繰り返します。

● - 使用するプリセットを選択するには、Active Cue ウィンドウの該当する Preset ボタンを修飾キーなし
でクリックします。再生カーソルが選択されたプリセットに移動します。リハーサル用のプリセットが設定

されていないボタンを選択した場合は、ダイアログが表示されます。
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Rehearsal Preset Not Set dialog

● また、［Recall Preset 1,2,3,4］をクリックして、［Cue Properties］ウィンドウのドロップダウンリストから
目的のプリセットを選択することもできます。

● リハーサル・プリセット・マーカーは、アクティブになると青色に変わります。

Disabling and Clearing Rehearsal Presets

Disable/Enable
● 選択した Cue の Rehearsal Preset Points を保持したまま無効にするには、点灯している Enable
ボタンをクリックします。

● 有効にするには、点灯していない Enable ボタンをクリックします。

● すべての Cue を無効にするには、SHIFT + Disable/Enable ボタンをクリックします。
確認ダイアログが表示されます。

Rehearsal Preset Enable/Disable Confirmation dialog

実行するには OK を、中止するには Cancel をクリックしてください。

Clear
● Active Cue Window の Clear Presetsボタンをクリックするか、Cue Properties ウィンドウの

Rehearsal Preset フィールドのドロップダウン リストで Clear Presets をクリックすると、選択してい
る Cue のすべての Rehearsal Preset Points が削除されます。

● Show のすべての Cue のすべての Rehearsal Presets をクリアするには Shift を押しながら
Active Cue Window の Clear Presets ボタンをクリックするか、Cue Properties ウィンドウの
Rehearsal Preset フィールドで Shift を押しながらのドロップダウン リストの Clear Presets をクリッ
クします。確認ダイアログがポップアップし OK と Cancelのオプションが表示されます。

Rehearsal Preset Clear Confirmation dialog
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Limitations
Rehearsal Preset Points のキーボードショートカットはアクティブではなく、キーに適用しても機能しません。
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Markers
Markers は Interraction Rules と併用するとパワフルなツールになります。

Active Cue Window Markers Drop-down Menu

Markers ボタンをクリックすると、Markers メニューが表示されます。Cue に Markerがない場合は、Add
Markerのみが有効となっています。

Markers Menu
Add Marker Audition Cursor の位置に新しい Marker が追加されます。注意

：新しい Marker に続く既存の Marker は番号が変更されます。

Edit Selected Marker Interaction
Rules

Interaction Rules ダイアログを開きます。

Remove Selected Marker 現在選択している Marker を削除します。注意：削除された
Markerの後に続く既存の Marker は番号が変更されます。

Goto Marker 1 AuditionのカーソルをMarker 1に移動させる。

Goto Marker 2 追加されたマーカーは、「Goto Marker x」の項目としてここに表
示されます。

タイムラインルーラーのマーカ

● ルーラー上の Marker をクリックすると、その Marker が選択されます。選択された Markerはハイラ
イト表示されます。

● ルーラー内の Markerr はクリックしてドラッグすると移動します。

● ルーラー上の Marker をダブルクリックすると Interaction Rules ダイアログが表示されます。

注意： Markerは常にタイムラインに表示される時系列順に番号が付けられます。つまり Marker 4 が Marker
1 より先に移動された場合、Marker 1 として番号が変更され、それ以降のすべての Marker も同様に番号が変
更されます。Marker を追加または削除した場合も同様です。一番左のMarkerは常に1となり、Marker は常に
連続して番号が付けられます。また Interaction Rules を持つマーカーには、感嘆符 !が付くことに注意してくだ
さい。
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Markers in Cue Properties

Cue Properties - Markers Section

Markers Section

Markers
Selected Marker:x欄や下矢印をクリックすると Marker Menuがドロップダウンしま
す。

Cue Properties - Markers Section - Markers field

Add Marker 現在の Audition Cursor の位置に新しい Marker を
追加します。注意：後続の既存の Marker は番号が
変更されます。

Remove Selected Marker 選択した Marker を削除します。注意：後続のマー
カーは番号が変更されます。

Marker Name フィールド内をクリックして入力し、マーカーに名前を
追加します。この名前は、Active Cue Windowの
タイムラインに表示されます。

Select Marker 1 Marker 1 を選択します。

Select Marker 2 追加されたマーカーはすべてここに表示され、
Select Marker xの項目が追加されます。

Marker Offset Cue の先頭からの Marker Offset を表示します(Cue に適用されている開始
(Preroll) オフセットは含まれません) 。フィールド内をクリックすると 新しい値を
入力することができます。下矢印をクリックするとリストが表示され、Resetが
選択できます。
これにより Marker の位置が Active Cue Window のタイムライン上の現在の
Audition Cursor の位置にリセットされます(カーソルの位置が Cue の開始前
の場合は、負のオフセットが表示されます)。
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Marker Interaction
Rules

選択した Marker に適用されているすべての Interaction Rulesのリストを
表示します。フィールド内をクリックすると ...ボタンが表示されます。これをク
リックすると Marker Interaction Rules ダイアログが開きます。以下を参照
してください。

注: Cue に Marker Interaction Rule が適用された Marker がある場合、Cue List の Cue に下図のアイコン
が表示されます。

Markers Interaction Rules

Markers Interaction Rules

Markers Interaction Rules ダイアログは、一般的な Interaction Rules ダイアログと非常によく似ています
が、1つの例外があります。

Reaching Marker は固定されたプロパティであるため、グレーアウトしています。

単純なインタラクションから非常に複雑なインタラクションまで、以下のように設定できます。

● Fire Cue XXX at Marker YYY とすると、 Cue 内の任意の場所で、Markerの位置に合わせて自動
的に Cue を Fire することができます。

● Cue 内でのループ (以下の詳細を参照)

● 同じ Marker に対して複数のルールを設定することで、異なる条件に基づいて、同じ Loop Ou tポイン
トから Cue 内の異なる位置にループすることができます。

Looping
Marker の使用例の一つとして、Cue内での Looping があります。

単純なループを設定するには
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1. Loop In ポイントと Loop Out ポイントに1つずつ、計2つのマーカーを配置します。

2. Out Marker をダブルクリックするか、それを選択してMarkersボタンのドロップダウンメニューからEdit
Selected Marker Interaction Rulesを選択します。

3. 以下を設定します。

• Fire

• Itself

• When

• Reaching Marker (固定、変更不可)

4. Add Rule をクリックして、ルールをリストに追加します。

5. OKをクリックしてルールを保存してダイアログを閉じます。

以上で設定は完了です。 Cue が実行されると、最初のマーカーを経由して2番目のマーカーに到達するまで再
生されます。その後、最初のマーカーに戻ってループし、手動で停止するまで無限にループを繰り返します。こ

れは単純な例ですが、複数の Interauction Rule を慎重に使用することで、他にも様々な可能性が生まれま
す。例えば、他の Cue が Fire されたときにループしている Cue を停止させることも可能です。

Interaction Rule の詳細については、Interaction Ruleの章を参照してください。

注意：ルールが機能するために、システムはトリガーを準備するためのに1防寒の時間を必要とします。そのた
め Cue の開始から 1秒前、または Cue のフェードアウトから 1秒前に設定された Marker は、そのルールをト
リガーできません。これらの Marker は Active Cue Window に赤で表示されます。
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Playing Cues Window
Playing Cuesウィンドウは、View > Playing Cues Window で開きます。

Playing Cues Window

このウィンドウには、システムで現在再生中、一時停止中、Dim中のすべてのCueのコピーが表示されます。

これらは Fire Time の順に表示され、停止すると消えます。

Show Properties で Cue Fire Buttons が有効になっている場合、再生中の Cue はこのウィンドウから直接
Paused と Stopped が可能です。

注意: Auditioning Cues は Playing Cues ウィンドウには表示されません。
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Properties Panes

Types
Ovation には、Show, Cue List, Cueの 3 種類の Propertiesペインがあります。

これらのペインには、現在読み込まれている Show、選択している Cue List 、選択している Cue に関する情報
が表示されます。

左側にある小さな「マイナス」と「プラス」のボタンは、ペインの各メインセクションを1行に折りたた
んだり、完全な状態に戻したりします。

Appearance
Properties ペインのテキストは、View > Properties Font Size で設定したフォントサイズで表示されます。

Properties Fields
いくつかのフィールドは ”information only（情報のみ）” ですが、その他のフィールドはテキストや数値を入力し
たり、オプションを選択することができます。

‘free text’ または ‘information only’ 以外のフィールドをクリックすると、下矢印が表示されます。この矢印をク
リックすると、そのフィールドのオプションにアクセスできます。

Properties Windows drop-down list

数値フィールド
多くの数値フィールドでは、ドロップダウンリストで値を選択することができます。独自の値を入力したい場合は、

数値フィールドをクリックするとカーソルが表示され、直接値を編集することができます。

Precedence 前方一致
一般的に、Show Properties, Cue List Properties, Cue Propertiesで設定した内容は、次のような優先順位
になります。

Cue Properties の設定は、Cue List Properties の設定や Show Properties の設定よりも優先されます。

Cue List Properties は、 Show Properties の設定より優先されます。

Show Properties の設定は、Cue List Properties の設定または Cue Properties の設定によって上書きされ
ない場合に適用されます。

これらのルールに例外がある場合は、その旨を記載されます。
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Show Properties

Show Properties Pane
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Show Section
Comments Showにコメントを追加できるフリーテキストフィールド

Default Stop Fade Out フィールドをクリックすると、0msから20sまでのフェードの長さと<Default>を加
えたドロップダウンリストが表示されます。 <Default>に設定されている場合は、
Cue が停止（中断）したときに Cue フェードアウトの値が使用されます。

Modified Fade In フィールドをクリックすると、ドロップダウンリストに0msから20sまでのフェードの
長さが表示されます。

Modified Fade Out フィールドをクリックすると、ドロップダウンリストに0msから20sまでのフェードの
長さが表示されます。

Default Interaction
Rules

フィールドには、現在の Show に定義されているすべての Interaction Rules
のリストが表示されます。注意：このフィールドに表示されているルールは、すべ
て同時に有効です。

Default Interaction Rules Field - Show Properties Pane

このフィールドをクリックすると、「Interaction Rules」ダイアログにつながるボ
タンが表示されます。

Default Output Player この欄をクリックすると、ネットワーク上のPCにインストールされているすべて
のOVプレーヤーと、<Default Player>, <Local Player>がドロップダウンリ
ストに表示されます。

Application Delay
Launch

ドロップダウンリストに、0[s]から60[s]までが用意されています。

Show Auto Start Yesに設定すると、Ovationを最後に終了したときにロードされた Show が、
次にOvationを起動したときに自動的に開始されます。

Show Edit Password フィールド内をクリックすると、New Password または Reset Password.の
選択肢がドロップダウンします。
前者は Show をパスワードで保護することができ、後者はパスワードをオフ
にリセットすることができます。

Show Time Mode Section
Show Time Mode: このフィールドをクリックすると、Time Mode sub-menuが表示され、以下の

選択肢があります。

Duration 経過した Show タイムに関連してタイムドイベントを実行するには、このオプ
ションを選択します。

Time of Day システムクロックでタイムドイベントを発生させる Time of Day

TimeCode chase 外部のTimeCodeソースでタイムイベントを発生させる。

注意：現在のTCソースは、LTC Horus（MassCoreのみ）またはUSBSync LTCから取得されます。
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Show Start Time Durationモードでのみ適用され、 Show の開始時間を定義します。
例：00:00:10:000に設定されている場合、 Show が開始されると、カウンター
は 00:00:10、つまりデュレーションの10秒前から始まります。

Show Time Options Section
Hide Menus: Yesの場合、Showの間メニューを非表示にします。

Hide Toolbars: Yesの場合、Showの間ツールバーを非表示にします。

Freeze Panes: Yesの場合、Showの間全てのペインとウィンドウを移動させたりサイズを替え
ることができません。

注意：これは Mixer は含まれません。

Show Validation: Yesに設定すると、 Show の初期化時に Show の検証（下記参照）が行われ
ます。

Forbid Editing: Yesに設定すると、 Show タイム中の編集と録音が禁止されます。このオプ
ションが[No]に設定されている場合、 Show タイム中に Cue のコピー、ペー
スト、削除、ドラッグなどの操作やオーディオ録音が可能となり、よりインタラク
ティブなパフォーマンスを実現できます。 Show タイム中に変更された Cue
は直ちに更新されます。その時点で再生中であれば、変更は次の再生時に
のみ有効です。再生中に削除された Cue は、 Cue が終了するか、手動で停
止されるまで再生されます。

Hide Properties: Yesに設定すると、Show Properties、Cue List Properties、Cue
PropertiesがShow Time中に非表示になります。このオプションは通常、前
のオプションと一緒に使用します。

Cue Fire Buttons デフォルトはNoです。Yesに設定すると、Showモードで全てのCueの左側に
Play/PauseとStopボタンが表示されます。

Focused Cue Flashing
Mode

特に多くの  Cue List がある Show では、わかりやすくするために、フォーカ
スのある Cue は Show モードで赤いボーダーが点滅します。この設定は、ど
の  Cue List タイプに点滅モードを適用するかを決定します。このフィールドを
クリックすると、次のオプションを含むドロップダウンリストにアクセスできま
す。
以下のオプションがあります。

None
All Cue Lists
All Cue Lists except Hot Keys and Custom Keys

Show Mode
Confirmations

Noに設定すると、 Show タイム中はすべての "Show stopping "および
"Show Pausing "時に確認ダイアログが出ません。通常、リモートコントロー
ル Show やリハーサル中は無効になります。
Yesに設定すると、操作を行う際に注意を促すダイアログが表示されます。

Saving Confirmations Noに設定すると、Ovationを終了する際に「Do you want to save...」という確
認メッセージが表示されません。

Popups Confirmations Noに設定すると、  Cue List を閉じるなどのアクションに対する確認ポップ
アップは表示されません。

Video Ref. to Internal
on Chase Lock

この設定がYesに設定されていると、VREFでTCにロックするとリファレンスを
インターナルに切り替えます。
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Show Logging Section
Enable Logging Yesに設定してLoggingを有効にすると、以下の設定が適用されます。

New Log File このフィールドをクリックすると、Every Show, Every Day, Every Week,
Every Month options. のドロップダウンリストが表示されます。ニーズに
合ったオプションを選択してください。

Log File Name Structure このフィールドをクリックすると、Station Name, Station Name / Show
Name, Station Name / Date and Station Name / Show Name / Date オ
プションを含むドロップダウンリストが表示されます。このオプションは、生成
されたログファイルにどのようなラベルを付けるかを決定します。

Log File Format フィールドをクリックすると、ASCIIテキスト（.log）, XML（.xml）, Enco DADロ
グファイル（.exp）を選択できるドロップダウンリストが表示されます。

Log File Folder このフィールドをクリックすると、Browse オプションを含むドロップダウンリス
トが表示されます。 Browse をクリックすると、ファイルブラウザが開き、ログ
を出力させたいフォルダに移動できます。

TimeCode Generator Section
Show TimeCodeは、使用できる TimeCode Output Portに出力できます。これは、Settings > Application
Settings > Player Units > MIDI で有効になっている MIDI MTCポート になります。

TC Gen Output Port 現在選択されている出力ポートが表示されます。ドロップダウンリストには、利用
可能なすべてのTC出力が表示されます。

TC Gen Pause Mode 以下の選択が行えます。

Off ShowがPauseした場合、TC出力は停止します。

Freeze ShowがPauseした場合、TC出力は現在値を出力し続けます。

Free Roll ShowがPauseした場合、TC出力はフリーランします。

TC Gen Stop Mode 以下の選択が行えます。

Off Showが停止した場合、TC出力は停止します。

Freeze Showが停止した場合、TC出力は現在値を出力し続けます。

Free Roll Showが停止した場合、TC出力はフリーランします。

TC Gen Goto on
Ready

Yesの場合、CueがReady状態になったときにStart Timeが出力ポートに出力さ
れます。そのためCueがFireされる前に他のスレーブ機器がStart Timeに合わ
せてロケートができます。

Multi-Sequencer Synchronization Section
Synchronization Mode Master, Slave, Off の選択肢があります。

Resynchronize Drifts/Jumps 同期のズレやジャンプが検出されたときに、再同期を行うかどうか
を設定します。ドロップダウンリストでYesまたはNoを選択できま
す。
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Resynchronize Difference
threshold

シーケンサーの同期がどれだけずれたら再同期が行われるかを決
定します。フィールドに任意の値を入力してください。デフォルトは
1.0[s]です。

注意：マスターとスレーブ間の同期は、サンプル単位で正確に行われます。例：TimeCode Chase。スレーブの
Ovationから出力が始まる前に、最大2秒のプリロールが必要です。
同期精度が重要な場合は、Show の一番最初に開始される Cue に2秒間のサイレンスを追加してください。ま
たは、TC/IPコマンドを使用してください。
複数のOvationで時間の同期をとるには、GPSソースを使用する方法があります。

注意：マルチ シーケンサーの同期設定についての詳細は 以下をご覧ください。

https://confluence.merging.com/display/PUBLICDOC/Ovation+redundancy+-+MultiSequencer+Synchr
onization
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Cue List Properties

Cue List Properties Pane

注意：選択した Cue List によっては、一部のフィールドがグレーアウトしたり、セクションが折りたたまれていたり
することがあります。

Cue List Section
Number 現在選択されている Cue List のリスト内での位置。ドロップダウンリストで位

置を変更することができます。リストの残りの部分は、必要に応じて並び替え
られます。つまり、必要に応じて他の  Cue List の番号が自動的に変更され
ます。例えば、現在選択されている  Cue List が5つのうちの2番目である場
合、その番号を1に変更すると、リストの先頭に配置されます。
前のNo.1は2になり、その他はすべてそのままです。  Cue List 2の番号を4
に変更した場合、1はそのまま、3は空いている2の枠に移動し、4は3に移動
し、5はそのままとなります。

Name 名前（変更はここで行います）

Comments Cue List にコメントを加えることができるフリーテキストフィールド
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Automatic Cue
Numbering

デフォルトでは、Standard Cue List と Timed Cue List は On になっていま
す。Hot Key と Custom Key の Cue List のデフォルトは Off です。フィール
ド内をクリックすると、On/Off が切り替わります。Off の場合、新しく追加され
た Cue には連続した番号が付けられますが、これらの番号は  Cue
Properties ウィンドウで削除できます。この場合、 Cue 番号は  Cue List 内
の位置によって決定されます。

Hidden チェックすると、Show モードで Cue List が表示されなくなります。この機能
はオペレーターには関係のない論理的な指示を含む管理用の Cue List に
使用すると便利です。

Default Stop Fade Out このフィールドをクリックすると、0msから20sまでのフェードタイムと
<default>が表示されたドロップダウンリストにアクセスできます。値が設定さ
れている場合、Cue を停止（中断）したときにフェードアウト値が適用されま
す。

Default Interaction
Rules

フィールドには、現在の Cue List に定義されているすべての Interaction
Rules のリストが表示されます。注意：このフィールドに表示されているルー
ルは、すべて同時に有効になります。
フィールドをクリックすると、Interaction Rulesダイアログにつながるボタンが
表示されます。

Default Output Player このフィールドをクリックすると、ネットワーク接続されたPCにインストールさ
れているすべてのOVプレーヤーと、開いている Show で定義された
<Default Player> と <Local Player> のドロップダウンリストが表示されま
す。<Default Player>を選択した場合、ボックスには何も表示されず、使用さ
れるプレーヤーはShowでの設定によって異なります。

Timed Cue List Section
Timed Mode Chasing Yes（有効）の場合、TimeCodeにより Cue List が動作します。

No（無効）の場合、Show の経過時間に関連して発生します。Timed Mode
Start Timeにはオフセットが発生する。

Timed Mode TC Chase
Source

Timed Mode Chase が有効な場合、チェイスする TC ソースを設定します。
ドロップダウンリストのオプションは、"Show Time "または利用可能な任意
のTC入力です。

Timed Mode Chase
Mode

ドロップダウンリストには2つのモードが用意されています。
Cue Fire then Freewheel:
TimeCodeでCueがFireされた後、Cueは独自に走ります。TimeCodeが停
止したり逆再生になると停止します。
Cue follow TimeCode：
Cue はTCに追従します。このモードはリハーサル時に便利です。
Windows レジストリには、動作をカスタマイズするための高度な設定オプ
ションが用意されています。
詳細は support@merging.comにお尋ね下さい。

Timed Mode Chase Stop
Counter

Cueの再生が停止するまでの、TimeCodeの欠損フレーム数

TImed Mode Chase Run
Counter

TCが止まったりジャンプしたりした後、再生を開始するまでのTCの増加フ
レーム数 (Default : 5 frames)

Timed Mode Chase
Jump Counter
Threshold

TCがジャンプしたと判断するスレッショルド (Default : 5 frames)

Timed Mode Chase
Jump Threshold

信号品質の問題とTCジャンプを区別するために）TCの低下をジャンプとみ
なすための最小継続時間。(Default : 1000 milliseconds)
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Timed Mode Start Time Cue List の開始時間の値をオフセットします。Timed Mode Chasingが有
効になっていない場合のみ使用可能です。

Timed Mode Pauses
Cues

Cue List が手動で一時停止された場合の Cue の動作を決定します。

Timed Mode Stops Cues Cue List が停止したときの Cues の動作を決定します (手動または TC が
受信されない場合)。Timed Mode Chase ModeがCue Follow TimeCode
に設定されている場合には適用されません。

TimeCode Generator Section
Cue List のタイムコードは、タイムコード出力ポートに出力できます。Settings > Application Settings >
Player Units > MIDI.でMIDI MTCポートを有効にしてください。

TC Gen Output Port 現在選択されている出力ポートが表示されます。ドロップダウンリストで、使
用できるすべてのTC出力が表示されます。MIDI MTCポートも表示されま
す。

TC Gen Pause Mode ドロップダウンリストには以下の選択肢があります：

Off Cue Listが停止するとTC出力も止まります

Freeze Cue Listが停止するとTC出力は同じ値のTCを出力します

Free Roll Cue Listが停止してもTC出力はフリーランで出力します

TC Gen Stop Mode ドロップダウンリストには以下の選択肢があります：

Off Cue Listが停止するとTC出力も止まります

Freeze Cue Listが停止するとTC出力は同じ値のTCを出力します

Free Roll Cue Listが停止してもTC出力はフリーランで出力します

TC Gen Goto on Ready Yes（有効）の場合、CueがReady状態になったときにStart Timeが出力され
るので、スレーブ機器はCueがFireされる前にStart Timeに合わせて調走を
開始することができます。

Hot Keys Section
Hot Keys number of Columns フィールドをクリックすると、Auto（デフォルト）または 1-8 を選択できる

リストが表示されます。

注意：Number of Columns が Auto に設定されている場合、システムはカラム数を自動的に調整しますが、
Automatic Cues Numbering の設定には従い、必要に応じてスロットを空けます。

Hot Keys Column to Audio Slot Mapping

● Noに設定した場合、すべての Cue は Cue Properties で定義された Audio Output Slot で再生され
ます。

● 数字 (1, 2, etc..) に設定すると、Cue は Hot Keys Column に対応する Audio Slot で再生されます。
このようにして Hot Keys の Cue は、配置されている列によってミキサーのスロットに割り当てられま
す。

注意：このモードでは、実際のオーディオ出力スロットは、Cue の列番号に Hot Keys の列とオーディオスロット
のマッピングを掛けたものとして計算されます。これにより、Mono (1), Stereo (2), Surround (6), etc の Cue
を扱うことができます。
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優先される順番は、

● <Use Cue Slot>に設定されていない場合は、Cue Listの Audio Output Slot が最初に使用されま
す。

● “No" に設定されていない場合は、Hot Keys Column to Audio Slot Mapping が使用されます。

● 上記のいずれにも該当しない場合は、Cue Individual Audio Output Slot が使用されます。

Custom Keys Section

Cue List Properties Pane - Custom Keys Section

Custom Keys Grid Size フィールド内をクリックすると下矢印が表示されます。ドロップダウンから値を選
ぶか、フィールドに直接入力することができます。

注意：Timed Cue List と TimeCode Generator セクションは折りたたまれており、Timed Cue List 以外で
はフィールドがグレーアウトしています。Custom Keys セクションは折りたたまれており、Custom Keys Cue
List 以外ではフィールドがグレーアウトしています。

Audio Section

Cue List Properties Pane - Audio Section

Audio Output Slot フィールド内をクリックすると下矢印が表示されます。ドロップダウンから値を選
ぶか、フィールドに直接入力することができます。

注意：この設定はリスト内のすべての Cue に適用されます。この値は Cue リストに個別の Cue Output Slot
が設定されている場合でも、それよりも優先されます。デフォルトは <use Cue Slot> です。
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Cue Properties

Cue Properties Pane
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Cue Section
Number 現在選択されている Cue の番号。(情報のみ)

Name 名前（変えられます）

Comments フリーテキスト フィールド

Pinned to Active Cue Window Yes (デフォルト)に設定すると Showモードで Pinnedボタンがアク
ティブになっている時に Cueが Active Cue Windowに表示されま
す。

Length Cueの長さが表示され、変更することができます

Rehearsal Preset ドロップダウンに次のオプションがあります

Recall Preset 1

Recall Preset 2

Recall Preset 3

Recall Preset 4

Set Preset 1

Set Preset 2

Set Preset 3

Set Preset 4

Clear Presets

詳細は Rehearsal Preset Points を御覧ください。

Fade In フィールドをクリックすると、0msから20sまでのドロップダウンリストに
アクセスできます。

Fade in Curve フィールド内をクリックすると、フェードの形を決めるドロップダウンリス
トにアクセスできます。

Power

Linear

dB

Cosine

Root-Cosine

Fade Out フィールドをクリックすると、0msから20sまでのドロップダウンリストに
アクセスできます。

Fade Out Curve フィールド内をクリックすると、フェードの形を決めるドロップダウンリス
トにアクセスできます。

Power

Linear
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dB

Cosine

Root-Cosine

Interaction Rules フィールドには、定義されているすべての Interaction Rule が含まれ
ます。注意：このフィールドに表示されているルールは、すべて同時に
有効になります。
フィールドをクリックすると Interaction Rules ダイアログを開くボタン
が表示されます。

Ignore Parent Rules 子（入れ子）Cue が、親Cueに定義されたルールに従うかどうかを決
定します。
フィールドをクリックするとドロップダウンリストが表示され、Yes また
は No を選択できます。

Fire at Show Start Yesに設定すると、Show の開始時に Cue が Fire されます。

Output Player このCueに現在定義されているOVプレーヤーを表示します。フィール
ドをクリックすると、ネットワーク上のPCにインストールされているすべ
てのOVプレーヤーと、現在定義されているShowの <Default
Player>と<Local Player>のドロップダウンリストが表示されます。
使用されるプレーヤーは Cue List や Show など親の選択によって決
まります。

Markers Section

Cue Properties - Markers Section - Markers field

Markers Selected Marker: x フィールドまたは下矢印をクリックすると、Marker
Menu が表示されます。

Add Marker 現在の Audition Cursor の位置に新しい Marker を追加します。注意：
既存の Marker の番号は変更されます。

Remove Selected
Marker

選択した Marker が消されます。注意：既存の Marker の番号は変更さ
れます。

Marker Name フィールド内をクリックすると Marker に名前を付けることができます。こ
の名前は、Active Cue Window のタイムラインに表示されます。

Select Marker 1 Marker 1 を選択します。

Select Marker 2 加えた Marker は全てここに表示され、Select Marker x エントリーに
表示されます。
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Marker Offset Cue の先頭からの Marker Offset を表示します。( Cue に適用されて
いる開始 (Preroll) オフセットは含まれません) フィールド内をクリックす
ると、新しい値を入力することができます。下矢印をクリックするとリスト
が表示され、Reset も選択できます。
これにより、Marker の位置が Active Cue Window のタイムライン上
の現在の Audition Cursor の位置にリセットされます。(カーソルの位置
がCueの開始前の場合は、負のオフセットが表示されます。)

Marker Interaction Rules 選択したマーカーに適用されているすべての Interaction Rulesのリ
ストを表示します。フィールド内をクリックすると、...ボタンが表示されま
す。これをクリックすると、Marker Interaction Rulesダイアログが開き
ます。以下を参照してください。

Timed Cue Section

Timed Cue section - Cue Properties Pane

Go Time CueがFireされる時間が表示されているか Manualになっています。Timed Cue
Lists のみに適用されます。

注意：Timed 以外のリストでは Timed Cue セクションは折りたたまれており、Go Timeフィールドがグレーアウ
トしています。

Hot Key Section

Hot Key Mode Drop-down List - Cue Properties Pane

Hot Key と Custom Key Cue Lists にのみ適用されます。選択した Cueの現在の Hot Key Modeを表示し
ます。クリックすると、Hot Key の動作を選択できるドロップダウンリストが表示されます。

Hotkey Mode

Play from Start

Toggle Play / Stop
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Toggle Play / Pause

Press Play / Pause

Press Play / Release Stop

Press Play / Release Pause

Custom Key Section

Custom Key section - Cue Properties Pane

注意：Custom Key セクションの Custom Color フィールドは Hotkeys でも使用できますが、Custom Font
とCustom Font Color フィールドは使用できません。Standard と Timed Cuelist では、Custom Colorは
ラベルの背景に影響し Custom Font も使用できます。

Custom Color フィールドをクリックすると、...とドロップダウン矢印のボタンが表示されます。この
ボタンをクリックすると、標準のカラーピッカーが表示されます。ドロップダウンで
は、デフォルトの色にアクセスできます。

Custom Font フィールドをクリックすると、...ボタンが表示されます。このボタンをクリックするとイ
ンストールされているすべてのフォントの一覧が表示されたフォントダイアログが開
きます。また、フォントのスタイルやサイズを選択することもできます。ドロップダウ
ンでデフォルトにアクセスできます。

Custom Font Color フィールドをクリックすると、...ボタンが表示されます。このボタンをクリックするとカ
ラーピッカーが表示されます。ドロップダウンでデフォルトにアクセスできます。

Audio Section

Audio section - Cue Properties Pane
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Offset メディアファイル内のCueの開始点を決定します。オフセットは正方向のみです。

Gain フィールドをクリックすると値を直接入力することができます。ここに入力された値は、
Cueを再生する際のゲインオフセットを決定します。負の値は減衰し、正の値は増幅し
ます。下矢印をクリックすると、ゲイン値のドロップダウンリストにアクセスできます。...
ボタンをクリックすると、Cue Gainフェーダーが開きます。

Audio Output
Slot

出力スロットの番号が表示されます。欄をクリックすると、新しい番号を入力することが
できます。Audio Output Slotsをご覧ください。

Audio Media Cueのオーディオメディアのフルパスを表示します。右下の矢印をクリックするとドロッ
プダウンリストが表示され、現在のオーディオメディアファイルを「置換」または「削除」
することができます。

Sampling Rate 情報表示のみ　Cueのサンプリングレートを表示します。

注意：Cue Propertiesの Length と Audio Offset フィールドには、フィールドの右側にあるボタンをクリックし
てアクセスする Reset オプションがあります。Cue Properties の Go Time フィールドにはManualオプション
があり、フィールドの右側にあるボタンをクリックすると Manual Fire にリセットされます。

注: Cue > Link Offsets/StartTimesおよび Active Cueペインの Link Offsets/StartTimes アイコンは、
Cue 内のすべてのオーディオ, TCGen, MMC, 9 ピン (Sony P2) のオフセットと開始時間をこれらのプロパティ
にリンクします。このボタンは on/off を切り替えられ、別の Cue がアクティブになってもその状態は保存されま
せん。有効にすると Cue Properties ペインのすべての関連フィールドがわかりやすいように赤くなります。

Microphone Switch Section
このセクションでは、ミキシングコンソールの入力の範囲を定義することができます。範囲内の全ての入力は

Cue で入力に切り替わり、Cue が終了するとReproに戻ります。

First Mic / Input Slot フィールドをクリックして、自動的に切り替える最初のマイク入力スロットの番号を
入力してください。

Last Mic / Input Slot フィールドをクリックして、自動的に切り替わる最後のマイク入力の番号を入力しま
す。

TimeCode Generator Section
Cue TimeCode は、利用可能な TimeCode Output Port に出力できます。これは、Settings > Application
Settings > Player Units > MIDI で有効になっている MIDI MTCポートにも行えます。

TC Gen Output Port 現在選択されている出力ポートが表示されます。ドロップダウンリストには利
用可能なすべてのTC出力が表示されます。これはMIDI MTCポートも同様
です。

TC Gen Start Time CueをFiredしたときに出力されるTimeCodeの最初の値です。

TC Gen Pause Mode ドロップダウンリストでは、以下の選択肢があります。

Off Cueがポーズした時、TCは止まります。

Freeze Cueがポーズした時、TCは同じ値を出力します。

Free Roll Cueがポーズした時、TCはフリーランします。

TC Gen Stop Mode ドロップダウンリストには以下の選択肢があります。

Off Cueが停止した時、TCも停止する

Freeze Cueが停止した時、TCは同じ値を出力する
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Free Roll Cueが停止した時、TCはフリーランする

TC Gen Goto on Ready Yes（enable）の場合、CueがReadyになったときにStart Timeが出力ポート
に連続して出力され、CueがFireされる前にスレーブ機器がStart Timeに合
わせてロケートできるようになります。

注意：TimeCode Generator セクションは折りたたまれており、timed Cue以外ではフィールドがグレーアウト
しています。

MMC Section
MMC Output Port フィールドをクリックすると下矢印が表示され、使用可能なすべてのMIDIポート

のドロップダウンリストにアクセスできます。

MMC Start Time 前のフィールドで有効な出力ポートが選択された場合、ここに開始時間を入力
することができます。

注意： Cue が起動するとMMC Playコマンドが、 Cue が一時停止するとMMC Pauseコマンドが、 Cue が停止
するとMMC Stopコマンドが送信されます。

MIDI Command Section
MID Command Output
Port

フィールドをクリックすると下矢印が表示され、使用可能なすべてのMIDI
ポートのドロップダウンリストにアクセスできます。

MIDI Fire Command フィールド内をクリックすると、...ボックスが表示されます。これをクリックす
ると、Edit MIDI Command ダイアログが開きます。

MIDI Pause Command フィールド内をクリックすると、...ボックスが表示されます。これをクリックす
ると、Edit MIDI Command ダイアログが開きます。

MIDI Stop Command フィールド内をクリックすると、...ボックスが表示されます。これをクリックす
ると、Edit MIDI Command ダイアログが開きます。
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Examples of the Edit MIDI Command Dialog

Available predefined General Midi Commands drop-down list

An example of a MSC Sysex (Go command of the Cue 235.6, Cue list 36.6, path 59)
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An example of a General Midi command

注意：Custom Midi Message edit line を使用した場合、メッセージが認識されるとドロップダウンメニューが
更新されます。

Sony P2 / RS422 Section
Sony P2 / RS422 COM Port 現在使用している Com Port または Noneが表示されます。ドロップダ

ウンにはすべての Com ポートが表示されます。

Sony P2 / RS422 Start Time

注意：Cueが起動すると P2 Playコマンド が、CueがPauseするとP2 Jog [0]コマンド が、Cueが停止すると P2
Stopコマンド が送信されます。

COM Command Section
COM Command Output Port 現在使用している Com Port または Noneが表示されます。ドロップダ

ウンにはすべての Com ポートが表示されます。

Command Format フィールド内をクリックすると、16進数（Hex）またはASCIIの選択がド
ロップダウンします。

COM Fire Command フィールド内をクリックしてコマンドを入力します。

COM Pause Command フィールド内をクリックしてコマンドを入力します。

COM Stop Command フィールド内をクリックしてコマンドを入力します。

注意：COMコマンドは外部機器をシリアルコントロールで制御するために使用します。例えば、POWER ONコ
マンドを送信してプロジェクターを起動したり、Command=Cue_Fire &CueList=2 &Cue=1のようなコマンドラ
インを送信したりすることができます。各機器メーカーは、利用可能なコマンドのリストを提供しています。

IP / OSC Command Section
IP Command Output Port 現在使用している IP Port または Noneが表示されます。ドロップダウ

ンにはすべての IP ポートが表示されます。

Command Format フィールドをクリックすると、16進数、ASCII、OSCがドロップダウン表示
され、使用するものを選択できます。

IP Fire Command フィールド内をクリックしてコマンドを入力します。

IP Pause Command フィールド内をクリックしてコマンドを入力します。

IP Stop Command フィールド内をクリックしてコマンドを入力します。

注意：IPコマンドは、外部機器をイーサーネット経由で制御するために使用できます。例えば、POWER ONコマ
ンドを送信してプロジェクターを起動させることができます。各機器メーカーは利用可能なコマンドのリストを提供

しているはずです。

HTTP Command Section
HTTP Address IPアドレスまたはホスト名

HTTP Port IPポート番号

HTTP Fire Command Cue が起動したときに上記のIPアドレスとポートに送信されるコマンド

HTTP Pause Command Cue がPauseしたときに上記のIPアドレスとポートに送信されるコマ
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ンド

HTTP Stop Command Cue がStopしたときに上記のIPアドレスとポートに送信されるコマンド

GPO Section

Audio section - Cue Properties Pane

GPO Output Port そのポートに割り当てられた物理的なGPOデバイス

GPO Output Pin トリガーとなるGPOデバイスの出力端子

GPO Ready State Cue が Ready状態になったときの出力端子の状態。

GPO Fire State Cue が Fired したときの出力端子の状態。

GPO Pause State Cue が Pause したときの出力端子の状態。

GPO Stop State Cue が Stop したときの出力端子の状態。

GPO Duration 状態が維持される時間 = パルス幅（ミリ秒単位）

注意：UP と Downの意味：

Up コモンと Pin#が閉じた状態

Down コモンと Pin#が開いた状態

Shell Command / Script / Batch Section
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Shell Command/Script/Batch section - Cue Properties Pane

Fire Command

Fire Command Parameters

Fire Command Default Directory

Pause Command

Pause Command Parameters

Pause Command Default Directory

Stop Command

Stop Command Parameters

Stop Command Default Directory

シェルコマンドには、3つのパラメータが必要です。

● アプリケーション名またはコマンド (acrobat.exe、myscript.bat など)

● このコマンドを変更するパラメータ（オプション）（ - filename, - load, - verbose, etc... またはコマンド
自体が必要とするもの）。

● 既定のディレクトリ（オプション）（コマンドやアプリケーションによっては、必要なファイルが存在する特

定のフォルダから実行する必要がある場合があります。

注意：Fire, Pause, Stop の各イベントには、それぞれ別のパラメータセットがあります。
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Mixer Automation

Mixer Automation section - Cue Properties Pane

Type 詳細については Snapshot Automation および Dynamic Automation を参照してくださ
い。
このフィールドに Dynamic Automation が存在する場合 Console Automation が表示さ
れ、<None> または <Console Snapshot> を選択することができます。

注意：Dynamic Automation が存在するときに<None>または<Console Snapshot>を選択すると、
Dynamic Automation は消去されます。

Glide フィールドをクリックすると、選択肢のリストがドロップダウン表示されます。
フィールドに時間値を入力して、特定のグライド長を設定します。

Instant

Cue Length

REMOTE CONTROL: General MIDI Command

REMOTE CONTROL: General MIDI Command section - Cue Properties Pane

MIDI Command Input Port フィールド内をクリックすると、利用可能なポートのリストがドロップダウンし
ます。

Fire Command フィールド内をクリックすると、下矢印が表示されます。

Pause Command フィールド内をクリックすると、下矢印が表示されます。

Stop Command フィールド内をクリックすると、下矢印が表示されます。

各コマンドの下矢印をクリックすると、MIDI Command Learn（MIDIコマンド学習）ダイアログが表示されます。
下矢印をクリックすると、<None>, <Clear last incoming messages>, または指定したポートで受信した最
後の10個のコマンドのリストが表示され、必要なコマンドを選択することができます。<None>は既存のマッピン
グを削除し、<Clear last incoming messages>はコマンドリストをクリアします。

注意：この方法でCUEをリモートコントロールする前に、Settings > Application Settings > Controller
Units > MIDI で Controller Settings を確認してください。
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MIDIコマンドのダイレクトマッピングを物理的または論理的なMIDIポートに対して行うためには、General MIDI
（GM）セクションの Enable direct Cue mapping of the MIDI messages from the selected Virtual
MIDI Portのオプションをチェックする必要があります。指定された物理的または論理的なMIDIポートからのコ
マンドは、MIDI設定ページの上部にある選択されたバーチャルMIDIポートからのものとして、MIDI Command
Learn ダイアログに表示されます。これにより、マッピング全体をやり直すことなく、物理的なMIDIポートを簡単
に変更することができます。

注意：Hot Keys Press Play/Release Stopモードをエミュレートするために、Note Onを Fire コマンドに、
Note Off を Stop コマンドにマッピングすると便利です。

REMOTE CONTROL : IP / OSC Command

REMOTE CONTROL: IP / OSC Command section - Cue Properties Pane

IP Command Input Port フィールド内をクリックすると、利用可能なポートのリストがドロップダウンされ
ます。

Command Format フィールドをクリックすると、16進数, ASCII, OSCが選択肢としてドロップダウ
ンされます。

Fire Command フィールド内をクリックすると、下矢印が表示されます。

Pause Command フィールド内をクリックすると、下矢印が表示されます。

Stop Command フィールド内をクリックすると、下矢印が表示されます。

それぞれのコマンドについて、下矢印をクリックすると、IP Control Fire/Pause/Stop Learn ダイアログが表
示されます。下矢印をクリックすると、<None>, <Clear last incoming message>, または指定されたポート
で受信した最後の10個のコマンドのリストが表示され、必要なコマンドを選択することができます。<None>は
既存のマッピングを削除し、<Clear last incoming messages>はコマンドリストをクリアします。

注意：CueのOSCリモートコントロールコマンドは、/CueMapping/で始まる必要があります。

注意：この方法でCueのリモートコントロールを試みる前に、Settings > Application Settings > Controller
Units > IP で Controller Settings を確認してください。
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REMOTE CONTROL: Multi-Sequencer Synchronization

REMOTE CONTROL: Multi-Sequencer Synchronization section - Cue Properties Pane

Synchronization Mode Master, Slave, Offのいずれかを選択する欄をクリックします。

Synchronization Token Ovationは、Cue NameとCueList Nam,eからSynchronization Token
を自動的に生成しますが、Master TokenとSlave Tokenは一致しなけれ
ばなりません。(大文字小文字は区別されます）。

注意:何らかの理由でトークンの自動生成が適さない場合。例えば、マスターOvationのCueがBachで、ス
レーブOvationのCueがBach backの場合、Token値をフィールドに入力することができます。(マスターとス
レーブのOvationには同じToken Valueを使用しなければなりません。

Resynchronize
Drifts/Jumps

同期のズレやジャンプが検出されたときに、再同期を行うかどうかを設定
します。ドロップダウンリストで Yes または No を選択できます。

Synchronize Pause Yesに設定すると、マスター Cue が一時停止するとスレーブ Cue も一
時停止します。

Synchronize Stop Yesに設定すると、マスター Cue が停止した場合、スレーブ Cue も停止
します。

注意：この方法で Cue の同期を試みる前に Settings > Application Settings > General > TCP/IP
Connections でマスターマシンとスレーブマシンの間にIP接続を確立し、Show Properties で
Multi-Sequencer Synchronization を On にしてマスターまたはスレーブとして設定する必要があります。
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REMOTE CONTROL: Dataton Synchronization

REMOTE CONTROL: Dataton Synchronization section - Cue Properties Pane

Synchronization IP Port フィールド内をクリックすると、利用可能なポートのリストがドロップダウン表
示されます。選択されたポートは、Dataton ビデオ プレーヤーを実行して
いるターゲット マシンに接族されているポートでなければなりません。

Synchronization Token ここで入力された名前によって どのDatatonのタイムラインがCueにリンク
されるかが決まります。

注意：何らかの理由で Token の自動生成が適さない場合。例えば、Master Ovation の Cue の名前が
Score で、Remote  Dataton のタイムラインの名前が Movie である場合、Token値をフィールドに入力す
ることができます(Token Valueは 同期させたいDatatonのTimelineの名前と一致しなければなりません)。

Resynchronize
Drifts/Jumps

同期のズレやジャンプが検出されたときに、再同期を行うかどうかを設定し
ます。ドロップダウンリストでYesまたはNoを選択できます。

Synchronize Pause Yesに設定すると、マスター Cue が一時停止すると、スレーブデータンの
タイムラインも一時停止します。

Synchronize Stop Yesに設定すると、マスター Cue がStopすると、スレーブデータンのタイ
ムラインもStopします。

注意：この方法で Cue を同期させる前に、マスターOvationとスレーブDatatonの間で、Settings >
Application Settings > General > TCP/IP Connections でIP接続を確立する必要があります。
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Interaction Rules

概要

Interaction Rules（インタラクションルール）は Ovationの最も強力な機能の1つです。

Interaction Rules は ある Cue が起動または停止したときに、他の Cue や Cue List にどのような影響を与え
るかを決定します。選択したルールはすべて一緒に適用されるため、何も再生されない状況になることもありま

す。

Show Propertiesで設定されたルールは グローバルです。つまり、Cue List Properties または Cue
Properties で設定したルールによって上書きされない限り 全ての Cue List およびすべての Cue に適用され
ます。

Cue List Properties で設定されたルールは、Cue Properties で設定されたルールによって上書きされない
限り、Cue List 内のすべての Cue に適用されます。

ルールには任意のオフセットが含まれます。

ルールは条件付きで設定できます。他の Cue の状態 (Fired, Paused, Stopped) に基づいて、ルールをトリ
ガーすることができます。

Cue は、ルールによって自分自身を起動することができます。これにより Cueをループさせることができます。

Interaction Rule が Cue List を Target とした場合、

● Cue ListがTimed Cue Listの場合、Cue List Time がStart, Paused, または Stopped になります（
Cue List Start, Pause または Stop ボタンに相当）。

● Cue ListがTimed Cue Listでない場合 その Cue List の 最初の Cue の Fire、または 全ての Cue
の Paused, Stopped または Dimmed になります。

Adding Rules
ルールを追加するにはいくつかの方法があります。単純なルールを Cue に直接追加するには、Cue > Add
rule または右クリックのコンテキストメニューを使用します。より複雑な複合インタラクティブルールの場合は、
Interaction Rules ダイアログを使用します。

単純なルールの追加
Cueを選択して Cue > Add Rule を選択するか、Cueを右クリックしてコンテキストメニューの Add > Rule を
選択します。

いずれの方法でも、利用可能なルールのリストは同じです。

Fire Next Cue when Ending 終了時に次の Cue をFIre

Fire Next Cue when Stopping 停止時に次の Cue をFIre

Fire All Child Cues when Stopping 停止時に全ての子 Cue をFIre

Stop Previous Cue when Starting スタート時に前のCueを停止

Stop All Cues in Cue List when Starting スタート時にCie List内の全てのCueを停止

Loop (Fires Itself when Ending) ループ（終了時に自身をFire）
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Loop between Markers (Fire Itself between
Markers)

マーク間をループ

Dim All Cues when Starting スタート時に全てのCueをDim

Select Next Cue when Starting スタート時に次のCueを選択

注意: Loop between Markers を選択すると、Cue の最初と最後に 2 つのマーカーが作成されます。マー
カーは後から移動できます。

Opening the Interaction Rules Dialog
Propertiesペインの Interaction Rules フィールドをクリックして…ボタンをクリックすると、Interaction
Rules ダイアログが開きます。すでにルールが設定されている場合は、Cue List の Cueのアイコンをダブルク
リックしてもダイアログが開きます。

Interaction Rules Dialog

このダイアログで Interaction Rule の追加, 変更, 削除ができます。

Show レベルで適用される Interaction Rules は、すべての Cue List と Cue に影響します。これは List に適
用されるルールによって上書きされ、さらにこれらは個々の Cue に適用されるルールによって上書きされます。
ただし、一部のルールは Cue に関係なく影響します。例えば 個々の Cue が Stop All Cues at Startに設定
されている場合、その Cue が起動したときに再生されているすべての Cue List のすべての Cue が停止しま
す。Timed List 内の後続の Cue は、通常通り再生されます。

各ドロップダウンリストで利用できるオプションは、すでに選択されている内容や有効な他のルールによって異な

ります。

ルールの追加
ドロップダウンリストで選択し、Add Rule >> をクリックします。
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ルールの削除
リスト内の削除したいルールをクリックしてハイライト表示し、 Remove Rule << をクリックします。

ルールの更新
リストの中で更新したいルールをクリックして強調表示します。ルールのパラメータがコントロールに反映されま

す。

必要に応じてパラメータを変更し、Update Rule VV をクリックして変更を承認します。

ルールの順序変更
並び替えたいルールをクリックして Move Rule Up または Move Rule Down ボタンをクリックして順番を変更
します。

ルールの書式
Interaction Rules は以下のような書式になっています。

（下記のものを）Stop / Pause / Dim / Fire/ Select

Next Cue 次のCue

Next Sibling Cue 次の子Cue

Previous Cue 前のCue

Previous Sibling Cue 前の子Cue

Specific Cue または Group of Cues

Cue List

Itself それ自身

選択した Cue が 以下の動作をしたWhen（時）または After（後）

Starting 起動したら

Ending 終わったら

Stopping ストップしたら

with a

Fade In

Fade Out

Dim Gain

Afterが選択されている場合は、msボックスがアクティブになります。ここに値を入力し、トリガーとなるイベント
が発生した後にルールのアクションを遅らせることができます。

Stopの場合、ダイアログにはデフォルトの選択肢として Startingが表示されます。

Fireの場合、ダイアログにはデフォルトの選択肢として Endingが表示されます。

Pause と Dimは、Start / Stopの選択肢はグレー表示されています。これは、現在の Cue が再生されている
間に他の Cue を Pause または Dimする場合にのみ論理的に使用されるからです。
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Siblingは、同じレベルの Cue を意味します。そのため、Next Siblingのように使用すると、子 Cue はすべ
てバイパスされます。

注意： Cueの開始時に作用するルールは、Start timeに発生します。Cueの End または Stopに作用する
ルールは、Fade Out の開始時に発生します。これにより クロスフェード が発生します。

Fade Out が必要だが、Cue の終了まで次のアクションを発生させたくない場合は、Fade out の長さに相当す
るディレイを持つ Afterルールを使用してください。

at Marker
First Action が Fireに設定されている場合のみ有効です。Cue に Marker マーカーが設定されている場合、
Cue は at Marker フィールドに設定した番号の Marker で Fire されます。

Loop
ループを作成するには、Fire : Itself : When : Endingの形式を使用します。 Cue 内のより複雑なループ
は、Maker を使って実現できます。詳しくは Marker Interaction Rules をご覧ください。

Cue List Target
Interaction RulesがTargetとしてCue Listを指定している場合、2つの追加オプションが利用可能です。

First Cue / Timed Cue List Timer

● Cue List が Timed Cue Listの場合、Cue List Time の Start, Pause, Stopped（Cue List の
Start, Pause, Stop ボタンに相当）となります。Timed Cue List は、スタートすると内部タイマーを起動
します。

● Timed Cue List でない場合は、リストの最初のCueが実行されるか、すべてのCueが Pause,
Stop, Dim します。

Selected Cue Standard と Timed Cue List は 現在選択している Cue を実行します。Timed Cue List
は 内部タイマーを起動することはありません。

Conditional Rules
Only ifのボックスがチェックされている場合、さらに別のレイヤーの制御が行われます。上述のコントロールを
使用して設定されたルールは、条件が満たされた場合にのみ適用されます。例えば、ドロップダウンリストで

Next Cue, Previous Cue, Pachific Cue, Group of Cue, Timed Cue Listの中から選択したアイテム
が、ラジオボタンで選択された通りに Fired, Paused, Stoppedのいずれかを行った場合です。

Interaction Rules は非常に強力なツールなので、ぜひとも試してみてください。

Rules Icons
Interaction Rules が適用されると、Cue List の Cue にアイコンが表示されま す。

このアイコンが表示されている場合、Cue Properties でルールが適用されています。

このアイコンが表示されている場合、Cue List Properties でルールが適用されています。
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このアイコンが表示されている場合、Show Properties でルールが適用されています。

このアイコンが表示されている場合、Cue 内の Marker にルールが適用されています。

Cue Properties, Cue List, Showのアイコンをダブルクリックすると、Interaction Rules ダイアログが開き
ます。

125



Show Validation Tool

Show Validator

Show Validator pane

Show Validation Tool は、Show > Show Validatorから利用できます。

これにより、Show の以下の点を検証することができます。

● Interaction Rules の有効性。例えば、存在しない Cue や Cue List を指す Rule など。

● Offline になっているクリッププレーヤー

● 無効なオーディオ出力スロット

今後のバージョンでは、さらに多くのチェック項目が追加される予定です。

注意： Show Validation Tool ペインで報告されたエラーをダブルクリックすると、問題となっている Cue または
Cue List が選択されます。
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Show Consolidation and Packaging
Show Consolidationは、 Show に関連して参照されるすべてのオーディオ, MIDI, その他のファイルを収集
し、Show ファイルと同じ場所にある Audio Files フォルダにコピーします。Show ファイルは、コピーされたファ
イルの新しいファイルの場所を指すように変更されます。Show は Ovationシーケンサーでアクティブなままな
ので、さらに編集することができます。

Show Packagingは、Show に関連して参照されるすべてのオーディオ, MIDI, その他のファイルを収集し、
Show ファイルのコピーと一緒に選択した場所に自動的に作成される新しい Audio Files フォルダにコピーし
ます。プロセスの最後には、パッケージ化されたバージョンに問題がないことを確認するために、Show
Validation オプションが提供されます。パッケージ化された Show ファイルは、コピーされたファイルの新しい
ファイルの場所を指すように変更されます。

オリジナルの Show はこのプロセスによって影響を受けず、Consolidation が完了してもオリジナルの Show
は Ovation Sequencer でアクティブなままです。

The Consolidation Process
パッケージングプロセスを開始するには、Show > Consolidate Show を選択し、Consolidate Show ダイ
アログを開きます。

Consolidate Show Dialog

オプションには

● 全ての場所のファイルを収集する

● リムーバブルドライブに入っているファイルを収集する

● ネットワークにあるファイルを収集する

● サンプリング周波数をShowに合わせて変換する
があります。

適当なオプションを加え、Yes をクリックしてプロセスを開始します。
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Consolidating Cues Dialog

処理が開始され、Consolidating Cues... ダイアログが表示されます。処理を中止する場合は Cancel をク
リックしてください。処理が完了すると Info ボックスが表示されます。

Consolidate Cues Info Box

The Packaging Process
パッケージングプロセスを開始するには、Show > Package Show を選択し、Package Show ダイアログを
開きます。

Package Show Dialog

1. Show で使用している全てのメディアファイルを収集して Packaged Show の場所にコピーします。
2. Show のコピーをコピーされたメディアファイルのロケーションの情報を更新して作成して新しい場所に
保存します。

3. Packaging 処理によりオリジナルの Show は影響を受けません。
4. エンベデッドの OVPlayer と OVController が Show とともにパッケージされます。
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5. プロセス後にオプションで Validation が行われます。

続行してよければ、Yes をクリックして、Browse For Folder ダイアログを開いて処理を続けます。

Package Show Browser

適当な既存のフォルダに移動するか、適当な場所に移動して新しいフォルダを作成します。目的のフォルダーを

開いたら（または作成したら）、OK をクリックして処理を開始してください。

ダイアログに進行状況の詳細が表示されます。

Package Show Progress Dialog

さらに、個々のファイルのコピーの進捗状況を示すダイアログが表示されます。
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Copying Files Dialog

このプロセスが完了すると、新しい Show を検査するかの画面が表示されます。

Package Show Validation Dialog

検査を行うことをお勧めします。結果はプロセスの最後に表示されます。

Recursive Packaging
パッケージングプロセスは、インクリメンタルに行うことができます。つまり、このプロセスを何度も繰り返し呼び

出すことができ、新たに参照されたファイルのみがパッケージ化された場所にコピーされます。

Backup/Archive
Package Show機能は、表示を別の場所に Backup/Archive する簡単な方法です。
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Audio Control

Audio Control Pane
Audio Controlペインは、Show Toolbar, Show メニュー, View メニューからアクセスできます。Ovation ミ
キサーの 0dB 位置から右端の Bus フェーダーの減衰を制御します。これはペインが開いていて Show が実行
されているか、Cue がオーディションされている場合にのみ有効です。

タッチスクリーンでの操作を容易にするため、コントロールは大きくなっています。

上部の スライダー ボタンは、1クリックあたり 2dB 刻みで -146dB から -40dB まで、-40dB
から 1dB 刻みで最大 0dB までレベルを上げることができます。

スライダーはクリックしてドラッグできます。減衰の度合いは Slider ノブに数値で表示されま
す。ノブをダブルクリックすると、デフォルトの 0dB の値に戻ります。

一番下のSliderボタンは、1クリックあたり 1dB 刻みで -40dB まで、2クリックあたり2dB 刻
みで -146dB までレベルを下げることができます。

一番下のボタンは Ovation ミキサーのメインアウトプットを Mute します。

Audio Controlは、閉じても開いても（アプリケーションのロード／アンロードによ り）現在
の設定が保持されますが、出力は Audio Control ペインが開いているときのみ値が更新
できます。
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Cue Gain

Cue Gainコントロール

Cue Gainは、Cue 全体のレベルをリアルタイムに設定します。

Cue Gain ダイアログは、Cue List Edit Toolbar, Cue メニューの Change Cue Gain, および Cue を右ク
リックしてコンテキストメニューからアクセスできます。

ボックスには適用されるブーストまたはカットの量がdBで表示されています。ボックス内をクリック
して数値を入力することもできます。

スライダーをドラッグすることで Cue のゲインを設定できます。

変更を許可してダイアログを終了するには OK をクリックしてください。

変更を拒否してダイアログを終了するには Cancel をクリックします。

Cue Gain ダイアログで行った変更は Cue Propertiesペインに反映されます。

注意：PyramixからOvationにクリップを Publish した場合、Pyramixでクリップに適用したゲイン調整に加えて、
Cue ゲインコントロールで行ったゲイン調整も適用されます。
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TimeCode

TimeCode Reader Panes
TimeCode Readerペインでは利用できる TimeCode Source と Generator Ports が表示されます。View >
View TimeCode Reader で、TimeCode Readerペインが開きます。

TimeCode Reader Pane

Source が選択されていない TimeCode Readerペインでは数字が白表示されています。最大20個のペイン
を同時に開いてアクティブにすることができます。ペインのサイズは自由に変更できます。

ペインの黒い部分を右クリックすると、コンテキストメニューが表示されます。

TimeCode Reader Sources sub-menu

マウスカーソルを TimeCode Sourcesに合わせると、利用可能なすべての Sourceのリストが表示されま
す。None と Show Timeは常に表示されています。その他のエントリは、お使いのハードウェアとドライバの設
定に依存します。
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TimeCode Generator Ports の上にマウスカーソルをホバリングすると、利用可能なすべての出力のリストが
表示されます。

TimeCode Reader Generator Ports sub-menu

None はいつも表示されています。その他の項目は、使っているハードウェアやドライバーの設定によって異な
ります。

Colorにカーソルを合わせると、カラーピッカーが表示されます。

TimeCode Reader Colors sub-menu
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Audio Output Slots

What is an Audio Output Slot?
オーディオ出力スロットは、各 Cue の Cue Properties で設定します。Audio Output Slotは、ミキサーの左
から右へのオーディオ チャンネル数に他なりません。つまり Strip 1の Channel 1は Slot 1でもあります。しか
し、Strip 4 の Channel 1は、ミキサーが使用している Strip の種類によって、異なります。全てモノラルの Strip
を使用しているミキサーであれば、Strip 4 Channel 1は Slot 4ですが、全てステレオの Strip を使用しているミ
キサーでは Slot 8 となります。5.1GPSの Strip を使用しているミキサーでは、Slot19になります。

Multi-channel Cues
マルチチャンネル Cue は、Cue Propertiesで指定された Audio Slot Output の昇順にマッピングされ、 Cue
に存在するチャンネルは無視されます。

Audio Output Slots and Cue Lists
Audio Output Slotは、Cue List Propertiesペインの Audioセクションにある Audio Output Slotフィール
ドで、Cue List 全体に対して設定することができます。デフォルトでは <Use Cue Slot>が設定されており、こ
の場合は Cue Propertiesペインで設定された Audio Output Slot で再生されます。

注意：<Use Cue Slot>以外の設定を行うと Cue Properties ペインの Audio Output Settings よりも優先さ
れます。
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Audio Gain Matrix
デフォルトで各 Cue の Audio Gain Matrixは Offになっています。この状態では、Audio Cue は、Audio
Output Slotの設定で決定された Mixer Strip（複数可）で再生されます。Audio Gain Matrixは、Cue を扱う
上で非常に強力なツールです。例えば、間違ったチャンネルの順番やバランス, レベルの不揃いを修正したり、
5.1 Cue をダウンミックスしてステレオで再生したりすることができます。

Audio Gain Matrixペインにアクセスするには、Cue Propertiesペインの Audio セクションにある Audio
Gain Matrix フィールドをクリックするか、Show > View Audio Gain Matrix を選択してください。

Audio Gain Matrix pane - Matrix Off

Audio Gain Matrix ペインには、選択している Cue List と選択した Cueが表示されます。

Output Slot
Output Slotのドロップダウンリストにある機能は Cue Properties ペインのフィールドと全く同じで、ここでの変
更は Cue Properties に反映されます。

Cue Gain
Cue Gainポットは、マトリックスがアクティブであるかどうかに関わらず、すべてのチャンネルにおける Cue の
全体的なゲインを決定します。このコントロールで行った値の変更は、Cue Properties ペインの Audio Gain
フィールドに反映されます。

他のロータリーコントロールと同様に、数値ボックスをクリックしてタイプ入力することもできます。

Matrix Size
この値は、マトリックスからの出力数と、ダイアログの縦方向の出力列の数を決定します。Matrix Sizeは、Off
（上のスクリーンショットのように）または任意の適切な値に設定できます。マトリックスが Offの場合、出力数は
CUE のチャンネル数によって決まります。ドロップダウンリストには、Off と 1-16があります。より大きな値に設
定したい場合は手動で入力し、Enter キーを押してください。これらの出力は、Output Slot として設定したス
ロット番号から昇順で Ovation ミキサーのスロットにパッチされます。
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Inputs
マトリックス入力の数、つまりダイアログの水平方向の入力列の数は、Cue のチャンネル数によって決まりま
す。

Output SlotとMatrix Sizeの両方の数値を使うことで、まずミキサーのエリア（Output Slot）に注目し、次にCue
に含まれるオーディオチャンネルをそのエリア内の何本のストリップに分配するかを決定することができます。

例えば、ある Cue を Strip 30,31,32,33,34,35 にミックスしたい場合、Output Slot 30を選択し、Martix Size
を 6に設定します。

Audio Gain Matrix pane - 2 In 6 out

デフォルトでは、input channel 数と同じ数の Output channel のみがアクティブになります。ロータリーコント
ロールは Cue の全体的な gain と、Cue に含まれるチャンネルの個別のゲインを設定します。

Output ロータリーコントロールは、各Output channel の全体的なレベルと、各入力チャンネルからの出力ごと
の寄与度を設定します。ロータリーコントロールをダブルクリックすると、Mute / deMuteができます。
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Downmixing
同様に Audio Gain Matrix は、マルチチャンネルのCueをステレオまたはモノにミックスダウンするためにも使
用できます。

Audio Gain Matrix pane - 6 In 2 out

Linking Parameters in the Audio Gain Matrix
複数のゲインを同時に相対的に動かすために、グループを作成することができます。

Gain Control Group の作成

SHIFTを押しながら

● 個々のゲインコントロールをクリックして、グループに追加する。

● グループのメンバーをクリックすると、グループから削除されます。

● マトリックス列全体をグループに追加するには、出力ゲインノブをクリックします。

● RESET をクリックすると、すべてのリンクがリセットされます（すべてグループから削除されます）。
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Independent Control of a Group Member

● CTRLキーを押しながら

● グループに割り当てられているゲインノブを、グループの他の部分を動かさずに操作することができま

す。

注意：クリックして Cue から離れても リンク は保存されます。リンクは Show と一緒に保存されるため、 Show
を閉じたり開いたりしてもリンクは保持されます。

複数の Cue のAudio Gain Matrixの設定

Audio Gain Matrix のパラメータは、一度の操作で複数の Cue または Cue List 全体に設定できます。これ
は、Cueが同じフォーマットである場合にのみ意味があります。

● Cue List 内のすべての Cue を選択します。

● Show > View Audio Gain Matrix で Audio Gain Matrixペインを開きます。

● 必要な設定を行います。

新しい設定は、選択したすべての Cue に適用されます。
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Ovation Files

File Types
Ovationのファイルは、Cue List を含む Show を保存するもので、.ovsのファイル拡張子を持ちます。

Cue Listは独立して保存, 読み込みが可能で、.ovlのファイル拡張子を持ちます。

Settingsは、.pmsのファイル拡張子で保存されます。

OVPlayer Session は、.ovp ファイル拡張子で保存されます。

OVController Session は、.ovcのファイル拡張子で保存されます。
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Ovation Menus

Show

Ovation Show Menu

New Show 新しくShowを作成します

Open Show Windowsのファイルブラウザが開き、ロードするShowを選びます

Save Show 現在のShowを保存します

Save Show As... 別名で現在のShowを保存します

Save Show As Template 現在のShowをテンプレートとして保存

Save Special Ovationの古いバージョンのShowとして保存

Close Show 全てのCue ListとShowを閉じる
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Recent Shows > ドロップダウンで最近開いたShowのリストを表示

Init Show Showを初期化します

Start Show Showを開始します

Pause Show Showを一旦停止します

Stop Show Showを停止します

Consolidate Show Consolidate Showダイアログを開きます。詳細は Show
Consolidateon and Packaging を参照してください

Package Show

View Show Properties... Show Properties タブを開きます

View Show Validator... Show Validator タブを開きます

View Show Log ログ タブを開きます

View Show Control Toolbar Show Control ツールバーを表示/非表示します

View Audition Toolbar Audition ツールバーを表示/非表示します

View Active Cue Window Active Cueウィンドウを表示/非表示します

View Active Cue Window
Edit Toolbar

Active Cueウィンドウのツールバーを表示/非表示します

View Audio Gain Matrix Audio Gain Matrixウィンドウを表示/非表示します

View Audio Control
Window

Audio Control ウィンドウを表示/非表示します

Exit Ovation を終了します
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Cue List

Ovation Cue List Menu

New Cue List Cue List のリストをドロップダウンします

Standard Cue List 新しいStandard Cue Listを開きます

Timed Cue List 新しいTimed Cue Listを開きます

Hot Keys 新しいHot Keys Cue Listを開きます

Custom Keys List 新しいCustom Keys Cue Listを開きます

Cue Browser 新しいCue Browser Cue Listを開きます

Hot Browser 新しいHot Browser Cue Listを開きます

Open Cue List 保存してあるCue Listを開きます

Save Cue List As Cue List を名前を付けて保存します

Close.. Close Cue List ダイアログが開きます

注意：Cue List を保存せずに閉じた場合、Cue List は失われます。

Fire & Start 選択している Timed リストに作用します。選択された Cue
を Fire し、その Cue のGo Timeから  Cue List カウン
ターを開始します。次の Cue を選択して、 Fire の準備を
します。

Start 選択している、 Timed ドリストに作用します。タイムドリス
トがゼロからスタートします

Pause Timed リストを一時停止します。リストは一時停止した時
点から再開されます。
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Stop/Reset Timed リストを停止します。リストは最初にリセットされ、
Fire 可能な状態になります。

Chase Timed リスト選択時に Chase Modeのオン/オフを切り
替えます

Toggle/Select

Cue List (Tab) 開いているすべての  Cue List を昇順で選択してい
きます。

Toggle Select

Hot Key list (Ctrl+Tab)選択した Cue List を、利用可能な Hot Keys
List の間で切り替えます。
(注意：Hot Key表示は、Show が初期化されたときにの
み表示されます)

View Cue List Properties... 現在選択しているCueリストのCue List Propertiesペイ
ンを開く、または選択します

View Fire Toolbar Fire Toolbarを表示/非表示します

View Edit Toolbar Edit Toolbar を表示/非表示します

Hot/Custom Keys Custom Keysリストを選択している場合のみ有効

Cue List Menu > Custom Keys sub-menu

Hot/Custom Keys Design Mode チェックを入れると、選択した Hot/Custom Keys ペインが
Design Mode で表示されます。

Snap all Keys on Grid 全てのキーを現在のグリッドに合わせてスナップする

Reset all Keys Position 全てのキーをオリジナルの位置にリセットする

Reset all Keys Size and Position 全てのキーのサイズと位置をリセットする
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Cue

Ovation Cue Menu

Undo

Cut Ctrl+X

Copy Ctrl+C

Paste Ctrl+V

Add Cue 以下のサブメニューが開きます

Add Short Empty Cue 現在ハイライトしているCueの下に、持続時間 1 秒の新し
い空の Cue を追加します。
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何もハイライトしていない場合は、リストの一番下に新しい
空の Cue を追加します。

Add Short Empty Cue 現在ハイライトしているCueの下に、24時間の新しい空の
Cue を追加します。
何もハイライトしてない場合は、リストの一番下に新しい空
のCueを追加します。

Add Cue Shortcut 現在選択しているCueと同じ名前、コメント、色を持つ新し
いCueを、 Show トカットの起動時に親 Cue を起動する
ルールとともに追加します。

注意：空のCueは、何かをすぐに起動する場合や、条件付きのルールで使用されます。中間的な長さが必要
な場合は、Cue Properties の Cue Length を変更してください。

Load MTInterchange
XML

Load Audio File Cue を検索して追加するためのブラウザを開きます。

Import CD Tracks CDの読み込みダイアログを開きます。CD Tracks
Importのページをご覧ください。

Record Audio as New
Cue

Record Audio ダイアログを開きます。Recordingの
ページをご覧ください。

Remove 選択したCueを消去します。

Edit in Pyramix 選択したCueをPyramixに送ります。

Consolidate 選択したCueが Show の Audio Files Folderに存在しない場合や、サンプリング
レートが Show のサンプリングレートと異なる場合は、Consolidate Cues ダイアログ
が開きます。それ以外の場合は、メッセージを表示します。何もすることはありません、
すべてのファイルはすでに適切に統合されています。

Record Audio Record Audio ダイアログが開きます。Recordingのページを御覧ください。

Replace Audio Media ブラウザが開き、Cueの既存のオーディオ メディア ファイ
ルを検索して置き換えます。

Snapshot Automation Filter Mixer Controls to Snapshot ダイアログを開き
ます。

Paste Automation 最後にコピーしたCueの Automation Snapshot を、現在
選択しているCueにペーストします。Snapshot
Automationのページを参照してください。

Change Audio Gain Cue Gain フェーダーを開きます。

Edit Rules Interaction Rules ダイアログを開きます。

Add Rule > 適用できるルールのリストがドロップダウンします。

Fire Next Cue when Ending

Fire Next Cue when Stopping

Fire All Child Cues when Starting

Stop Previous Cue when Starting

146



Stop All Cues in Cue List when Starting

Loop (Fire Itself when Ending

Loop between Markers (Fire Itself between Markers)

Dim All Cues when Starting

Select Next Cue when Starting

Copy Rules 選択したCueのルールがクリップボードにコピーされます。

Paste And Replace Rules 選択したすべてのCueのルールをコピーしたルールに置
き換えます。

Paste and Add Rules 選択したすべてのCueのルールにコピーしたルールを追
加します。

Audition/PFL 選択したCueを選択した出力スロットから再生します。

Audition > Auditionコマンドがドロップダウンします。

Start

Rewind

Stop

Play/Pause

Fast-Forward

End

Jump Forward 1

Jump Forward 2

Jump Forward 3

Jump Back 1

Jump Back 2

Jump Back 3

Pin/Unpin to Active Cue Window 現在選択しているCueを Active Cue Window にPinする
かUnPinするかの切り替えです。

Lock in Active Cue Window Lock モードがアクティブな場合、選択した Cue が Active
Cue Window に入ります。
Lock モードがアクティブでない場合、Active Cue
Windowはグレーアウトされます。

Move Down Down 選択したCueをCue Listの1つ下の位置に移動します。

Move Up Up 選択したCueをCue Listの1つ上の位置に移動します。

Nest Right 選択したCueを 上のCueの子Cueにします。

Unnest Left 子Cueを1段上げる（1段しかない場合はCueになりま
す）。
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Link Offsets/StartTimes Cue内のすべてのオーディオ, TCGen, MMC, 9ピン
(Sony P2)のオフセットとスタートタイムをこれらの
Propertiesにリンクします。このボタンはOn/Off を切り替
え、別のCueがアクティブになってもその状態は保存され
ません。有効にすると、[Cue Properties ペインのすべて
の関連フィールドが赤くなります。

View Cue Properties Cue Properties ペインを開く/閉じるします。

Fire

Ovation Fire Menu

Fire Sequenced
Cue !

Enter Showが走っている場合、選択しているCue List の選択し
ているCueをFireし、次のCueを選択します。

Previous Scene LEFT 選択しているCue Listの前のシーン（Child-CueまたはCue
）に移動します。

Next Scene RIGHT 選択しているCue Listの次のシーン（Child-CueまたはCue
）に移動します。

Previous Cue UP 選択しているキCue List の前のCueに移動します。

Next Cue DOWN 選択しているキCue List の次のCueに移動します。

Fire Cue 選択しているCueを再生します。

Pause Cue 選択しているCueをポーズします。

Stop Cue 選択しているCueをストップします。

Stop All Cues 再生している全てのCueを止めます。
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View

Ovation View Menu

View Show Properties Show Propertiesの表示/非表示

View Show Validator Show Validatorの表示/非表示

View Show Log Show Logの表示/非表示

View Show Control Toolbar Show Control Toolbarの表示/非表示

View Cue List Properties Cue List Propertiesの表示/非表示

View Fire Toolbar Fire Toolbarの表示/非表示

View Edit Toolbar Edit Toolbarの表示/非表示

View Cue Properties Cue Propertiesの表示/非表示

Properties Font Size サブメニューに次の選択肢があります。
Small
Medium
Large
これは Propertiesペインのフォントのサイズです。

View TimeCode Reader TimeCode Readerウィンドウを開きます。20個まで開くことができま
す。

149



View Audition Toolbar Audition Toolbarの表示/非表示

View Modifiers Toolbar Modifiers Toolbarの表示/非表示

View Active Cue Window Active Cue windowの表示/非表示

View Active Cue Window
Edit Toolbar

Active Cue Window の Edit Toolbarの表示/非表示（Active Cue
Window が開いている時のみ）

View Audio Gain Matrix Audio Gain Matrixの表示/非表示

View Audio Control Audio Control window の表示/非表示

View Mixer Mixerの表示/非表示

View I/O Status I/O Status Window の表示/非表示

View Input Check Input Check Window の表示/非表示

View Touch Controller Touch Controllerの表示/非表示（タッチコントローラーがある場合の
み）

Settings

Ovation Settings Menu

Settings Settings window を開きます。

Keyboard Shortcuts Keyboard Shortcuts ダイアログを開きます。

Help

Ovation Help Menu

User Manual 英文マニュアルを開きます。

About Ovation About Ovation window を開きます。
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Settings
注意： Show の実行中、または Cue のオーディション中に、Settings ウィンドウを開くと多くの設定ページが表
示されません。

Overview
多くの設定は、Show の Cue Properties, Cue List Properties, Show Propertiesペインで行います。し
かし、その他の多くの設定は別個に用意されており、Settings メニューからアクセスします。

キーボード ショートカット エディタは、Settings メニューから直接アクセスできます。

メインの Settings ダイアログウィンドウも、Setting メニューからアクセスできます。フォルダーとサブフォル
ダーを使って、設定を論理的にグループ化しています。ウィンドウの左側には、利用可能なすべての設定が表

示されています。フォルダーのアイコンをクリックすると、フォルダーを折りたたんだり広げたりすることができま

す。初期設定では、すべてのフォルダーが開いており、その中に含まれる設定ページが名前で表示されていま

す。左側の画面で設定ページをクリックすると、右側の欄にあるその設定ページが表示され、変更ができます。

ここに記載されていないページについては、Pyramixのユーザーマニュアルに記載されています。

Settings には大きく分けて2つのグループがあります。

Ovation Settings dialog

ここでは全てのサブフォルダーが閉じられています。

● Show Settingsは、Show毎に保存されます。

● Application Settingsは、全てのShowに適用されます。

注意：このルールには1つの例外があります。

Application Settings > General > Audition ページでは、Audition Cues Output Slot を除いたすべて
の設定が全ての Show に適用されます。Template が PFLバス を固定して持つことができるように、Show と
一緒に保存されます。

Settings Buttons

Apply changes to …
Settings フォルダのツリービューの下にある最初の大きなボタンで、現在開いている設定ページの変更を行い
ます。Apply changes to ...は、設定ファイルの変更をまだ保存していません。設定は選択的に保存すること
も、全体を保存して後で再度使用することもできます。
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Load
Load をクリックするとブラウザが開き、Settingsの Profile（*.pms）ファイルを探してロードすることができま
す。

Save
All Settings を保存する場合には Saveボタンをクリックします。Save As ブラウザが表示され、適当なファイ
ル名を付けて好きな場所に保存することができます。

OK
変更を保存して、Settings window を閉じます。

Cancel
行った変更をキャンセルして Settings window を閉じます。
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Show Settings

General
Formats & Sync MassCore

Show Settings > General > Formats & Sync

Preset

このセクションは MassCore Audio device を使用している場合は表示されません。

Information

Effective Sampling
Rate

プルアップ, ダウン, Varispeedの影響を含めたサンプリングレートを表示しま
す。

Effective TC Frame
Rate

プルアップ, ダウン, Varispeedの設定の影響を含めたTCフレームレートを表
示します。

Warnings 選択したレートに関する注意事項を表示します。

Frequencie

Sampling Rate 使用できるサンプリングレートがドロップダウンリストから選択できます。

TC Frame Rate 使用できるTCフレームレートがドロップダウンリストから選択できます。

Drop ドロップフレームを使用するNTSCのみでチェックできます。
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Formats & Sync - ASIO

Show Settings > General > Formats & Sync

Preset

このセクションは ASIO Audio device を使用している場合は表示されません。

Information

Effective Sampling
Rate

プルアップ, ダウン, Varispeedの影響を含めたサンプリングレートを表示しま
す。

Effective TC Frame
Rate

プルアップ, ダウン, Varispeedの設定の影響を含めたTCフレームレートを表
示します。
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注意：サンプリングレートの設定は、Showが走っていない時のみ設定可能です。CUEを試聴している場合も
同様です。アクセスするには、Showを Init して Stop してください。

Warnings 選択したレートに関する注意事項を表示します。

Frequencie

Sampling Rate 使用できるサンプリングレートがドロップダウンリストから選択できます。

TC Frame Rate 使用できるTCフレームレートがドロップダウンリストから選択できます。

Drop ドロップフレームを使用するNTSCのみでチェックできます。

Audio Synchronization

Master Sync Mykerinos DSPボードを複数枚使用しているシステムでは、ドロップダウン リ
ストでどのボードをSyncマスターにするかが決められます。

Source システムのサンプルクロックソースを決定します。選択肢は、使用している
ハードウェアインターフェースによって異なります。

Video/TimeCode Synchronization

Video Format ドロップダウンリストに使用可能なすべてのビデオフォーマットが表示されま
す。

TC Reference ドロップダウンリストにTimeCodeのリファレンスソースとInternalが表示されま
す。

Varispeed

サンプリングレートをプルアップ/プルダウンするか、サンプリングレートを調整してVarispeedモードで動作さ
せることができます。

重要!一般的なD/AコンバータやA/Dコンバータは +/-0.15 ‰ (150 ppm)を超えて動作しないため、どの
Varispeedモードでもミュートになります。デジタルI/Oは、外部のリアルタイムサンプリングレート変換回路を
介してルーティングされるか、またはプルアップまたはプルダウンサポートを内蔵した適切な外部コンバータ
を使用することをお勧めします。

注意：NTSCビデオリファレンスへのロックは、ノミナルおよびプルダウンのサンプリングレートに制限されま
す。

Nominal ‘Normal’ mode です。Sampling Rateのプルダウンメニューで設定した公
称サンプリングレートを使用します。

Pull-Down サンプリングレートを0.1％低くします。NTSCのフレームレート30fpsと
29.97fpsの間の互換性のために、オーディオポストプロダクションで最もよく
使用されます。

Pull-Up サンプリングレートを0.1％上げます。NTSCのフレームレート30fpsと
29.97fpsの間の互換性のために、オーディオポストプロダクションで最もよく
使用されます。

Varispeed オーディオの再生速度を-12.5％～＋12.5％の範囲で変化させることができま
す。
このオプションを選択し、必要な速度変化を10分の1単位で隣の入力フィール
ドに入力します。許容範囲外の値を入力した場合は、許容範囲内に制限され
ます。例：1500と入力した場合、1125に設定されます。

MassCore™ [dedicated
mode]

Pyramix User Manual を御覧ください。
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I/O Interfaces
ここで表示されるページは、お使いのシステムに含まれるオプションによって異なります。詳しくはPyramix User
Manual をご覧ください。

Routing
ここで表示されるページは、お使いのシステムに含まれるオプションによって異なります。詳しくはPyramix User
Manual をご覧ください。

Mic/Pre Remote
ここで表示されるページは、お使いのシステムに含まれるオプションによって異なります。詳しくはPyramix User
Manual をご覧ください。

TimeCode
Pyramix User Manual をご覧ください。

Mixing Console

Slots Allocation

Show Settings > Mixing Console > Slots Allocation

Slots Allocation
ミキシングコンソールのオーディオスロット/チャンネルの数を、Cue の再生に使用する数として定義してくださ
い。残りのスロット/チャンネルは、自動的に入力モードに切り替わり、ライブミキシングやMT ASIOブリッジから
の入力のミキシングに使用できます。
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Number of Audio Slots for Cue Playback　ドロップダウン リストには以下の選択肢があります。
All Strip（全てのストリップ）
2,4,6,8, 10
Please type higher values manually… （下図が多い場合はマニュアルで入力してください）
スロットは、オーディオミキサーの最も低い番号のスロットにマッピングされます。

このオプションでは、空きストリップをOvation Mixing Consoleに残し、MT ASIO BridgeまたはReWire接続
を定義して、Pyramix（またはその他のDAW）の出力をミキシングコンソールに接続し、高度な Cue 編集を行う
ことができます。

Level Meter
このページでは、ミキサーのレベルメーターの外観と動作を決定します。詳細はPyramixのユーザーマニュアル
をご覧ください。

DSP Power Saving

Show Settings > Mixing Console > Core Power Saving

Special Modes

Player/Recorder Mode このモードでは、48×48チャンネルのような大きな構成を1枚のボード
上で動かすことができます。Player/Recorderモードは、外部のハード
ウェアコンソールでの使用を目的としています。
このモードを有効にすると、内部ミキサーは信号のルーターの役割に
なり、レベルコントロール、パン、プラグイン、インサートは使用できま
せん。このオプションは、複数のモノラルミックスバスを持つ構成での
み利用可能です。

Direct Out 機能は、同様にDSPパワーを節約するための方法です。

Core Time Saving
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Disable Punch In / Punch out このボックスをチェックすると、パンチイン/アウト機能が無効になりま
す。

重要！ソフトウェアでは、トラックを待機させ、録音プロセスを開始することはできますが、結果として得られる
メディアファイルにはデジタルヌル（無音）が含まれます。

Disable Mix Down このボックスにチェックを入れると、メニューコマンド Project->Mix
Down で行えるデジタルミックスダウン機能が無効になります。

重要！ソフトウェアでは、ミックスダウンプロセスを開始することはできますが、結果として得られるメディア
ファイルにはデジタルヌル（無音）が含まれます。
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Mixer Settings

Show Settings > Mixing Console > Mixer Settings

Virtual Room / Stereo Pan Law

ドロップダウンメニューで、デフォルトの Sin/Cos, Constant Power, -3dB center, Square Root,
Constant Power, -3dB centerのいずれかを選択できます。

注意：既存のプロジェクトでは、この設定を変更しない限り、デフォルトである Square Root が使用されます。

Internal Buses

Max Number of Internal Buses available :　必要な内部バスの数をドロップダウンで選択してください。(32
- 384)

Delay Compensation Policy
Mode
ドロップダウンで下記が選択できます。
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Full Delay Compensation
Off

注意：自動遅延補正機能は、5つ以上の入れ子になったI/Oループには対応していません。

Automatic Delay Compensation　これが選ばれていると 自動遅延補正がOnになります。

注意：再生または録音中に遅延を変更した場合、トランスポートが次に停止したときに計算され、適用されます。

Max Mixer Delay Compensation
Mixer error: Delay compensation ダイアログで、スライダーを要求されたディレイレイテンシー値より上の
値に設定してください。

Reset to Factory クリックすると 工場出荷時時の最大遅延値に戻ります。

VST Plug-ins Settings

Show Settings > Mixing Console > Plug-ins Settings

VST Plug-ins

Plug-ins List Menu で VSTプラグインの並び順とグループ分けを選択できます。

Company Name and I/O
Configuration

ソート リストは会社名順に表示され、プラグインはI/O構成に応じてグ
ループ化されます。例：1 in - 1 out, 1 in - 2 out, 2 in - 2 out など。

I/O Configuration I/O Configurationごとにプラグインをグループ化し、グループ内ではア
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ルファベット順にプラグイン名を表示します。

VST plug-ins folders
このボックスは、アプリケーションの起動時にVSTプラグインをスキャンするフォルダを示します。

デフォルトでは、VSTPluginsとSteinbergVSTPluginsの2つのディレクトリがスキャンされます。追加ボタンをク
リックするとファイルブラウザウィンドウが開き、スキャンリストに追加することができます。

スキャンリストからディレクトリを削除するには、リスト内でディレクトリを選択して Remove ボタンをクリックしま
す。

Show Available plug-ins
クリックすると、使用できる Plug-ins が表示されます。

All Settings MixerVST Plug-ins Settings Page

リストにはスキャンされ、利用可能なすべてのVSTプラグインが表示されます。ブラックリストに登録されたプラ
グインは赤で表示されます。

Scan VST Plug-ins Foldersリストに追加されたディレクトリのスキャンを開始します。

Force Rescan VST Plug-ins Foldersリストにある全てのディレクトリの再スキャンを開始します。

OK ダイアログを閉じます。
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Remote Control

Show Settings > Mixing Console > Remote Control

Mixing Console Remote Control
Enable チェックを入れると、ドロップダウンリストから選択したミキサーのリモートプロトコルが有効

になります。

Properties ドロップダウンリストで選択したミキサーのリモートプロトコルの設定ダイアログを開きます。

OASIS

OASIS Transport Configuration dialog

Console IP address
コンソールのIPアドレスとポートを設定します。
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Timeout Options

Show reconnection message チェックを入れると、コンソールへの接続が失われたときと再び接続さ
れたときにメッセージボックスが表示されます。

Timeout [ms] 接続再確立までの最大時間を設定します。

設定を保存してダイアログを閉じるにはOKを、保存せずにダイアログを閉じるにはCancelをクリックしてくださ
い。

RAP (Ross Audio Protocol)

RAP - Ross Audio Protocol configuration dialog

Ovationは、Ross OverdriveとVision製品で制御することができます。

このダイアログでサーバーIPアドレスとサーバーポートを設定します。

設定を保存してダイアログを閉じるには OK を、保存せずにダイアログを閉じるには Cancel をクリックします。

注意：RAPサポートには、オプションのOASISファーストクラスセキュリティキーが必要です。(Ovation
Platinumに付属)

EMC

EMC MIDI I/O Configuration dialog

設定を保存してダイアログを閉じるには OK を、保存せずにダイアログを閉じるには Cancel をクリックします。
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Application Settings

General
Media Manager

Application Settings > General > Media Manager

Preferred Media Folders パスを加えるにはここをクリックします。

...フィールドをクリックするとブラウザ ダイアログが開きます。

Preferred Media Folders Browser
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これにより、新しいメディアパスを追加して、Ovation Showの実行に必要なメディアを検索することができます。
ネットワーク接続でCueを実行するのではなく、ローカルに保存されたCueを使用してください。

Real-time Sampling Rate Conversion
以下のオプションを切り替えることができます。

Disabled リアルタイムSRCは行われません。クリップはオリジナルのサンプリングレートで再
生されます。サンプリングレートがプロジェクトのサンプリングレートと一致しない場
合、クリップは不正な速度で再生されます。

Medium Quality クリップは正しい速度で再生されます。変換が必要な場合に、速度を優先した音の
品質で変換されます。

High Quality クリップは正しい速度で再生されます。最高の品質で変換が行われます。この場
合、当然ながらより多くのリソースが必要となります。

Very High Quality クリップは正しい速度で再生されます。変換が必要な場合は、Merging
Technologies社の HeptaCon Sample Rate Converter により、最高の品質で変
換されます。

Other Settings
Compressed Media Settings

ここでは、メディアを解凍する先を指定します。

Decompress files... dialog

Locally (by the original). これを選択すると、元のファイルと同じ場所にファイルが作成され
ます。

Sub-locally (by the original, in a
\MTDXCache sub folder).

これを選択すると、元のファイルと同じ場所にPyramixが作成した
サブフォルダーにファイルが作成されます。

Custom (files are generated to
the specified location).

これを選択すると、ユーザーが指定した場所にファイルが作成され
ます。”Browse... “ボタンが表示され、ファイルブラウザーウィンド
ウを開いてパスを設定できます。
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Audition

Application Settings > General > Audition

Cue Audition

このラジオボタンは、オーディオCueの試聴に使用する Player と Audio Output Slot を選択するためのもので
す。デフォルトは Ovation が動作しているマシンです。別の Player を選択することは、ネットワーク接続された
マシン上の Player を使用する非常に高度な構成となります。

注意：マルチチャンネルのCueの場合、Audition Cues on .Audio Output Slot ボックスで設定した数字がCue
の最初のチャンネルの出力先となります。つまり Audio Output Slot "ボックスで設定された数字は、オーディ
ションのモニタリングに使用される最初のスロットを定義します。例えば、6ch サラウンドの Cue の場合、Audio
Output Slot ボックスの数字が “9” であれば、信号は Output スロット9〜14に送られます。

Audition Cues through their default Player
Audition Cues through :ドロップダウン リストで選択したネットワーク上のプレーヤーが設定できます。

Audition Cues on their default Audio Output Slot
Audition Cues on :

Audio Output Slot 利用可能なオーディオ出力スロットを設定することができます。

注意：このページの設定は Show に保存されます。

Active Cue Window Trim In/Out Audition Timings
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Cue Out preroll (in s.) フィールド内をクリックして、デフォルト値に代わる値を入力します（5sec）

Cue Out Looping (in s.) フィールド内をクリックして、デフォルト値に代わる値を入力します（1sec）

IP Connection

Application Settings > General > IP Connections

IP Connections ページでは、Ovation の IP 接続を以下のオプションで設定することができます。

Type 注意：または Client

IP / Name ターゲットサーバーのIPアドレスまたは名前を入力します(TypeがServerに設定されている
場合は関係ありません)。

Port ターゲットの Port 番号か名前を入力してください。

Status ここにはコネクションの状態が表示されます。

Note:

● IPクライアントまたはサーバーを作成すると、IPオブジェクトが Player Units と Controller Unitsの
両方に表示されます。

● Player Unitsは、コントロールプロトコルの出力を扱います。

● Controller Unitsは、コントロール プロトコルの入力を扱います。

● Server も Client も、データを送受信することができます。実用上の違いは、Serverは複数の Client
と接続できるのに対し、Client は1つの Server としか接続できません。

● Server は複数の Client の接続を受け付けます。

● データが Server 経由で送信されると、接続されているすべての Client に送信されます。

● Server が利用できなくなると、Client は自動的に Server への再接続を試みます。
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● 新しい接続が作成/破棄されると、Apply changes to IP connection ボタンで対応するプ レーヤー/
コントローラーユニットの追加/削除が行えます。

IP Address / Server Name Considerations
一般的に事故を避けるために、固定IPアドレスを使用することをおすすめします。DHCPサーバは、デバイスが
オフラインになるまで、DHCPサーバの「リース時間」に設定された時間だけ、毎回同じアドレスを割り当てる必
要があります。IPアドレスの代わりにマシン名を使用している場合は、ネットワーク上にDHCPサーバーがあっ
ても特に不都合はありません。しかし、機器の中には名前で解決できないものもあり、そのような機器を接続す

るにはIPアドレスが唯一の方法です。そのため、固定IPアドレスを使用することをお勧めします。

注意：最も一般的なポート番号（1024以下）の使用は避けた方が良いでしょう。安全性を高めるために、49152
- 65535の範囲のポートを使用することをお勧めします。

UDP/IP Support
IP通信では、UDP（User Datagram Protocol）がサポートされています。

● UDPのサポートにより、UDP Streamer と UDP Receiverの2種類の接続が追加されました。

● UDP接続では、ポート番号を設定する必要があります。UDPレシーバーのIPアドレスには 0.0.0.0 を、
UDPストリーマーのIPアドレスには対象となるIP機器のアドレスを記入してください。

注意：OSCはUDPに対応していますが、TCPには対応していません。

Player Units
Player Unitsは、Ovationが他のターゲットをコントロールするためのバーチャルデバイスです。

MIDI, IPコマンド, Sony P2 / RS422 Cue を再生するために利用可能なMIDIインターフェースIPポートとCOM
ポートを一覧表示します。

注意：既に使用されているバーチャルCOMポートに出力を割り当てようとすると、下図のダイアログが表示され
ます。

Virtual COM Port selection conflict
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MIDI

Application Settings > Player Units > MIDI

MIDIリストの Player Units の項目をクリックすると、右側のペインに関連するオプションが表示されます。

Midi
Enable チェックを入れると有効になります。

Virtual MIDI Port 有効にするとドロップダウンリストがアクティブになり、Virtual Midi Port をリストから
選択することができます。
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IP

Application Settings > Player Units > IP

IP
Enable チェックを入れると、Player は Cue Properties で定義されたIPコマンドを出力しま

す。

Escape character チェックすると、コマンド文字列の終わりを定義するためにエスケープ文字が使用さ
れます。
ドロップダウンリストから適切なエスケープ文字を選択してください。
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OSC Options
Send Cue status messages to this port
チェックすると、OSC Cue Statusメッセージがこのポートを介して送信されます。

注意：Cue Statusメッセージの説明は、Ovation OSC Dictionaryを参照してください。

Send Mixer status messages to this port
チェックすると、OSC Mixer Statusメッセージをこのポートに送信します。

注意：Mixer Statusメッセージについては、Ovation OSC Dictionaryを参照してください。

Remap to
選択した Mixer Status メッセージを別の OSC Dictionary に自動的にリマップします。

注意：Remap 機能は、Send Mixer Statusオプションが有効な場合のみ動作します。

Com

Application Settings > Player Units > COM

COM
Enable COM Player を有効にします。
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Virtual COM Port この機能を有効にすると、ドロップダウンリストがアクティブになり、バーチャルCOM
ポートをリストから選択できるようになります。

Protocol ドロップダウンでGenericまたはSony P2を選択できます。

COM Settings
注意：以下のCOM設定とプロトコルは、上記のプロトコルでGenericが選択されている場合のみ有効です。

Genericが有効な場合、以下のシリアルポートオプションが利用できます。ドロップダウンリストを使用して、使
用用途に適した設定を選択してください。

Baud rate
Data bits
Parity
Stop bits
Flow Control

Protocol
Start of message ドロップダウンリストで、各送信メッセージの先頭に追加される16進数の文字列を選

択することができます。

End of message ドロップダウンリストで、各送信メッセージの末尾に追加される16進文字列を選択す
ることができます。

Ethernet

Sony P2 over IP
事前設定

1.　File and Printer Sharing（ファイルとプリンターの共有）が有効になっていることを確認してください。

WIn XP Windows コントロールパネル > ネットワーク接続で使用しているLANカード/アダプターを選択
~ 右クリックしてプロパティを選択

Win 7 Windows コントロールパネル > ネットワークと共有センター > 詳細な共有設定の変更

Local Area Connection Properties Network and Sharing Center > Advanced Sharing Settings

173



2. a) ドメイン上のコンピュータ

コンピュータが同じドメインに接続されている場合、セキュリティアクセスはドメインサーバーによって管理されて

いるので、セクション3に直接進んでください。詳細については、IT管理者にご相談ください。

b) ワークグループ内のコンピュータ

ワークグループで作業するには、いくつかの追加手順が必要です。

● 各マシンが同じワークグループのメンバーであることを確認する。

● ワークグループの変更は、Windowsのコントロールパネル > システム > [XP]コンピュータ名タブ > 変
更で行うことができます。

● [XP]コンピュータ名タブ > 変更 [Win7]設定の変更

● 変更を有効にするには、コンピュータを再起動する必要があります !

● それぞれのマシンで、相手のマシンにアクセスできることを確認します。

● マイコンピュータ > ネットワーク > ワークグループ

● アクセスを必要とするマシンのユーザーアカウントのユーザー名とパスワードを入力する必要がありま

す。

● Remember my credentials [Win7] Remember my password [XP] にチェックを入れておかない
と、コンピュータを再起動するたびにユーザー名とパスワードを入力する必要があります。

● フォルダーを共有する必要はありません。
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Sony over IP

Application Settings > Player Units > SONY P2 > Device\Serial

Sony P2 over IPは、OvationがEthernet接続でSony P2プロトコルを使用して、リモートのVCubeまたは
Pyramixワークステーションを制御することができます。COMポートを有効にしてください。

仮想COMポート（COM1～COM16）を選択します。これは、実際のCOMポートと同じように動作します。仮想
COM ポートは Cue Propertiesペインの Sony P2 / RS422および COM Command セクションで使用され
ます。

File and Printer Sharing IP アドレスまたはコンピュータ名を挿入するか、ターゲットがローカルの場合は空
白にします(例：VCubeがOvation Sequencerと同じマシン上で動作している場合）。

Port Nameは、ターゲットマシンに複数のポートが設定されている場合に使用します。これはPyramixの場合
で、VCubeの場合ではありません。

リモートマシンが Pyramix の場合は、Pyramix で Sony over IP の設定でコントローラーを追加する必要があ
ります。

リモートマシンが VCube の場合、VCube側では何も設定する必要はありません。ただし、接続は1つしかでき
ません。

Com
Enable ボックスにチェックがはいっていると Sony P2 over IP が有効です。

Virtual COM Port 現在選択されているバーチャルCOMポートを表示します。下矢印は、使用可
能なポートのリストをドロップダウンします。
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Remote Identification

Remote Computer name ここに入れるリモートPCの名前は一致していなければなりません。

Port Name* ここでの入力は、もう一方のコンピューターの Controller Port Nameと一致
していなければなりません。

GPO

Application Settings > Player Units > GPO > SeaI/O-410

注意：現在 対応しているGPI/Oインターフェースは、Sealevel社の以下のモデルのみです。
● SeaPORT PLC-16** 8 in 8 out
● SeaI/O-410U 16 in 16 out
● SeaI/O-420U* 16 in 8 out
● SeaI/O-430U* 32 in 0 out
● SeaI/O-440U* 0 in 32 out
● SeaI/O-450U* 0 in 16 out
● Seal/O-8012e 8 in 8 out
● Seal/O-8012es 8 in 8 out
● SeaDAC P/N 8221* 16 in 16 out
● SeaDAC P/N 8222 16 in 8 out
● SeaDAC P/N 8223* 32 in 0 out
● SeaDAC P/N 8224* 0 in 32 out
● SeaDAC P/N 8225* 0 in 16 out

* 特注対応可能 ** 生産終了
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注意：USBドライバーは Pyramixインストーラーには含まれていません。サプライヤーのWebサイトからドライ
バーをダウンロードしてください。GPIOハードウェアデバイスの仕様については下記のサイトをご覧ください。

http://www.sealevel.com /

最大32台まで接続できます。物理的に設置されているGPO機器はここに表示されます。

General Purpose Output
Enable

チェックを入れると、GPO が有効になります。

Virtual GPO Port

ドロップダウンリストには、利用可能なすべての仮想GPOポート、または Noneが表示されます。

注意：Show の実行中や Cue のオーディション中にSettingsウィンドウを開いても、Playerのページは表示さ
れません。

注意：Player がデフォルトのローカルマシンであっても、ネットワークマシン上のスタンドアローンであっても、
Show が実行されているか、Cue がオーディション中であれば、Player に関連するすべてのページはSettings
ウィンドウに表示されません。
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Controller

Remote Controlled Ovations
このページでは、どのステーション（Ovationが動作しているPC）をOV Controller Session で制御するかを定
義します。

Application Settings > Controller > Remote Controlled Ovation Stations

Controlled Stations
Local Ovation Squencer

チェックすると、同じマシンで動作している Ovation Sequencer が、このコントローラからのコマンドを受信しま
す。

Remote Ovation Sequencers

稼働中の Ovation Sequencer が選択したコントローラからのコマンドを受け取るリモートマシンのリストを追加
することができます。これにより、ネットワークを介したリモートコントロールや、複数の Ovation Sequencer を
同時にコントロールして冗長性を持たせることができます。

新しいリモート Ovation Sequencer シーケンサを追加するには、Click here to add a Remote Ovation
Sequencer をクリックし、PCのネットワーク名を入力します。

上のスクリーンショットでは、Parade と Lake という2つの Remote Ovation Sequencer が追加されていま
す。

Backup Sequencer
Mirror All Commands to Remote Ovation Sequencers listed above

チェックを入れると、ローカルのOvationのすべてのコマンドが、選択したリモートシーケンサーにミラーリングさ
れ、冗長性が保たれます。
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Controller Units
Controller Units

Ovation Sequencer/Showコントローラ をリモートコントロールするためのフォルダです。

このフォルダには、システムでサポートされているすべてのリモートコントロールユニットがサブフォルダにリスト

アップされています。それらは以下のようになります。

● 独自のOvationキーボード
● 独自のOvationウェブサーバー
● IPコントローラー
● MIDIポート
● MCS(Midi Show Control)、MTC(Midi TimeCode)、MMC(Midi Machine Control)および

GM(General Midi)
● DMXポート (Art Netプロトコルは後のベータ版で利用可能)
● GPIポート
● Sony 9ピン（P2プロトコル）リモートコントロール

注意：英文マニュアルの Appendix I では、コントローラユニットの各種プロトコルの実装方法と、使用可能な
Ovation Media SequencerおよびMedia Server Commandsとのマッピング方法について詳しく説明していま
す。

注意：OvationとPyramixでサポートされているコントローラのリストは以下のリンクをご覧ください。

https://confluence.merging.com/display/PUBLICDOC/Pyramix+Supported+Controllers

コントローラーユニットをクリックしてリストから選択すると、関連ページに適切なオプションが表示されます。
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Proprietary

OVKeyboard

Application Settings > OV Controller Units > Proprietary > OVKeyboard

Ovation Keyboard
Enable

チェックすると Ovation Keyboardがアクティブになります。

Keyboard Mapping
Multi-purpose (Standard Mapping)

赤い大きなボタンの振る舞い ドロップダウンは、Fire Sequenced Cue または Fire Selected Cue
を選択できます。この設定は、Multi Purpose（Standard Mapping）モー
ドのコントローラにのみ適用されます。UIには影響しません。

Hot Keys Only
ラジオボタンは相互に排他的です。物理的なキーボードレイアウトに対応するマッピングを選択します。

注意：Pyramix と Ovation を同時に使用している場合で、PyramixにADR機能がある場合、キーボードが競合
する可能性があります。この場合は、以下の場所にDWORDレジストリキーを追加してください。
HKEY_CURRENT_USERSoftware\Merging Technologies\Pyramix\ADR を開き、
Disable ADR Keyboard という名前のDWORDレジストリキーを追加し、1に設定します。
レジストリの編集に自信がない場合は、マージング社の販売パートナーに変更を依頼してください。
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Web Server

Application Settings > OV Controller Units > Proprietary > Web Server

Web Server

Enable チェックするとWebサーバー機能が動作します。

HTTP Port: デフォルトは 888 です。必要があれば変更してください。

Pages Root Folder フィールドには、Pages Root Folderへのデフォルトのパスが表示されていま
す。...ボタンをクリックするとブラウザが開き、別のパスを設定できます。

Password (optional) : ページをパスワードで保護する場合は、フィールドにパスワードを入力します。

Tutorial チュートリアル
ブラウザで Ovationが動作しているマシンのIPアドレスと、上記で定義したポート番号を入力してください。

http://128.0.0.1:888

表示される  Cue List を制限するには、次のようなフィルターを追加します（フィルター内の  Cue List のイン
デックスは、  Cue List の番号から1を引いたものと定義されます）。
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http://128.0.0.1:888/Filter?Cuelist=0

ページ下部の Show Control Bar を非表示にして、予期しない操作を避けるには、次のようなフィルタを追加し
ます。

http://128.0.0.1:888/Filter?ShowControlBar=Hidden

または、両方を「&」で区切って併用することもできます。

http://128.0.0.1:888/Filter?Cuelist=0&ShowControlBar=Hidden
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MIDI

E.g. Ethernet MIDI

Application Settings > Controller Units > MIDI > Ethernet MIDI

MIDI INPUTs

注意：各MIDIセクションの右側にある赤く点滅するLEDは、MIDIデータを受信していることを示します。

Midi Port
Enable

チェックすると MIDI remote controlが有効になります。

注意：このオプションが選択されるまで、このページの他のオプションはグレーアウト（利用不可）されます。

Virtual MIDI Port
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ドロップダウンリストで、利用可能な最初の16個のMIDIポートのいずれかを選択できます。

Midi Show Control (MSC)
Enable

チェックすると MIDI Show Control (MSC)が有効になります。

Device Id
ドロップダウンリストには、「Any」または「Device Ids（0～7E）」が表示されます。

Command Format
ドロップダウンリストには、コマンドフォーマットタイプをフィルタリングするためのMSCの選択肢が多数用意され
ています。

Midi TimeCode (MTC)
Enable

チェックすると MIDI TimCodeが有効になります。
使用するMidi Portは、上記1項で設定したMidi Portです。

Midi Machine Control (MMC)
Enable

チェックすると MIDI Machine Control が有効になります。

General Midi (GM)
If Ticked, ignore Note On/Off velocity

チェックすると Note On/Off ベロシティ が無視されます。

Enable direct Cue mapping of MIDI messages from the selected Virtual MIDI Port
ボタンをチェックすると、個々のCueの General MIDI（GM）コントロールが有効になります。

注意： Direct MIDI messages Cue mappingは Cue Propertiesの General MIDI Command セクショ
ンの‘REMOTE CONTROL:にあります。

Enable Mapping based on command:
MIDIコマンドを Show Start, Select Next Cue List などのCueイベントに関連しないイベント、またはSelect
Next Cue などのコンテキストに関連するCueコマンドにマッピングできるようにします。

ドロップダウンリストで、どのタイプの Midi コマンドをマッピングするかを選択できます。

Note off
Note on
Polyphonic key pressure
Control change
Program change
Overall keypressure aftertouch
Pitch bender change
Control Change コマンドは、Note On などの General Midi コマンドです。

Midi Channel欄の Add をクリックすると、リストにエントリが追加されます。

Midi Channel欄の 0をクリックすると、利用可能なMidi Channel（1～16）のリストが表示されます。

Data 1の欄のエントリーをクリックすると、0～127までの選択肢がリストアップされます。

Media Sequencerの欄をクリックすると、マッピング可能なOvationコマンドのリストが表示されます。

PCキーボードの Delete でマッピングエントリを削除できます。
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Enable Legacy GM (Note On/Off and Program Change old auto mapping)

古い "固定 "スタイルのGMマッピングを再び有効にします。

マッピング可能なコマンドの一覧は、GM（General Midi）を御覧ください。

COM
Ovationの Cue は、Sony P2プロトコルのコントローラーから開始、停止、一時停止することができます。また
Ovation ステーションは、Ovation のネイティブプロトコルを使用して、シリアル接続を介してリンクされた別の
Ovation をコントロールすることができます。
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Sony P2

Application Settings > Controller Units > COM > COM1: P2 mode)

Com Port
Enable チェックを入れると、Com Port と関連するリモートコントローラーがOvationを制御できるように

なります。

Protocol ドロップダウンでは、Sony P2とOvationの選択が可能です。設定ページはモーダルで、この設
定により他の適切な設定が表示されます。
Sony P2 プロトコルを使用するマシンで制御する場合は、Sony P2を選択します。

Com Settings
Protocol

Sony Device Id
ドロップダウンリストには、OvationとOvationでサポートされているすべてのP2デバイスエミュレーションが表示
されます。
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Targeted Cue List
このドロップダウンリストで、現在のOvation Showにある任意のCue Listをターゲットとして選択することができ
ます。

Track Arming Cues Selection
注意：Digital presets（Track Aeming）1-32 のみが許可されています。

ドロップダウンリストで以下のものが選択できます。

No selection トラックアーミングは影響を受けません。

1-8 Selects Cue lists, 9-32 selects Cues

Targeted Cue List is used, 1-32 selects Cue Targeted Cue Listは、Targeted Cue Listドロップ
ダウンリストで選択されたものによって決定されま
す。

Targeted Cue List is used, hours selects
Cues

Targeted Cue Listは、Targeted Cue Listドロップ
ダウンリストで選択されたものによって決定されま
す。

Goto Cues selection
ドロップダウンリストで以下のものが選択できます。

No Selection Goto TimeCode は影響を受けません。

Hours selects Cue Lists, minutes select Cues

Targeted Cue list is used, hours select
Cues

Targeted Cue Listは、Targeted Cue Listドロップダウ
ンリストで選択されたものによって決定されます。

注意：

Valid Cue and Cue List Numbers
00は Cue 番号や  Cue List 番号として使用できないため、アドレスを指定できる Cue と  Cue List の最大数
は、時間と分でそれぞれ 23 (1-23) または 59 (1-59) に制限されます。

制限

● A) Cue内の特定のタイムコードに移動する（未実装）。
● B) アナログのA1、A2、V、TCのエディットプリセットビット（トラックアーミング）は使用しません。デジタ
ル編集プリセット1～32のみ使用します。プリセット32以上（未実装）。

● C) Rew、F.Fwd、Jog、Shuttleはできません。

Track arming Cues selection options:
● 1) "No selection" でトラックアーミングは動作しません。
● 2) "1-8は Cue List を選択、9-32は Cue を選択"
● 3) "Targeted Cue list is used, 1-32 selects Cues" : ドロップダウンメニューにより、ターゲットとなる

Cue List が選択されます。

Goto Cues selection options :
● "No selection" トラックアーミングは効果がありません。
● "1-8で  Cue List を選択、9-32で Cue を選択"
● "Targeted Cue list is used, 1-32 selects Cues" : ドロップダウンメニューにより、ターゲットとなる

Cueリストが選択されます。

Ovation to Controller Reporting
Ovation は次のレポートをコントローラーに送り返します。

● 選択されたCueの現在のタイムコード。
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● 上記オプション 1の場合はフルタイムコード。
● 上記オプション 2の場合は秒とフレーム、時と分はそれぞれ  Cue List 番号と Cue 番号を示します。
● 上記のオプション 3の場合は、分、秒、フレームで、時間は Cue #を示します。
● 再生、停止、一時停止（静止）タリー、 Cue アップ（ Cue の準備ができたとき）。
● 選択されたCueを示すトラックアーミングステータス（Edit preset sense）。オプション Aの場合は無効
です。

● デフォルトのデバイスIDはOvationで、以下のように報告されます。ソニーのデバイスID : 0xF0B1
(NTSC), 0xF1B1 (PAL), 0xF2B1 (Film).

● その他のデバイスIDは、Sony Device Idのドロップダウンリストから選択できます。
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Ovation mode

Application Settings > Controller Units > COM > COM1: Ovation mode)

Com Port
Enable チェックを入れると、Com Port と関連するリモートコントローラーがOvationを制御できるよう

になります。

Protocol ドロップダウンでは、Sony P2 と Ovationの選択が可能です。設定ページはモーダルで、こ
の設定により他の適切な設定が表示されます。
他のOvationステーションで制御する場合は Ovation を選択します。

COM Settings
以下のパラメータは、制御するOvationに合わせて設定する必要があります。
Baud rate
Data bits
Parity
Stop bits
Flow Control
Protocol
英文マニュアル Appendix VII を参照してください。

189



IP

Application Settings > Controller Units > IP > IP3

注意：IPエントリーとIP1などのコントローラーは、Settings > Application > General > IP Connection で設
定された場合のみ表示されます。IP Connectionsの章を御覧ください。

IP Controller Unitは、データを受けるのに使用されます。

以下のデータフォーマットを受け取ることができます。

1.　Ovation Native（httpプロトコル フォーマット）
2.　マッピング　以下で定義されたマッピング データ メッセージ

a. メッセージ長
b. 特殊なエンドオブメッセージ文字（エスケープ文字）
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Internet Protocol Options
Enable チェックすると、コントローラがアクティブになり、このページの残りの

設定が可能になります。

Ovation Native Mapping, Dataton Synchronization, OSCとは相互に排他的で
す。チェックすると、Ovation Web Serverで使用されるネイティブな
HTML形式のコマンド文字列が受け入れられます。Web Server
Commands を参照してください。

Mapping (Cue direct mapping) Native, Dataton, OSC Synchronizationとは相互に排他的です。

Escape Character チェックすると、コマンド文字列の終
わりを定義するためにエスケープ文
字が使用されます。ドロップダウンリ
ストから適切なエスケープ文字を選
択してください。

Message Length of チェックすると、メッセージの長さ（バ
イト）が、コマンド文字列間のブレーク
ポイントの
コマンド文字列間のブレークポイント
を定義するために使用されます。

Send status feedback
via Player section of this
connection

プレイヤーセクションは他の目的では
使用できません。

3. Dataton Synchronization リモートのDatatonプレーヤーを使用する際には、この点を確認してくださ
い。Native, Mappingとは相互に排他的です。

4. OSC このポートでは、以下の種類のOSCディスパッチメッセージを受信します。このポートで受信し
たOSCリモートコントロールメッセージのうち、処理するものを選択することができます。

● /Server messageは、Ovationのグローバル機能（Show state、CueおよびCueリストなど）に関連し
ています。

● /Mixer messageは、Ovationのミキシングコンソールをリモートコントロールします。

● /CueMapping messageは、Cue Properties - Remote Control - IP / OSCコマンドで設定された
特定のコントロールに関連します。

● Flux :: SpatRevolution message : Flux::Spat Revolutionの Fader, Solo, Mute, Pannerのメッ
セージは、自動的にOvation OSC Dictionaryのスキームにリマップされます。

注意：詳しくは、Ovation OSC dictionary をご参照ください。

GPI
GPIユニットが全てリストアップされています。
GPIデバイスの設定を行うにはリストの中のデバイスをクリックしてください。
注意：現在、対応するGPI/Oインターフェースは、Sealevel社の以下のモデルのみです。

● SeaPORT PLC-16** 8 in 8 out
● • SeaI/O-410U 16 in 16 out
● • SeaI/O-420U* 16 in 8 out
● • SeaI/O-430U* 32 in 0 out
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● • SeaI/O-440U* 0 in 32 out
● • SeaI/O-450U* 0 in 16 out
● Seal/O-8012e 8 in 8 out
● Seal/O-8012es 8 in 8 out
● • SeaDAC P/N 8221* 16 in 16 out
● • SeaDAC P/N 8222 16 in 8 out
● • SeaDAC P/N 8223* 32 in 0 out
● • SeaDAC P/N 8224* 0 in 32 out
● • SeaDAC P/N 8225* 0 in 16 out

* は特注品 ** は生産終了品

注意：最大32ユニットが接続できます。

OV Controller Settings > Controller Units > GPI > SeaI/O-410 (COM9 [0])

General Purpose Input (GPI)
Enable

チェックを入れるとGPIコントロールが有効になります。

Cue # corresponds to the Cue ID

このボタンをチェックすると、Cue は Cue#、Child#1、Child#2、Child#3 を使って最大 3 つのネストしたレベル
で識別されます。これは Cue Properties ページに表示されるグレーの数字、またはCueボタンのCue名の横に
表示される数字です。この数字は、Child#1などのCue#の間の区切りを表しています。

このモードは、ネスティングの仕組みを利用して、挿入した Cue の下にある Cue の#を変更せずに、  Cue List
の任意の場所に Cue を追加する必要がある場合に便利です。

Cue # corresponds to the Cue Index
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Cue # は、その Cue List における Cue のインデックスです。これは、Cue Propertiesページに表示されるグ
レーの数字、またはCueボタンのCue名の横に表示される数字で、いずれかのCueがネストされている場合に
使用されます。マッピングにネストされたメカニズムが役に立たない場合に有効です。

例：

Trigger Options
8つのラジオボタンでトリガのパラメーターを設定します。

1 ハイレベルの信号を検出したときにトリガ

2 ローレベルの信号を検出したときにトリガ

3 信号の立ち上がりでトリガ

4 信号の立ち下がりでトリガ

5 パルスの最初のハイレベルを検出したときにトリガ

6 パルスの2番めのハイレベルを検出したときにトリガ

7 パルスの最初のローレベルを検出したときにトリガ

8 パルスの2番めのローレベルを検出したときにトリガ

注意：各 Trigger Options に別々のコマンドを割り当てることができます。

注意：3-4, 5-6, 7-8 はよくペアで使用されます。

例1：ボタンを押して離すと Cue が Fire され、2回目にボタンを押して離すと Cue が停止するようにしたい場
合。この場合は、5-6または7-8を使用してください。

例2：ボタンを押したときにCueを起動し、ボタンを離したときにCueを停止させたい場合。この場合は3-4を使用
します。

注意：High/Low入力と立ち上がり/立ち下がり入力は、同じ状況でマッピングされたコマンドをトリガーします。
唯一の違いは、立ち上がりがHighの前に実行され、立ち下がりがLowの前に実行されることです。これは、2つ
のコマンドを連続して実行する必要がある場合に便利です。
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Media Server Commands Mapping

コマンド表では、P列がパラメータに対応しています。メディアサーバーコマンドの多くは、次のようになっていま
す。P.1 = Cue List #、P.2 = Cue #、P.3 = Cue Child1 #、P.4 = Cue Child2 #。P.3 Cue Child1 #, P.4 Cue
Child2 #
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Ovation Webserver
Overview
Ovation は あらゆるシステムに対して驚くほどのコントロールを実現します。しかしこれまでは、他の多くのシー
ケンサーやコントロール・ソフトウェアと同様に、そのコントロールにアクセスするにはローカル・マシン上の専用

インターフェースに限られていました。

しかし WebServer オプションにより、その状況は一変しました。ウェブ対応のプラットフォーム（デスクトップ,
ラップトップ, スマートフォン, iPadなど）の標準的なHTTPインターフェイスを通じて、複数の場所から Ovation
の Show を完全にコントロールすることが可能になりました。

Merging 社独自のインターフェース デザインを使用することもできますし、基本的なWebページ デザインを知っ
ていれば カスタム インターフェースを作成することもできます。どのような選択であれ、またどのようなプロジェク
トであれ、Ovation Show やインストレーションに WebServer を使用することで、これまでにないコントロールの
可能性が開けます。

アプリケーション
● 技術者でないユーザーのためのマルチゾーンアクセス 複数の部屋を持つ博物館の展示物など

● 手動で Cue やシーケンスを Fire するためのステージサイドアクセス

● 複数のコントロールステーション（例：ゲーム Show など ギャラリー, 音響監督, プレゼンター）がそれぞ
れのニーズに合わせて適切なコントロールを行うことができます。

● ピット にいるコンダクターのための Show 情報とタイミングビュー

● ホテルのロビーやバーに設置される特注のブランドインターフェース

● その他、多数......

Using Ovation Webserver

Activating
Ovation WebServerを有効にするには、Settings >Application > Controller Units > Proprietary >
Web Serverに進み、Enableボタンをチェックします。

必要に応じて、このページでHTTPポート番号を変更できます。デフォルトのポートは888です。

Pages Root Folderは、Mergingが標準で提供するものとは異なるカスタムページを提供するために変更する
ことができます。デフォルトでは、Ovation User Interfaceに似たインターフェースを実装しています。

注意：OvationShow.htmlと js/OvationProcess.jsはMerging Technologies社の所有物ですが、カスタム
ページ作成の参考として自由にお使いいただけます。

Quickstart
ブラウザで、Ovationを起動しているマシンのIPアドレスとポート番号を入力してください。

http://192.168.2.13:888
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以下のフィルターを追加することで、表示される Cue List を制限することができます（フィルター内の Cue List
インデックスは、Cue List 番号から1を引いたものとして定義されます）。

http://192.168.2.13:888/Filter?Cuelist=0

次のフィルタを追加することで、ページ下部の表示コントロールバーを非表示にして、予期しない操作を避けるこ

とができます。

http://192.168.2.13:888/Filter?ShowControlBar=Hidden

または、両方とも一緒に、＆で区切ってください。

http://192.168.2.13:888/Filter?Cuelist=0&ShowControlBar=Hidden

これで次の様になります。
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Settings
ページの右上にあるOvationのロゴをクリックすると、メニューが表示され、表示スタイルを Tabbed View また
は All-in-One View から選ぶことができ、ページの更新間隔を設定することができます。

All-in-One View では、  Cue List がページの下に次々と表示されます。タブ表示では、1つの  Cue List が表
示され、残りの  Cue List はページ上部のタブに表示されます。
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ネットワークが遅い場合やアーティファクトが気になる場合は、リフレッシュレートを下げて利用することができま

す。

HTTP Control
HTTP コマンドは、クライアントアプリケーションから Ovation WebServer に直接送信することができます（
Web ブラウザの URL フィールドにコマンドを入力することもできます）。

これらのコマンドは、Ovation Controller Commands ドキュメントに記載されていますので、参照してください。
Appendix VII Web Server Commands.

一般的には、以下のようなコマンドが送信されます。

● 192.168.1.33:888/Action?Command=Show_Init

● 192.168.1.33:888/Action?Command=Show_Start

● 192.168.1.33:888/Action?Command=Cue_Fire&CueList=0&Cue=4.-2

● 192.168.1.33:888/Action?Command=CueList_Select&CueList=0

● 192.168.1.33:888/Action?Command=Cue_Select&CueList=-1&Cue=1.-2

● 192.168.1.33:888/Action?Command=Cue_Fire&CueList=-1&Cue=-1

● 192.168.1.33:888/Action?Command=Cue_Pause&CueList=-1&Cue=-1

● 192.168.1.33:888/Action?Command=Cue_Fire

● 192.168.1.33:888/Action?Command=Cue_Stop

● 192.168.1.33:888/Request?Show

● 192.168.1.33:888/Request?Cues_Status

Connection Feedback
クライアントのネットワーク接続が失われた場合（wifi）、または何らかの理由でOvationサーバーがオフラインに
なった場合、TimeCodeカウンターの背景が赤に変わります。接続が回復すると、Web UI は自動的に再接続さ
れます。

GPI Command Mapping

Media Server Commands Mapping
コマンド表の P列は、メディアサーバーコマンドの大半のパラメータに対応しています。

P.1 = Cue List #
P.2 = Cue #
P.3 = Cue Child1 #
P.4 = Cue Child2 #
注意：パラメータは、-1（マイナスワン）で設定しなければなりません。

例：

Cuelist#5の Cue#2 をFireするには、
Cuefire P.1=5, P.2 = 2, P.3 = -1, P.4 = -1

Appendix Vを参照してください。
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Tips and Tricks

Rules
Ending と Stoppingの指定の違いを理解することが重要です。

Endingは、Cue が正常に再生を終えることです。

Stopping とは、手動またはルールによって Cue が早期に終了することです。

また、When と Afterの違いについても理解しておく必要があります。この設定は、ルールが適用される時点に
影響します。When を選択した場合、ルールはフェードアウトまたはフェードインが始まった時点で適用されま
す。

After を選択した場合、Cue の開始後、またはmsボックスで設定した遅延時間で Cue が終了または停止し
た後に適用されます。

注意：ルールのアクションは、After で遅延を適用しない限り、常に Cue の開始時またはフェードアウトの開始
時のいずれかに発生します。

When を選択すると、クロスフェードを簡単に作成することができます。

クロスフェードが必要ない場合は、Offsetパラメータを使って補正することができます。

Fade Modifier
Shiftキーを押すと、ユーザー定義のフェード時間が呼び出されます(専用キーボードの Fade Modifierキー、
または標準キーボードの Shiftキー)。

<Default>
Ovationで <default>がオプションの場合、階層は以下のようになります。

Cueの設定は Cue Listの設定を上書きします。

Player
OVPlayer がCue Propertiesで特定のネットワークにアサインされていない場合（フィールドが空白または
<default>に設定されている場合）、Ovation は Cue List Propertiesの Default Output Player フィールド
を確認します。このフィールドが空白または <Default>に設定されている場合、OvationはShow Properties
の Default Output Player フィールドを確認します。これも空白または <Default>に設定されている場合、
ローカルのOvationプレーヤーが使用されます。

Stop Fade Out
同様に、Cue Properties で Stop Fade Outが <Default>に設定されている場合、Ovation は Cue List
Propertiesの Default Stop Fade Out フィールドの設定を確認します。これも <Default>に設定されている
場合、Ovation は Show Propertiesの Default Stop Fade Out フィールドを確認します。これも
<Default>に設定されている場合は、Cue Propertiesの Fade Out フィールドの値が使用されます。

Drag & Drop
メディアファイルは、Ovationの外部から  Cue List に ドラッグ＆ドロップ することができます。例：エクスプロー
ラブラウザ や iTunes など。
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Altキーを押しながら既存の Cue にドラッグ&ドロップした場合は、オーディオのみの Cue の場合、元のメディ
アファイルが置き換えられます。

Shiftキーを使用して、Cue List 間で Cue をドラッグ＆ドロップできます。Altキーを使用すると、基礎となる
オーディオ メディア ファイルがソースに置き換えられます。単純なドラッグ＆ドロップで Cue List を並べ替えるこ
とができます。

Changing Properties for Multiple Cues
複数の Cue が選択されている場合、Cue Propertiesで変更されたパラメータは、選択されているすべての
Cue に対して更新されます。唯一の例外は Cue Number です。これは複数の異なるリストで Cue が選択され
ている場合にも適用されます。

(複数のCueの選択は Windowsブラウザの規約に従います。例えば、1つのCueを選択した状態で Shift +
Clickすると、2番目にクリックした Cue までの連続した範囲が選択され、Ctrl + Clickすると Cue の選択/非
選択が切り替わります)。

Starting a Show With Sysex
Ovation 7.x では、MIDI SysEx 入力を特定の Ovation コマンドにマッピングすることができません。マッピング
可能なMIDI入力は以下の通りです。General Midi (GM) - Control Change コマンド（2-3バイト長のメッセー
ジ）。例：Hexa = B0 00 00 or B1 10 00 or ...

ただし、コントロールする機器が任意の SysEx メッセージを送信できる場合は、以下の2つの Midi Show
Control 固有の SysEx メッセージを使用することができます。

Show Init:

Hexa = F0 7F <Device id> 02 <Sound (General) = 10> 07 01 F7 Show Start:

Hexa = F0 7F <Device id> 02 <Sound (General) = 10> 07 02 F7

<Device id> ：specified in Settings > Controller Units > MIDI > Midi port (Midi Show Control section).

<Sound (General)> : 同様に設定されています。

Ovationで使用できるMIDI Show Controlマクロコマンドの詳細については、MIDI and Midi Show Control を
参照してください。
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First launch

Starting Ovation
デフォルトでは Ovation は Programs フォルダにインストールされます。同時にデスクトップ上にショートカット
が作成されます。

デスクトップの Ovation ショートカットをダブルクリックすると Ovation が起動します。

別の方法では、Start > All Programs > Merging Technologies > Ovation > Ovation を選択してください。
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Audio File Support

Quicktime Support
Quicktimeハンドラーを有効にするためには、Apple社からQuicktime Proを購入してインストールする必要が
あります。

http://www.apple.com/quicktime/pro/

Compressed Audio File Formats
Ovationは、MP3やAACをはじめとする多くの圧縮ファイルフォーマットを直接サポートしています。その他の圧
縮フォーマットは、WindowsのDirectShowテクノロジーによってサポートされています。

Codecs

MP3 and AAC
OvationはMP3とAACに直接対応しています。(オプションのAdvanced Audio Codec Supportキーが必要で
す。)別途コーデックをインストールする必要はなく、解凍ファイルも発生しません。

FLAC
FLACのエンコード、デコードに直接対応しています。別途コーデックのインストールやキーは必要なく、解凍ファ
イルも生成されません。

Ogg-Vorbis
Ogg-Vorbisのエンコードおよびデコードにネイティブに対応しています。別途コーデックのインストールやキーは
必要なく、解凍ファイルも生成されません。

How Compressed Audio Support Works

Technology
デコンプレッションは、Microsoft DirectShow テクノロジーによって行われます。そのため、サポートされる
フォーマットは、どの DirectShow コーデックがインストールされているかによって異なります。Windows のデ
フォルトのインストールでは、一般的な圧縮ファイル形式（wma、mp3など）のほとんどを扱うことができますが、
主要な圧縮形式（ogg-vorbis、flacなど）をすべてサポートするために、さまざまなコーデックが存在しています。

また、主要な圧縮ファイル形式（ogg-vorbis、flacなど）に対応した様々なコーデックがあります。

Widows のデフォルトのインストールで問題が発生した場合や、特定のコーデックを必要としている場合は、
Merging 社が推奨するサードパーティ製のコーデックのリストを用意しています。

詳細については、Merging Forum Pyramix Troubleshooting & Tips section をご覧ください。
http://forum.merging.com/viewforum.php?f=16

サンプルの正確な編集を可能にするために、圧縮ファイルはまずキャッシュファイルに解凍されます。このファイ

ルは以下のようなフォーマットになっています。

originalFileName__DXC(tag)DCX_.wav

このファイルはプレーンな wav ファイルです。
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Ovation Setup
まず、デフォルト の Default decompression cache を設定します。

Settings > Application > General > Media Manager > Other settings で Decompression Settings
をクリックし、Decompress files… ダイアログを開きます。

ここでは、マウントルールが指定されていない場合に、メディアをどこに解凍するかを指定します。

Decompress files... dialog

Locally (by the original)：ファイルは元のファイルと同じ場所に作成されます。

Sub-locally (by the original, in a \MTDXCache sub folder).：ファイルは、元のファイルと同じ場所に
Pyramixが作成したサブフォルダーに作成されます。

Custom (files are generated to the specified location).：ユーザーが指定した場所にファイルが作成さ
れます。このオプションを選択すると、Browse...ボタンが表示され、ファイルブラウザーウィンドウを開いてユー
ザー定義のパスを設定できます。

Mounting Rules
general settings に加えて、Mounting Rulesを作成して、特定のマウント場所の Default decompression
cache settings を上書きすることができます。

Mounting Rules dialog decompression rules section

Special rules for cache file decompression
Locally (by the original)：ファイルは元のファイルと同じ場所に作成されます。

Sub-locally (by the original, in a \MTDXCache sub folder).：ファイルは、元のファイルと同じ場所に
Pyramixが作成したサブフォルダーに作成されます。

Custom (files are generated to the specified location：ユーザーが指定した場所にファイルが作成され
ます。このオプションを選択すると、Browse...ボタンが表示され、ファイルブラウザーウィンドウを開いてユー
ザー定義のパスを設定できます。

Enable：ルールを有効にします。
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Allow cache files mounting：チェックを入れると、キャッシュファイルを直接マウントすることができます。
チェックを入れないと見えない状態になります。
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Keyboard Shortcuts
Show Edit Mode では、Fire コマンドがダブルクリックのように動作するようになり、デフォルトではSpaceキー
にマッピングされています。そのため

● Edit Mode では、SpaceはAudition / Stopを切り替えます。

● Show Mode では、Space は常に Cue を起動します。

● Show Mode では、Enter は Fire Sequenced Cue ! (Fire and select Next) となります。

Default Keyboard Shortcuts
Show

New Show CTRL + N

Open Show CTRL + O

Save Show CTRL + S

Save Show As CTRL + A

Init Show F1

Start Show F2

Pause Show F3

Stop Show F4

Consolidate Show

View Show Properties SHIFT + P

View Show Validator

View Show Log

View Show Control Toolbar

View Audition Toolbar

View Active Cue Window

View Audio Control

Exit CTRL + Q

Cue List

New Standard Cue List CTRL + SHIFT + N

New Timed Cue List

New Hot Keys

New Custom Keys
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New Browser CTRL + SHIFT + B

New Hot Browser

Open Cue List CTRL + SHIFT + O

Save Cue List As CTRL + SHIFT + A

Close Cue List CTRL + SHIFT + C

Fire & Start F5

Start F6

Pause Shift + F7, F7

Stop Shift + F8, F8

Chase

Toggle/Select Cue List TAB

Toggle/Select Hot Key list

Select Specific Cue List CTRL + Corresponding Hot Key (01 - 48) (Either on PC

keyboard or Hardware Remote)

View Cue List Properties CTRL + SHIFT + P

View Fire Toolbar

View Edit Toolbar

Custom Keys Design Mode Ctrl + Shift + E

Snap all Keys on Grid

Reset all Keys Position

Reset all Keys Size and Position

Cue

Undo Ctrl + Z

Cut CTRL + X

Copy CTRL + C

Paste CTRL + V

Add Empty Cue Insert

Load MTInterChange XML

Load Audio File

Remove Delete
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Edit Ctrl + E

Replace Audio Media

Audition Ctrl + Space, Ctrl + D

Audition Start

Audition Rewind

Audition Stop Ctrl + Shift + F11, Ctrl + F11

Audition Play/Pause Ctrl + F9, Ctrl + Shift + F9

Audition Fast-Forward

Audition End

Audition Review Start

Audition Review End

Audition Jump Forward 1 Ctrl + Right

Audition Jump Forward 2 Ctrl + Shift + Right

Audition Jump Forward 3 Ctrl + Shift + Alt + Right

Audition Jump Back 1 Ctrl + Left

Audition Jump Back 2 Ctrl + Shift + Left

Audition Jump Back 3 Ctrl + Shift + Alt + Left

Move Down Ctrl + Down

Move Up Ctrl + Up

Nest Ctrl + Alt + Right

Unnest Ctrl + Alt + Left

Edit Cue Rules Ctrl + R

Edit Audio Gain Ctrl + G

View Cue Properties Ctrl + P

Fire

Fire Sequenced Cue ! Enter

Previous Scene Left

Next Scene Right

Previous Cue Up

Next Cue Down
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Fire Cue Space, Shift + F9, F9

Pause Cue Shift + F10, F10

Stop Cue Shift + F11, F11

Stop All Cues

Hot Key 01 (Down) 1

Hot Key 02 (Down) 2

Hot Key 03 (Down) 3

Hot Key 04 (Down) 4

Hot Key 05 (Down) 5

Hot Key 06 (Down) 6

Hot Key 07 (Down) 7

Hot Key 08 (Down) 8

Hot Key 09 (Down) 9

Hot Key 10 (Down) 0

Hot Key 11 (Down)

Continues to:-

Hot Key 48 (Down)

Hot Key 01 (Up) 1

Hot Key 02 (Up) 2

Hot Key 03 (Up) 3

Hot Key 04 (Up) 4

Hot Key 05 (Up) 5

Hot Key 06 (Up) 6

Hot Key 07 (Up) 7

Hot Key 08 (Up) 8

Hot Key 09 (Up) 9

Hot Key 10 (Up) 0

Hot Key 11 (Up)

Continues to:

Hot Key 48 (Up)
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Trimmer

Nudge Cue In Less

Nudge Cue In More

Nudge Cue Out Less

Nudge Cue Out More

Nudge Fade In Less

Nudge Fade In More

Nudge Fade Out Less

Nudge Fade Out More

Nudge Cursor Less

Nudge Cursor More

Snap In To Cursor

Nudge Out To Cursor

Audition Review Start

Audition Review End

View

View Show Properties Shift + P

View Show Validator

View Show Log

View Show Control Toolbar

View Cue List Properties Ctrl + Shift + P

View Cue List Fire Toolbar

View Cue List Edit Toolbar

View Cue Properties Ctrl + P

View Audition Toolbar

View Active Cue Window

View Mixer Alt + M

View Touch Controller Alt + C

Settings

Settings Alt + G
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Keyboard Shortcuts Ctrl + K

Help

User Manual Ctrl + H

Custom Keyboard Shortcuts
Ovationのデフォルトの Keyboard Shortcuts を習得されることを強くお勧めします。しかし、Ovationの機能
に独自の Keyboard Shortcuts を作成したい場合には、以下の方法があります。

独自の Keyboard Shortcuts を定義するには、以下の手順に従います。

1. Settings > Keyboard Shortcuts.を選択します。これにより、Keyboard Shortcutsウィンドウが開きま
す。

Ovation Keyboard Shortcuts dialog

2. すべてのメニューコマンドは、このウィンドウ内のタブにまとめられています。キー割り当てを追加/変更したい
Commandのグループがあるタブを選択します。

3. 該当する Command をクリックしてハイライト表示させます。

4. Press new shortcut key ボックス内をクリックします。カーソルが点滅するバーになります。

5. 希望するキーまたはキーと修飾子の組み合わせ（Ctrl、Shift、Altなど）を押します。これらのキーはPress
new shortcut keyボックスに表示されます。なお、選んだキーや組み合わせがすでに別の機能に割り当てら
れている場合は警告が出ます。
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6. Assignボタンをクリックします。

7. 満足するまでキーとコマンドの割り当てを続けます。

8. ユーザーが定義した Keyboard Shortcutsのセットは、Preset として保存できます。Preset を保存するに
は、Save Presetボタンをクリックし、名前を付けます。同様に、以前に保存したプリセットを呼び出すには、
Presetボックスをクリックして、ポップアップリストから選択します。テーブルは、現在ログインしているユーザー
のシステムに保存され、他のユーザーには影響しません。

9. テーブルをファイルに保存またはロードして、他のシステムに持っていくことができます。Save Tableか
Load Tableボタンをクリックしてください。

10. テーブルは、コマンドに関するコメントを添えてテキストファイルとしてエクスポートすることができます。これ
は、独自の Keyboard Shortcuts を含むコマンド リファレンス ガイドとして印刷することができます。
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Advanced Features

Multiple Ovation Sequencers for Redundancy

Mirror All Commands to Remote Ovation Sequencers
Mirror All Commands to Remote Ovation Sequencers の設定は、Settings > Application Settings
> Controller > Remote Controlled Ovationsにあります。このオプションを有効にすると、ローカルの
Ovation Sequencer がマウス, Keyboard Shortcuts, タッチスクリーンで発行したすべてのコマンドが、
Controller Settings で定義されたすべての Remote Ovation Sequencer にも送信されます (ハードウェアコ
ントローラを使用しない場合)。これにより、ネットワーク上の別のマシンで同じ Show を実行している別の
Ovation Sequencerとの間で完全な冗長性を実現することができます。ネットワーク上の 2台のマシンがこのオ
プションを有効にし、両方が自分の Controller Settings > Remote Ovation Sequencers リスト にもう一
方のマシンを定義した場合、Show の最中で、どちらかまたは両方のユーザーインターフェイスを操作すること
ができ、それぞれのシーケンサはもう一方のミラーになります。

Remote Players and Controllers

Ovation Players
メインのOvationアプリケーションに加えて、より小さなアプリケーションである OVPlayer もパッケージに含まれ
ています。

ほとんどの場合 Ovation はスタンドアローンで動作するか、Ovation のフルバージョンを実行する他のマシンと
ネットワーク接続されます。しかし、1台のマスター Ovation シーケンサと1台または複数のOvation プレーヤー
を、ネットワーク接続されたリモートマシンで動作させることも可能です。この場合、1台のOvationシーケンサが
マスターとなり、他のシーケンサをコントロールします。

Ovation Controllers
OVPlayer と同様に、OV Controller もリモートマシン上で動作させることができます。OV Controller は、外部
機器からのコマンドで Ovation を制御することができます。

OV Player
OV Player モジュールは、Ovation Sequencerの命令を解釈し、ローカルまたはネットワーク ストレージから
適切なタイミングで正しいメディアファイルを再生し、制御プロトコルを出力するメカニズムです。

Show Mode では、ネットワークに接続されたPC上の OV Playerや、複数のPC上の OV Player を1つの
Ovation モジュールで制御することができます。この強力な機能により、非常に複雑なシナリオを開発すること
ができます。

各 Cue Listや各 Cueには、それぞれ異なる Default Output Players を定義することができ、それらは
Showのデフォルトを上書きします。

一度に1台のマシンで実行できる OV Playerは1つだけです。Ovation Show を実行しているマシンのOV
Playerは、Ovation Sequencerの一部です。Slave Player マシンでは、別の OV Player アプリケーション
を使用します。

OV Player Files
OV Player のファイルには、オーディオミキサーの設定を含むプレーヤーの設定が保存されており、ファイルの
拡張子は .ovpです。
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OV Player User Interface
Main Screen
OV Player を起動すると、メインウィンドウが開き、最近使用したオーディオミキサーウィンドウが表示されます。

OV Player main Window

注意：OV Player は View メニューで最小の状態でスタートさせることができます。

OV Player Buttons and Toolbars

OV Logo ボタン クリックするとメインウィンドウのコントロール メニューがドロップダウンします。

OV Player Window Control Menu

コントロールは Windows の標準的なものです。右上にある3つの丸いボタンは、左から右へ

Minimize ：メインのOVプレーヤーウィンドウとミキサーウィンドウ（開いている場合）をタスクバーに最小化しま
す。

Maximize / Restore ：メインのOVプレーヤーウィンドウを最大化するか、最小化／最大化する前のサイズと
位置に戻すかを切り替えます。

Close：Exit OV Player ダイアログを開きます。
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Exit OV Player dialog

OK をクリックすると OV Playerが終了し、Cancelすると終了をキャンセルします。

Toolbars

メニューツールバーを含むすべてのツールバーは、カーソルが Move に変わるまでエントリの左側をクリッ

クし、新しい場所にドラッグすることでフローティングにすることができます。フローティングツールバーをメイン

ウィンドウの端にドラッグすると、スナップしてドッキングした状態になります。

OV Player Toolbar

新しい OV Player Session を開きます。

Windows のファイルブラウザが開き、既存の Session を開くことができます。

現在の Session を保存します。Untitled の場合、Save As ファイルブラウザが開きます。

Mixer を表示/非表示します。

OV Player Settings を開きます。

About OV Playerが開きます。
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OV Player Menus

OV Player Menus

Session, View, Help をクリックすると、それぞれのメニューがドロップダウンします。

Session

OV Player Session Menu

New Ctr+N 新しい OV Player Session を開きます。

Open Ctrl+O Windowsのファイルブラウザが開き既存の Session を開くことができま
す。

Save Ctrl+S 現在の Session を保存します。Untitled の場合、Save As ファイルブラウ
ザが開きます。

Save As... Save As ファイルブラウザが開きます。

Recent
Sessions

最近開いたSessionがドロップダウンリストで表示されます。

Exit OV Player を終了します。

View

OV Player View Menu

Run Minimized チェックを入れると、OV Player が最小化された状態でタスクバーに表示さ
れます。

Mixer Mixerを表示/非表示します。

View Player I/O Status OV Player I/O Status windowを表示/非表示します。

Settings OV Player Settings を開きます。

注意：これは、Ovation Sequencer の Settings メニューからアクセスできる Settingsウィンドウの制限付き
バージョンです。
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Help

OV Player Help Menu

About OV Player を開きます。

OV Controller
このアプリケーションモジュールは、Ovation の MIDI と GPI のリモートコントロール入力を処理します。
Ovationのシーケンサーを外部機器からコントロールすることができます。

OVPlayerと同じように、遠隔地のコンピューターで動作させることができます。

一度に起動できる OV Controllerは、1台のマシンに1つだけです。

注意：OV Controllerは Ovation Sequencers を制御し、リモートの OV Player を制御します。

OV Controller Files
OV Controller のファイルはコントローラーの設定を保存するもので、ファイルの拡張子は.ovcです。

OV Controller User Interface
Main Screen

OV Controller が起動すると メイン ウィンドウが開きます。

OV Controller main Window

注意：OV Controller は View メニューで最小で起動できます。

OV Controller Buttons and Toolbars

OV Logo ボタン クリックするとメインウィンドウのコントロール メニューがドロップダウンします。
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OV Controller Window Control Menu

コントロールはWindowsの標準的なものです。右上にある3つの丸いボタンは、左から右に向かって

Minimize ：メインのOV Controller ウィンドウをタスクバーに最小化します。

Maximize / Restore ：メインのOV Controller ウィンドウを最大化するか、最小化／最大化する前のサイズと
位置に戻すかを切り替えます。

Close Exit OV Controller ダイアログを開きます。

Exit OV Controller dialog

OKをクリックするとOV Controller を閉じ、Cancel をクリックするとOV Controller を閉じずにダイアログを終
了します。

Toolbars

メニューツールバーを含むすべてのツールバーは、カーソルが Move に変わるまでエントリの左側をクリッ

クしドラッグすることでフローティングにすることができます。フローティングツールバーをメインウィンドウの端に

ドラッグすると、スナップしてドッキングした状態になります。

OV Controller Toolbar

新しい OV Controller Session を開きます。

Windowsのファイルブラウザが開き、既存の Session を開くことができます。

現在の Session を保存します。Untitled の場合、Save As ファイルブラウザが開きます。

Touch Controller window を表示/非表示します。

OV Controller Settings を開きます。
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About OV Controller が開きます。

OV Controller Menus

OV Controller Menus

Session, View, Help をクリックすると、それぞれのメニューがドロップダウンします。

Session

OV Controller Session Menu

New Ctr+N 新しい OV Controller Session を開きます。

Open Ctrl+O Windowsのファイルブラウザが開き既存の Session を開くことができま
す。

Save Ctrl+S 現在の Session を保存します。Untitled の場合、Save As ファイルブラ
ウザが開きます。

Save As... Save As ファイルブラウザが開きます。

Recent Sessions 最近開いたSessionがドロップダウンリストで表示されます。

Exit OV Controller を終了します。

View

OV Controller View Menu

Run Minimized チェックを入れると、OVコントローラーが最小化された状態でタスク
バーに表示されます。

Touch Controller Touch Controller windowを表示/非表示します。

Settings OV Controller Settings を開きます。

Note：これは Ovation Sequencer の Settings メニューからアクセスできる Settingsウィンドウの制限付き
バージョンです。
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Help

OV Controller Help Menu

About OV Controller を開きます。
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Appendix I

OVController Commands
● Ovationは2つの方法でリモートコントロールできます。

○ メディアシーケンサーとして。ユーザーインターフェースで利用できるすべての機能は、アプリ

ケーション内でマウスを使って手動で操作するのと同様に、リモートコントロールが可能です。

これは、ユーザーインターフェースの各ボタンをリモートコントロールするのと同じです。

○ メディアサーバーとして。すべての Cue と Cue List は、Cue List 番号や Cue番号、インデッ
クスを指定して、個別にリモートコントロールすることができます。これは、Ovationのユーザー
インターフェースとは別に、メディアのプールをリモートコントロールするのと同じです。

● 両方のモードを同時に使用することができます。リモートコントローラーは、いくつかのメディアシーケン

サーコマンドとメディアサーバーコマンドを、いつでも透過的に送信できます。

● 次のページのチャートでは、両方のモードで使用できるすべてのコマンドを示しています。

● Ovation のキーボードコマンドのマッピングについては、Appendix II を参照してください。

● Appendix III では、MIDI / Midi Show Controlコマンドのマッピングについて詳しく説明しています。

● Appendix IV では、DMXコマンドのマッピングについて詳しく説明しています。

● GPIコマンドのマッピングについては、Appendix V をご覧ください。
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Appendix II

Ovation Keyboard Controller Commands Map

Keyboard Layout

Standard - General Purpose Mapping

Big Red Button

標準のマッピングのキーボードは、赤い大きなボタンが２つの操作を行います。これは、All Settings >
Application Settings > Controller Units > Properties > OV Keyboard ページで設定します。

● Fire Swquence Cue 選択した Cue をFireし、自動的に次の Cue を選択する
● Fire Selected Cue 選択した Cue をFireします

Note：このオプションは標準仕様の Ovation Keyboard にのみ適用され、HotKey仕様のキーボードや
Ovation UIのFireボタンには適用されません。
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Hot Keys Only Mapping

Note：Ovationキーボードは、メディアサーバーモード固有のコマンドをマッピングしていません。

Note：キーボードのキーは、付属の工具で簡単に交換することができます。両キーボードレイアウトに必要な
キーキャップは全て付属しています。

Changing Keyboard Mapping
きーぼーどのマッピングを変更するには、

Settings > Application > Controller Units > Proprietary > OVKeyboard

を開き、適当なキーボードのチェックボックスを Enable にしてください。
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Ovation Keyboard Commands mapping
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